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Proper Disposal of Electrical and Electronic Equipment (EEE)

The European Union (EU) has enacted Waste Electrical and Electronic Equipment
Directive 2012/19/EU (WEEE), which aims to prevent EEE waste from arising; to
encourage reuse, recycling, and recovery of EEE waste; and to promote
environmental responsibility.

In accordance with these regulations, all EEE products labeled with the “crossed
out wheeled bin” either on the product itself or in the product literature must not be 

disposed of in regular rubbish bins, mixed with regular household or other commercial waste, or by
other regular municipal waste collection means. Instead, and in order to prevent possible harm to the
environment or human health, all EEE products (including any cables that came with the product)
should be responsibly discarded or recycled.

To identify a responsible disposal method nearby, please contact the local waste collection or
recycling service, the original place of purchase or product supplier, or the responsible government
authority in the area. Business users should contact their supplier or refer to their purchase contract.

Document History

Version Date Comment

Ver.1 November 7, 2016 Initial FLIR release
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1 Document Scope and Purpose
The purpose of this document is to provide instructions for configuring:

• System, network, camera, analytic, and event settings for legacy ioi HTML Edition trk-101 and trk-
101-P encoders

• Analytics and events on ioi HD cameras 

This document contains the following notifications:

A Note is useful information to prevent problems, help with successful installation, or to provide additional
understanding of the products and installation.

Une Remarque est une information utile permettant d'éviter certains problèmes, d'effectuer une
installation correcte ou de mieux comprendre les produits et l'installation.

A Tip is information and best practices that are useful or provide some benefit for installation and use of
FLIR products.

Un Conseil correspond à une information et aux bonnes pratiques utiles ou apportant un avantage
supplémentaire pour l'installation et l'utilisation des produits FLIR.

A Warning is a precautionary message that indicates a procedure or condition where there are potential
hazards of personal injury or death.

Avertissement est un message préventif indiquant qu'une procédure ou condition présente un risque
potentiel de blessure ou de mort.

A Caution is a precautionary message that indicates a procedure or condition where there are potential
hazards of permanent damage to the equipment and or loss of data.

Attention est un message préventif indiquant qu'une procédure ou condition présente un risque potentiel
de dommages permanents pour l'équipement et/ou de perte de données.
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2 Introduction
This User Guide explains how trk-101 and trk-101-P encoders add video analytics capabili ties to s tandard
stationary and PTZ (Pan/Tilt/Zoom) surveillance cameras, turning them into powerful real-time active
detectors . It also provides detailed instructions how to configure analytics and events for ioi HD cameras. A
detailed description ioi HD system, network, and camera configuration can be found in the User and
Installation Guide for each ioi HD camera.

Note: 

The user interface for the ioi HD cameras differs slightly from the HTML Edition units, although the
functionality is the same. A detailed description of the ioi HD system, network, and camera configuration
can be found in the User and Installation Guide for each ioi HD camera.

Support for ioi encoders to operate with FLIR cameras is being added on an ongoing basis.Check with your
sales representative or FLIR support for the current listed of supported cameras. We recommend reviewing
Release Notes as they are issued to see the latest features and functions.

Analytics

Operators can define rules, perimeter lines, sterile zones and other criteria for intrusion detection. As the
camera monitors a scene, it automatically detects the occurrence of specific events, such as region
entrance, fence trespassing, and tripwire crossover which trigger an automatic notification. Users can
define the events and location in the video of the image that can be detected with user-customizable rules
and positioning criteria. 

Al l ioi units analyze the connected or captured video input . The analys is enables alarms to be raised
when a detec t ion rule is met, for example, when people, vehic les and objects cross a perimeter or enter
a pre-defined region. Objects left behind or removed from a scene can also be detec ted. You can define
and customize the detec tion rules that trigger alarms .

For s ites with PTZ cameras , once a moving object has been detected, the object can be tracked
autonomous ly, since the encoder controls and moves the PTZ camera to track and zoom in on the
threat.

IP streaming or analog video output

In addition to their analytic capabilities, the encoders enable connectivity to a legacy CCTV network via
an analog output or connectivity to an IP-based network  via a standards-compliant, compressed H.264/
MJPEG IP streaming video output. On-screen overlays indicate where the detection has occurred on the
video output.

Web configuration

All units can be configured via a standard web browser (32-bit Internet Explorer 9 or above), which takes
less than five minutes to setup. Additional configurat ion opt ions for multiple units on the network are
offered us ing FLIR's Discovery Network Assistant (DNA) utility. 
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Supported operating systems

ioi encoders support the Windows 7, 8, 8.1, and 10 operating systems.

Note: 

The Windows 10 default browser is Edge, which the encoder does not support. When using Windows 10
with your encoder, you must select Internet Explorer as the browser.
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3 Accessing the Unit
Each unit supports one video channel and has its own dedicated IP address and built -in HTTP web
server.

Note: 

Use the Discovery Network Assistant (DNA) utility to find or change the unit’s IP address.

Tip:

The IP address is shown momentarily on the analog video output upon unit start-up. If you do not know
the IP address you want to access, connect a video monitor to the analog video-out of the unit in order to
display the IP address. 

Before trying to access the unit , make sure the unit is turned on and properly connected to the network .
See the unit’s installation manual for details.

To view or configure a unit, enter the unit’s IP address as a URL (for example, http://198.160.123.115) in
the address bar of your browser (32-bit Internet Explorer 9 or above.) Then login according to the
instructions below.

To log into a unit

1. Open your web browser (IE 9 or higher).

2. Enter the IP address of the unit (for example, http://198.160.123.115) as the URL in the browser
address bar.

3. Click Go or Enter. The Login dialog box is displayed:

Login Dialog Box

4. Enter your user name and password in the Login name and Password fields, respectively. The
default user name is "admin" and the default password is "admin".

5. If you want the password to be automatically inserted when you login on this computer, select
Remember my password on this computer.

6. From the Language drop-down lis t, select the language to be used for the user interface. 
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7. If you want to log in as a guest with minimum privi leges, select the Login as guest checkbox.
The login name and password are automatically entered in their respective fields.

8. Click Login. The unit’s HTML interface opens.

The following is an example of the Live View screen that opens when you firs t login. If the unit is
configured with a PTZ camera, the PTZ controls are shown at the bottom left of the screen. For a
description of the PTZ controls ,  see Live View Workspace Overview.

Live View Screen

If the unit is configured with a PTZ camera, the PTZ controls are shown at the bottom left of the screen.
For a description of the PTZ controls ,  see Live View Workspace Overview.

After logging in, from the Mode menu click Site-Live, Site-Playback, Live View, or Setup.

Note: 

Depending on your user account privileges, certain features in the unit’s web interface may not be
enabled.
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4 Quick Tour of the Web Interface
This chapter provides a quick tour of the unit’s interface. The workspace is the HTML page that is displayed
when you access the unit. There are four workspaces selectable from the Mode menu: 

· The Live View workspace is used primarily for real-time monitoring functions.

· The Setup.workspace is primarily used for configuring and maintaining the unit. The Setup
workspace is only available if you are logged in as a user with adequate privileges. Users with
permission to view live and recorded video are known as “privileged users”.

· The Site-Live workspace is used for monitoring live video on a remote unit via Site Viewer. A User
can view only the camera(s) for which he has privileges in the Site-Live workspace.

· The Site-Playback workspace is used for playing back clips recorded on a remote unit via Site
Viewer. A User can view only the camera(s) for which he has privileges in the Site-Playback
workspace.

4.1 Live View Workspace Overview
According to the user privi leges, the Live View screen (workspace) enables you to perform real-time
surveillance monitoring, such as  viewing the real-time video image. The Live View screen also enables
 you to arm (enable the analys is of the video us ing act ive detection rules) and disarm (disable detect ion)
the unit, to view and clear alarms, and to take a snapshot.

In order to view l ive video,  you must  disarm the camera by  c l ick ing the Disarm  but ton.

Armed Live View Screen
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The following is an example of the Live View screen (workspace) of an armed unit  connected to a PTZ
camera.

 Live View Screen with Connected PTZ Camera

The following table describes the components of the Live View screen (workspace):

Label Description

Notifications area Message area in which current detec t ion status (active alarm or video signal
s tatus) is displayed.

View mode
Dsiplays the mode in which the Live Video is displayed: Standard mode (TCP/
UDP/RTP) or Lite mode (HTTP). Lite mode is recommended for use if the video
if blocked by anti-virus software or a firewall.

Command buttons Enable you to arm and disarm the unit (turn video analyt ics on or off) and to
c lear alarms . See Command But tons .

Viewing Area Video viewing area. Video is displayed only when the unit is set to NVR mode
in the Unit Information screen

PTZ controller On PTZ cameras only, the buttons for controlling the PTZ camera. See PTZ
Controller Panel.

Mode menu Tabs for selecting workspaces and for logging out.

Discrete Input/
Output resources

Buttons that indicate the status of alarm inputs and relay outputs . The
buttons also enable users with adminis trator privi leges to arm/disarm alarm
inputs and switch relay outputs on or off.

Viewing toolbar Toolbar buttons that can be used while viewing video. See Viewing Toolbar.

Firmware version Displays  the loaded firmware vers ion.

Snapshot button Enables  you to take a snapshot .
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4.1.1 Command Buttons

The command buttons include the following functions.

Button Description

Arm/Disarm Arms or disarms the active rules enabling or disabling video analys is and
detection on the camera.

Clear alarms Clears the detec t ion or video signal alarm status on the camera.

Snapshot icon enables saving the current video window as a jpeg image file.

4.1.2 PTZ Controller Panel

The PTZ controller panel is displayed only when a PTZ camera is configured as the camera type
connected to the unit. It enables you to mechanically control the PTZ camera's movements. See
Defining a PTZ Camera on trk-101-P. The following table describes the set tings and features of the PTZ
controller panel:

Buttons Description

Presets: Lis ts for select ing an exis t ing preset locat ion (Preset) for display in
the video viewing area.

Pan Left : Rotates the PTZ camera to the left. 

Pan Right : Rotates the PTZ camera to the right.

Tilt Up: Tilts the PTZ camera upwards.  

Tilt Down: Tilts the PTZ camera downwards.  

Zoom In: Increases the opt ical magnificat ion in the Viewing area.

Zoom Out: Decreases the optical magnification in the Viewing area.

Speed: Determines the speed at which the camera controls move the camera
when panning, ti lting or zooming.

Stop Playlist : Stops a running playl is t of selected presets and marks it for
returning to the firs t playlis t preset when the playl is t play button is selected.

Play Playlist: Ac tivates (runs) the playl is t of selected presets.

Pause Playlist : Pauses the playl is t sequence and remains on the last playl is t
preset. When play is selec ted, the playl is t continues from the last preset of the
playlis t vis ited.
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4.1.3 Viewing Toolbar

The Live View toolbar enables you to control the digital magnification of the displayed video. The
following table describes the buttons in the Viewing toolbar:

Icon Description

Full View tool. Returns the view from a magnified view to a non-magnified view.

Zoom-in tool. Clicking the button magnifies the view in the Viewing area.

Zoom-out tool. Clicking the button reduces the magnification in the Viewing area.

Pan tool. Enables you to move the magnified view in the Viewing area. The Viewing
area must be in a magnified state in order to use this tool.

Magnifying glass tool. Selects an area to magnify and fit to the Viewing area (digital
zoom).

Close-up View button. Clicking the button opens a window that provides a close-up of
a section of the view and moves as you move the mouse. Click the button to close the
window.

4.2 Setup Workspace Overview
The Setup screen (workspace) is used to configure the unit. It is only available to authorized users .
See Configuring the Unit.

The Setup workspace enables you to configure, manage, and maintain the unit. Entering the Setup
workspace automatically disarms the unit during configuration. You can rearm the unit from the Live
View screen (workspace). Detection occurs only when the camera is rearmed.



11
November 7, 2016

Quick Tour of the Web Interface

HTML Edition Units User Guide

Following is an example of the Depth screen, showing the tabs and buttons used for initial configuration
of the camera:

Depth Screen with Callouts
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Note: 

The Setup screen may differ from the one shown above according the functionality supported by
your unit.

The following table describes the Setup screen (workspace):

Label Description

Configuration area Area in which you can view and change the configuration
parameters according to the specific settings page.

Display toolbar Tools buttons used during selected configuration processes. For
example, defining the location and position of fences, defining
tripwires and so on.

Display window Viewing area used during some of the configuration processes. If
video is not required during configuration, it becomes part of the
Configuration area.

Mode menu Tabs for selecting workspaces and for logging out.

Solo Setup keypad
control buttons

Buttons that control the recording and storage of clips used for
setting presets during setup.

Apply settings Button for saving changes made to the configuration in the current
displayed tab only.

Configuration
menu 

Enables you to access the configuration screens for defining the
setup and viewing parameter or rule definitions.

Configuration tabs Enables you to select the required configuration option.

Caution: 

Before moving between configuration options, make sure that you save your changes by clicking the 
Apply button. Otherwise, your changes will be lost.
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5 Configuring the Unit
This chapter deals primarily with how to configure the ioi HTML Edition encoder after you have
successfully logged in to the unit. See Accessing the Unit.

Configuration topics are selected by us ing the Configurat ion menu of the Setup screen (workspace).
See Figure: Depth Screen with Callouts.

The following buttons are provided for configurat ion:

• System: Defines the system settings comprising the firmware, date and time, backup and restore,
user accounts settings, discrete I/O resources and the remote setup option.

• Network: Defines the network and streaming settings.

• Camera: Defines the settings for the camera connected to a TRK encoder.

• Analytics: Defines the monitored scene perspective (depth) and detection rules settings.

• Events: Defines automatic responses to pre-defined events and/or scheduled actions.

Note: 

After completing the configuration in any screen, you must click the Apply button. Otherwise,
your configuration changes for that screen will be lost.

5.1 Configuring System Settings
The System but ton on the s idebar includes the following tabs for system configuration:

• Unit Information: Enables you to create a name for the unit and displays the unit type/model,
name, serial number, hardware revision, firmware version and serial number. In addition, it enables
you to select the Operating Mode. See Setting Operating Modes.

• Firmware: Displays the current firmware version and enables you to select and upgrade to a
different firmware version.

• User Accounts: Enables you to define users and their privileges.

• Date & Time: Enables you to define the unit date and time, as well as the method by which you
synchronize the date and time.

• Discrete I/O: Enables you to configure the input and output resources to receive alarms from
external devices (alarm input settings), as well as to provide a relay signal to control external
devices (output control settings).

• Copy Settings: Enables you to copy specific settings of the current unit to different units all at once.

• Backup & Restore: Enables you to perform a backup or restore the settings.
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5.1.1 Viewing Unit Information

The Unit Information screen displays the unit hardware and firmware information and enables you to
select the unit's Operating Mode.  

Following is an illustration of the Unit Information screen:

Unit Information Screen

The following fields and button are displayed in the Unit and Internal Board sections of the Unit
information screen:

Field Name Description

Type/model ioi product family and model.

Unit name Custom unit name as given by the user (editable).

Serial number Serial number of the unit.

Hardware
revision

Revision of the unit hardware. 

Firmware
version

Version of the ioi firmware that is installed on the unit. 

Serial number Serial number of the internal board.

Apply Saves the new settings to the unit.

To change the unit name 

1. In the Setup workspace, select System > Firmw are. The Firmware screen is displayed. See
figure above.

2. Modify the Name field as required.

3. Click Apply. Your change is saved.
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5.1.1.1 Setting Operating Modes

The Operating Modes section of the Unit Information screen enables you to configure the unit’s operating
mode according to the type of input connection (IP or analog).

Following is a summary of each mode:

Operating Mode Input Output Comment

Analog video 
(NVR mode) Analog video in.

Digital video stream with
embedded digital analytics
(metadata) over IP out.

For use with NVR (default
mode)

Analog video 
(DVR mode) Analog video in.

Analog video with
embedded metadata out. For use with DVR

Analog video 
(HD Analytic
Analog mode) Analog video in.

Digital analytics (metadata)
out over IP. For use with Latitude.

Digital video
(HD Analytic
Decoder mode) Digital video in.

Digital analytics (metadata)
out over IP

For use with Latitude. Works
with Quasar and other
cameras.

trk-101 and trk-101-P deliver metadata over IP when the unit is configured in HD Analytic Analog Mode and
HD Analytic Decoder mode. 

· HD Analytic Analog Mode — When the encoder is configured in HD Analytic Analog mode and is
connected locally to a camera’s analog video output, the encoder sends metadata over IP to
Latitude, which embeds the metadata over the video which Latitude receives from the camera over
IP.

· HD Analytic Decoder Mode — When the encoder is configured in HD Analytic Decoder mode and
receives encoded video over IP from the secondary stream of selected cameras. The encoder then
sends metadata over IP to Latitude, which it embeds over the primary video stream received over IP
from the camera. Decoder mode supports selected cameras.



November 7, 2016
16

Configuring the Unit

HTML Edition Units User Guide

The following table summarizes the pros and cons of using the HD Analog and Decoder modes:

Operating
Mode

Pros Cons

HD Analytic
Analog

• For use with raw video
• Offers better detection quality
• View smaller objects at a greater

distance
• Supports all HD cameras with

analog output (requires setting
the same FOV on the camera’s
encoded video and on the
camera’s analog output)

• Requires physical cable connection
• Cat 5 and RG-59/U coax cable

distance is limited to 330’ (100m) for
HD video 

• Installation is more difficult and
expensive

HD Analytic
Decoder 

• No cabling required 
• Easy, lower cost installation

• If there are network problems,
decoded image quality decreases
and there may be misdetections

• Normal detection distance

5.1.1.1.1  NVR Mode

Analog input, digital video and analytics output over IP (NVR mode) 

The trk-101/101-P receives analog video from any camera that provides analog video. It sends a video
stream with embedded metadata over IP to Latitude or any other VMS. This is the default mode.

NVR Mode

Note: 

You must select NVR mode if you want to monitor live video when the unit is armed.
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5.1.1.1.2  DVR Mode

Analog input, video and analytics output over analog (DVR mode)

The trk-101/101-P receives analog video from any camera that provides analog video. It outputs the video
with embedded metadata on an analog connection that can be attached to a DVR.

DVR Mode

Note: 

In this mode, encoding and video streaming are disabled if the unit is armed.

5.1.1.1.3  HD Analytic Analog Mode

Analog input, digital analytics output over IP (HD Analytic Analog mode) 

In this mode, when working with Latitude, an IP camera connects via its analog port to
trk-101/101-P, which sends metadata over IP to Latitude. The camera sends encoded video over IP to
Latitude, which embeds the metadata over the video on the encoded video stream for use in Latitude. 

HD Analytic Analog Mode

HD Analytic Analog mode is designed for use with raw video. It has the advantage of working with all HD
cameras that have an analog output. It offers better detection quality and enables viewing smaller objects at
a greater distance.

Disadvantages of this mode are that it requires physical cable connection, which can result in installation
being more difficult and expensive. Furthermore, Ethernet and 75-ohm RG-59/U coax cable distance is
limited to 330’ (100m) for HD video.

This mode is configured on the trk-101/101-P from the Latitude GUI. It does not need to be configured from
the unit’s Setup > System > Unit Information page. Refer to the HD Analytics Quick  Configuration Guide
for information how to implement this setting on Latitude.
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Note: 

In HD Analytic Analog mode, encoding and video streaming on trk-101/101-P are disabled if the unit is
armed. 

5.1.1.1.4  HD Analytic Decoder Mode

Digital input, digital analytics output over IP (HD Analytic Decoder mode)

The trk-101/101-P acts as a decoder when armed and configured in this mode. Decoder mode supports the
following cameras:

· FLIR F-Series, FC-Series, and TCX cameras

· Quasar CP-4221-30x, CF-3211, CM-3211, CF-4221, CM-4221, CM-4321, CF-4251, and
CM-4251

· Axis 

· Sony

· Bosch

The camera sends encoded video via RTSP to Latitude and to the encoder, which receives encoded video
from the camera’s secondary steam. The encoder performs analytics on the stream and sends the
metadata to Latitude, which embeds the metadata over the video it receives directly from the camera.

HD Analytic Decoder Mode with Fixed Camera-IP or Analog Connection

HD Analytic Decoder Mode with PTZ Camera-IP Connection
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HD Analytic Decoder Mode with PTZ Camera-Analog Connection

HD Analytic Decoder mode has the advantage of not requiring any cabling, since all communication is over
the Internet. The benefit is easy, lower cost installation.

Disadvantages of this mode are: 

· If there are network problems, decoded image quality decreases and there may be misdetections

· This mode does not enable viewing small objects from a greater distance

HD Analytic Decoder mode is configured on the unit from the Latitude GUI. It does not need to be
configured from Setup > System > Unit Information page. Refer to the HD Analytics on Latitude
Installation Guide for information how to implement this setting on Latitude.

Note:

1. In HD Analytic Decoder mode, encoding and video streaming on the encoder are disabled if the
unit is armed. If the unit is disarmed, the video stream from the camera passes through the 
trk-101/101-P directly to the client. 

2. The only PTZ camera that supports HD Analytic Decoder mode is the Quasar CP-4221-30x. 

5.1.1.1.4.1  Support for RTSP Authentication

When selecting HD Analytic Decoder mode (digital input and digital analytics output over IP) from the 
System > User Information screen, it is possible to enable support for RTSP authentication in order to
secure the access to a video on the device. 

The video stream of the camera is viewed on the TRK unit via an RTSP connection. Each supported
camera has its own syntax for the URL that attaches it to the RTSP server. The URL is entered in the 
trk-101/trk-101-P System > Unit Information screen.
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System > Unit Information Screen

5.1.1.1.4.2  RTSP URLs for Supported Cameras

Axis cameras are authenticated by default. Other cameras can be configured for authentication as well.
FLIR will continue to support non-authenticated cameras while adding this support for authenticated
cameras.

The syntax for each supported camera follows. For “<ip>”, enter the camera’s IP address.

FLIR F-Series and FC-Series (ID, R, and S)

rtsp://<ip>/ch0

FLIR TCX 

rtsp://<ip>/cam/realmonitor?channel=1&subtype=1&proto=Onvif

Quasar

rtsp://<ip>/h264_2

Note:

Quasar uses Stream 2 for RTSP streaming (“h264_2”). 

Axis

rtsp://<ip>:<rtsp_port>/axis-media/media.amp?
videocodec=h264&audio=0&camera=1&fps=<fps>&compression=50&resolution=640x480&videobitrate=<bi
trate>&videobitratepriority=quality&videokeyframeinterval=<keyframe_interval>

Where:

<rtsp_port> – used rtsp port (default 554)

<fps>    - frames per second required

<bitrate> - desirable bitrate (bit per second should be set to 1500 and 1000 for static rules)
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<keyframe_interval> - desirable interval between key frames (GOP) in frames 

Note: Used VGA resolution (640x480)

Example:

rtsp://10.70.20.179:554/axis-media/media.amp?
videocodec=h264&audio=0&camera=1&fps=25&compression=50&resolution=640x480&videobitrate=1500&
videobitratepriority=quality&videokeyframeinterval=50

Note:

The stream number is not defined as a parameter in the Axis syntax. The above parameters are
configured directly in the Insert RTSP stream URL text box on the trk-101/trk-101-P System > Unit
Information screen. No additional configuration is required in the camera.

Sony

rtsp://<ip>/media/video2

Note:

Sony uses Stream 2 for RTSP streaming (“video2”). Before entering the URL, the video stream
parameters must be configured on the camera’s web page. The video stream parameters cannot be
configured in the Insert RTSP stream URL text box on the trk-101/trk-101-P System > Unit
Information screen.

Bosch

rtsp://<ip>/video?inst=2

Note:

Bosch uses Stream 2 for RTSP streaming (“video?inst=2”). Before entering the URL, the video stream
parameters must be configured on the camera’s web page. The video stream parameters cannot be
configured in the Insert RTSP stream URL text box on the trk-101/trk-101-P System > Unit
Information screen.

5.1.1.1.4.3  To Enable RTSP Authentication

To enable RTSP authentication

1. In the Insert RTSP stream URL text box, enter the URL of the RTSP stream for the connected
device. 

2. If needed, select the Is Authentication Required checkbox.

3. Enter the user name and password in the respective text box.

4. Click Apply.
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5.1.1.1.4.4  Support for H.264 Encoding on Quasar Cameras

The trk-101 and trk-101-P support decoding of an H.264 video stream on Quasar CP-4221-30x, CF-3211,
CM-3211, CF-4221, CM-4221, CM-4321, CF-4251, and CM-4251 HD cameras when the trk-101 or 
trk-101-P is configured in Latitude in Decoder mode. The encoder receives a video stream over IP and
outputs analytic metadata over IP. 

Note:

The following limitations apply to HD Analytic Decoder mode:

· Analog out is disabled

· Video encoding is disabled on the encoder

· Video streaming is disabled if the unit is armed

5.1.2 Viewing Firmware Information and Upgrading the Unit

The Firmware screen displays the unit hardware and firmware information and enables you to update
the firmware.  

Following is an illustration of the Firmware screen:

Firmware Screen

The following table shows all the available fields and buttons in the Firmware screen. 

Field Name Description

Current firmware
version

Displays the loaded firmware version number.

Upgrade file Displays the upgrade file  (.utk)selected after clicking the Browse button. 

Clicking the button upgrades the firmware to the selected file.
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5.1.3 Updating the Unit Firmware

From time to time, FLIR releases a new vers ion of firmware that may add additional functionality to the
unit and/or corrects issues with exis ting firmware. This section describes how to perform a firmware
upgrade on your unit.

Tip:

Instead of upgrading units one by one according to the procedure described below, it is recommended to
use the DNA utility to upgrade several ioi units at once. Before performing the upgrade via DNA, make
sure that in the Events > Responses screen, when selecting Power On from the Triggering Event tab,
that the action associated with the Power On event is not set to Arm Camera on the Action tab.

To upgrade the firmware

1. Confirm that you have the correct upgrade file (with a .utk extens ion) and copy it to your local

computer.

2. Close any other open Internet Explorer browser applications, excluding the one used for
upgrading the unit.

3. In the Setup workspace, select System > Firmw are. The Firmw are screen is displayed. See
Firmware screen above.

4. Do one of the following:

• In the Firmware Update area, enter the path and file name of the *.utk file to be used for the

upgrade in the File Path field.

• Click Browse and browse to the location of the *.utk file to be used for the upgrade.

5. Click Update now . The upgrade process starts and the following message is displayed.

Firmware Upgrading Unit Message

Caution: 

In order to avoid potential permanent damage to the equipment and/or loss of data, do not stop
the update procedure before completion.

6. Wait until the upgrade finishes.  The unit restarts .

7. Log into the unit.



November 7, 2016
24

Configuring the Unit

HTML Edition Units User Guide

8. If necessary, you might be prompted to update the ioi ActiveX component of your browser to
match the new firmware vers ion.

Install ActiveX Component Dialog Box

9. Install the Act iveX component. On the popup window, c lick Install. The ActiveX component is
installed. You are asked to reset your computer.

Note: 

See Configuring ActiveX Security Settings for instructions how to configure ActiveX on your
computer.

10. Login again after the browser reconnects with the unit . The video s ignal is displayed on the
Live View window.

11. Navigate to Setup > System > Firmw are. Confirm that the firmware vers ion has changed and
that the new firmware vers ion number is displayed.

5.1.4 Configuring User Accounts

The User Accounts screen enables you to add, modify or delete user accounts. A unit is delivered with
two pre-configured (default) users :

• admin: User who has full control (use or set) of the unit. The default user name and password are both
“admin”. From a security standpoint, it is strongly recommended to change the default password for
this user.

• guest: User who has limited privileges (view only). The default password is “1234”. This user can be
deleted if no guests are allowed to view camera video signal.

Warning: 

If you restore your unit to the default factory settings, your user account settings are also
restored to their default factory settings. If you have made changes to the user account settings,
it is strongly recommended that you make a note of these settings before restoring your unit to
the factory defaults. This enables you to easily recreate your user account settings after a
restore of the default factory settings.
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The User Accounts screen has following fields:

Field Name Description

User Name The name of the user. 

Password and
confirm
password 

The password for the user. 

Type The type of user account as described in the previous table. 

The following user account types are available:

Type Description

Admin An Adminis trator has full control over the unit and can perform any unit
funct ionality.

Supervisor A Supervisor can perform any unit functionality exc luding creat ion,
edit ing, or deletion of user accounts.

Operator An Operator can only monitor the video channel and perform bas ic
functions such as c learing alarms , arming or disarming cameras , and
so on.

Viewer A Viewer can only monitor the video channel.

Privileged Users

Users with Admin, Supervisor, and Operator privileges are known as having “administrative privileges”,
which authorizes them to view live or recorded video. These users are referred to as “privileged users”. 

5.1.4.1 To Add a New User Account

To add a new user account

1. In the Setup workspace, select System > User Accounts. The User Accounts screen is
displayed.  
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User Accounts Screen

2. Click Add user. A new user is added to the lis t of user accounts.

3. In the Account Details area, modify the User Name, Password and Type as required.

4. Click Validate to validate the new user details . The new user details are updated in the User
Accounts l is t.

Note: 

Although the new user account is displayed in the User Accounts list, it is not saved until you
click Apply.

5. Click Apply to save the new user details .

Note: 

The default password for a new user account is “1234”. It is strongly recommended to change
this password.

6. If the unit is located behind a firewall and privlileged users have access to it, configure unit
privileges in the Privileged Units area as indicated in To Configure Unit Privileges.
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5.1.4.1.1  To Configure Unit Privileges

To configure unit privileges

1. Select Setup > System > User Accounts. The User Accounts screen opens. A discovery
process discovers all units on the same VLAN.

System > User Accounts Screen

2. Select or add a user for configuration. Click Add User.

3. To add a unit that is not on the same VLAN, enter the unit’s IP address in the Add Manually
text box.

4. Click Add.

5. To add viewing and control privileges for a specific unit, select the checkbox in the left column
of the Privileged Units area.

Note:

When using Site Viewer, all attached units on the site that have privileges are displayed. A
privileged unit must be selected in order for it to be viewed remotely when using Site Viewer.
See Monitoring and Controlling Remote Sites with Site Viewer. 
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6. To enable a remote connection via Site Viewer across a firewall:

a. Enter the site’s static IP address in the External IP text box.

b. For each unit, in the External Port text box, enter the port number. See Accessing a
Remote Unit over the Web (Port Forwarding).

c. Click Apply.

Note:

1. The External IP address and External Port numbers should match those
configured in the router.

2. It is not possible to configure units that are listed in the Privileged Units section
over a firewall. 

5.1.4.2 To Remove a User Account

To remove a user account

1. In the Setup workspace, select System > User Accounts. The User Accounts screen is
displayed. See Configuring User Accounts.

2. In the User Accounts l is t, select the user you want to delete.

3. Click Remove. The user is removed from the User Accounts lis t.

4. Click Apply to save the set tings.

Note: 

Although guest is a default user account, it can be removed if no guest login is allowed.

5.1.5 Configuring the Date and Time

The Date and time screen enables you to define the date and t ime for the unit, as well as the format
and methodology of maintaining t ime on the unit. The unit has an internal c lock that maintains time that
can be set manually, synchronized with a PC or synchronized with a time server (NTP).

Caution: 

Be sure to configure the correct t ime and date on the unit for recording when an event occurred and for
identifying prec isely when video was recorded.  

Tip:

It is recommended that all units on the system be synchronized with an NTP server.
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The Date and time screen has the following fields:

Field Name Description

Unit c lock The current date and t ime on the unit.

PC c lock The current date and t ime on the computer running the browser.

Date format The date format for the unit .

Time zone The unit's t ime zone setting represented by GMT + or – x hours . For
example, GMT-05:00 means Greenwich mean time minus 5 hours
Eastern Time (USA and Canada).

Synchronize
with PC 

The unit’s date and time settings are synchronized with date and time on
the computer from which the unit is being configured once the Apply button
is pressed. 

Manual
settings 

The unit’s date and time settings are set according to the date and time
entered in this field. 

Synchronize
with NTP 

The unit’s date and time settings are continuously synchronized with the
specified NTP time server. NTP is a protocol designed to synchronize the
clocks of computers over a network at regular intervals. 

NTP Server IP The IP address of the NTP server on the network used to synchronize the
date and time of the system components. 

Sampling rate
(min.) 

The time interval for requesting information from the server when NTP
synchronization takes place. 

For more information on enabling a W indows computer to work as a time server, refer to W indows Time
Service.

http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
http://technet.microsoft.com/en-us/library/cc773061(v=WS.10).aspx
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5.1.5.1 To Configure the Date Format and Time Zone Settings

To configure the date format and time zone settings

1. In the Setup workspace, select System > Date and time. The Date and time screen is
displayed.  

Date and Time Screen

2. From the Date format drop-down lis t, select either dd/Mm/yyyy or MM/dd/yyyy.

3. From the Time zone drop-down lis t, select the t ime zone in which the unit is located. For
example, GMT-05:00.

4. Click Apply. The date format and t ime zone are set.
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5.1.5.2 To Define the Date and Time Settings

To define the date and time settings

1. In the Setup workspace, select System > Date and time. The Date and time screen is
displayed. See Date and Time Screen.

2. If you want to synchronize the date and time with an NTP server, continue with step 8.

3. If you want to set the date and t ime manually, cont inue with step 11.

4. If you want to synchronize the date and time with the PC from which you are work ing, select
Synchronize with PC.

5. Cont inue with s tep 11.

6. Enter the IP address of the time server In the NTP Server IP field.

7. Enter or select the time interval in minutes for synchronization updates to occur In the Sampling
Rate field.

8. Cont inue with s tep 11.

9. Select Manual settings .

10. Enter the date and t ime according to the selected date format In the Date and Time field.

11. Click Apply. The date and t ime settings are defined.

5.1.6 Configuring Discrete Input/Output Resources

This section describes how to configure the unit to receive alarms from external devices and control
external devices. 

The Discrete I/O screen enables you to configure hardware resources in the ioi unit to:

• Receive alarm signals from dry contacts of external devices (alarm inputs on the ioi unit). 

• Provide signals used to control external devices (relay outputs on the ioi unit).

The ability to receive alarms from external devices enables you to configure the ioi unit to respond to
events generated on external devices such as doors , sensors , etc. 

The external devices should be able to open or close a dry contact, indicating a change in their status .
For example, if the specific alarm input is armed and an intruder opens a door, the ioi unit can be
configured to move a PTZ camera to a spec ific preset .

Similarly, you can configure the unit to control an external device upon an event being triggered on the
ioi unit. For example, if an intrus ion is detected in a part icular area, you can configure the unit to close
all entrances to that area by activating a relay output.

The section Configuring the Event Engine describes the following:

• How to configure automatic responses once external alarms (from alarm inputs) occur.

• How to activate or deactivate the units’ relay outputs following an event detected on the ioi unit. 

Refer to Monitoring Real-Time Video for more information on us ing the Live View screen to monitor and
control discrete inputs and outputs in real-time.
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Note: 

The icons (buttons) in the I/O Resources table indicate the number of alarm inputs or relays available
on the unit being configured

The Discrete I/O screen has the following fields:

Label Description

I/O Resources

Alarm input 
(from external device
dry contact)

Button indicat ing the current status of the alarm input as follows:

: Disabled.

: Enabled, armed and there is no alarm indicated.

: Enabled and disarmed.

: Enabled and an alarm has been triggered (the external device
is in a s tatus cons idered as an alarm).

Relay Button indicat ing the current status of the relay as follows:

: Disabled.

: Enabled and the relay has not been activated (Off ).

: Enabled and the relay has been activated (On).

Alarm Input Settings

Alarm input 
(dry contact)

Number of the alarm input in the unit.

Name Name of the alarm input (can be edited by the user to reflect
connected device).

Work ing mode Work ing mode for the alarm as follows:

· Alarm on closed: Alarms (notifies) upon short circuiting
of the external device dry contact terminals .

· Alarm on opened: Alarms (notifies) upon disconnection
of the external device dry contact terminals .

· Disabled: Disables all spec ific alarm input funct ionality
and ignores its s tatus.

Condition Indicates if the alarm input is :

· Armed: Being monitored for alarms .

· Disarmed: Not being monitored for alarms.

Alarm status Indicates the current status of the input (Alarm/No Alarm).

Clear Clears the current alarm status .

Output Control Settings

Relay Number of the relay output in the unit .
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Label Description

Name Name of the relay. Can be edited by the user to reflect a
connected device.

Status Indicates if the relay is :

· Enabled: Enables spec ific relay functionality and its
ac tivation to control external devices.

· Disabled: Disables all spec ific relay functionality and
its activation from the unit .

Signal Indicates the current status (s ignal) of the relay (On/Off ).

Change Changes the current signal s tatus.

Note: 

Refer to the unit’s installation manual for information regarding alarm input wiring and connections
to your specific unit.

5.1.6.1 To Configure the Settings for an Alarm Input

To configure the settings for an alarm input

1. In the Setup workspace, select System > Discrete I/O. The Discrete I/O screen is displayed. 

Discrete I/O Screen

2. In the Alarm Input Settings area, from the Alarm input drop-down lis t, select the number of the
alarm input you want to configure. 
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Note: 

The Alarm input drop-down lis t inc ludes the numbers of all the alarm inputs whose alarm
settings can be configured according to the unit type.

3. Enter a name for the alarm input in the Name field.

4. From the Work ing mode drop-down l is t, select the work ing mode for the alarm input:

• Alarm on closed 

• Alarm on opened

• Disabled

5. Click Apply to enable fields according to the updated work ing mode.

6. From the Condition drop-down lis t, select Armed or Disarmed.

7. The alarm status for the alarm input is indicated in the Alarm status field. Click Clear if you
want to c lear the alarm status for the alarm input .

8. To configure the alarm settings for addit ional alarm inputs, repeat steps 2 through 6 for each
alarm input.

9. Click Apply. Your changes are saved.

Note: 

The Alarm input drop-down lis t inc ludes the numbers of all the alarm inputs whose alarm
settings can be configured according to the unit type.
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5.1.6.2 To Configure the Settings for a Relay Output

To configure the settings for a relay output

1. In the Setup workspace, select System > Discrete I/O. The Discrete I/O screen is displayed.
See figure above. 

2. In the Output Control Settings area, select the number of the relay you want to configure from
the Relay drop-down lis t

Note: 

1. The Relay drop-down lis t inc ludes the numbers of all the relays whose output control
sett ings can be configured according to the unit type.

2. The units include a single relay output whose configuration is NORMALLY OPEN by
default. To change relay configuration, see Changing Relay Status from N/O to N/C.

3. Refer to the unit’s ins tallation manual for information regarding relay output  wiring and
connections to your spec ific unit model.

3. In the Name field,  enter a name for the relay output.

4. From the Status drop-down lis t, select Enab led or Disabled.

5. The signal status for the relay output is indicated in the Signal field. Click Change if you want
to change the signal status.

6. To configure the output control set tings for additional relays , repeat s teps 2 through 5 for each
relay.

7. Click Apply. Your changes are saved.

Note: 

Changes to the Name and Status fields only take effec t after c lick ing Apply.
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5.1.6.3 Changing Relay Status from N/O to N/C

The on-board relay in the unit provides a single contact (NORMALLY OPEN by default), which can be
configured to CLOSED upon an alarm condition. This is usually configured with a momentary closure (for
example, five seconds), followed by returning to the OPEN condition, to be ready for the next alarm event.

Should a NORMALLY CLOSED (N/C) condition be preferred, the relay may be configured by selecting one
of the following two events in the Event Engine:

· Event 1:  Triggering event = Power ON

§ Action = Activate relay contact – continuous ON

· Event 2:  Triggering Event = Detection Alarm (according to your configuration)

§ Action 1 = Activate relay contact – continuous OFF – immediately

§ Action 2 = Activate relay contact – continuous ON – after five seconds

The above conditions will turn on the relay at Power ON. An alarm will open the relay for five seconds and
close it again. The above conditions also will create an alarm indication in case of a loss of power. 

Note: 

1. The unit must be rebooted after configuration in order for this setting to take effect. 

2. Event 1 can also be replaced by Triggering Event = ARM. In this instance, the relay will be OPEN
until the unit is armed, at which time it will behave as described above. This may be desirable in
some deployments.
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5.1.7 Copying Settings to Other Units

Once a unit has been configured, you can copy spec ific configuration set tings to other units in the
system simultaneously, thus avoiding redundant steps and reduc ing the time required for sys tem
configuration.

This function includes the abil ity to search for ioi units in the network and to select them as targets in
order to copy the unit's configurat ion settings to them .

The following is an example of the Copy Settings screen:

Copy Settings Screen

The following set tings are available for duplicat ion to other units :

Configuration Description

Network Settings If the local unit  is in DHCP mode, target unit  wil l be set to work in
DHCP mode.

If the local unit is in Manual IP mode, target unit’s IP address definit ion
will not be changed.

The subnet mask , default gateway address and DNS server address wil l
be copied.

Include email
identifier ("From")

If checked, the target unit'semail ident ifier is the same as the unitl being
configured. When enabling email notificat ions , all emails will have the
same sender. 

If unchecked, the email identifier of each unit is configured separately,
allowing different identifiers for each unit.

User accounts All user accounts and their propert ies will be copied to the target units .
Exis ting accounts will be overridden and deleted.
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Configuration Description

Video Streaming All video streaming sett ings wil l be copied to the target units inc luding
Compress ion, Resolution, Max. Frame Rate, Streaming Mode and Bit
Rate/Quality.

Note:

This applies only when both the source and target unit support the
same streaming features (CIF/4CIF, Single/Dual Stream).

Remote Setup Remote Setup sett ings wil l be copied to the target units.

SoE Settings SoE pre- and post-settings, plus FTP backup settings, will be copied to
the target unit. Verify that target unit video streaming settings comply
with SoE recording requirements:

· Compression: MPEG4/H.264

· Streaming mode: CBR 

·

Date & Time All date and time settings wil l be copied to the target units .

On Screen Display
(OSD)

All On-Screen Display settings will be copied to the target units.

GUI Language The language in the target unit will be the same as the language 
displayed in this unit's user interface.

Automatic
Responses

All automatic responses, except PTZ camera control-related responses
(i.e., goto preset, playl is t, etc.) and discrete I/O resource-related
responses (i.e., relay output, external alarm inputs), will be copied to
the target units.

Note:

1. If at least one automatic response related to PTZ control or
discrete I/O is present on the unitl, no Automatic Responses
wil l be copied at all.

2. Before copying this type of event to another uni, it is
recommended to delete all PTZ control or Discrete I/O
resources that are related to automatic responses.
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Configuration Description

Scheduled Actions All Scheduled Act ions , except PTZ camera control-related responses
(i.e., goto preset, playl is t, etc.) and discrete I/O resource-related
responses (i.e., relay output, external alarm inputs), will be copied to
the target units .

Note:

1. If at least one automatic response related to PTZ control or
discrete I/O is present on the unitl, no Automatic Responses
wil l be copied at all.

2. Before copying this type of event to another uni, it is
recommended to delete all PTZ control or Discrete I/O
resources that are related to automatic responses.

To copy settings to other units in the network

1. In the Setup workspace, select System > Copy Settings. The Copy Settings screen is
displayed. The unit searches for available units.

2. In the Sett ings section, mark the settings you want to copy to the other units .

3. In the Copy To section, select the target units.

4. Click Copy. The selected sett ings are copied to the target units .

5.1.8 Backing Up and Restoring Unit Settings

The Backup & Restore screen enables you to c reate backup files of the system and analytic settings
on the unit. 

Backup & Restore Screen
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Warning:

1. Make sure to restore or duplicate the unit settings with a file taken from the same type of unit.

2. Before performing a restore, make a full backup of the unit. The unit automatically resets after
performing a restore, which cannot be undone.

Note: 

1. The backup can also be used to for replicating configurations to other units.

2. Disconnect the unit to avoid duplicated IP addresses.

3. After the settings are replicated, it is recommended that individual settings for each unit be
updated. This particularly applies to the IP address of the unit, but refinements must also be
made if the scenes parameters vary, such as depth, camera height, angle of view, terrain, etc.

The Backup & Restore screen has the followings fields and buttons:

Label Description

Backup

Backup Creates the backup file. 

Restore

To factory defaults Indicates that the res tore must return all sett ings to their factory
defaults including network and IP settings unless otherwise
spec ified.

Keep current
network settings

Indicates that the res tore to factory defaults must not restore the
network (IP configurat ion).

Full restore from file Indicates that a full restore of all the saved sett ings is to be made
from the file spec ified in the File Path field to the unit.

Note:

A full backup file must be specified in the File Path field.
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Label Description

Analyt ics settings
from file

Indicates that the analyt ics settings (depth and detection rules
settings) will be restored from the file spec ified in the File Path field
to the unit .

Note:

From the File Path text box, browse for and select the analytics
set tings backup file.

File Path The path and fi lename of the backup file to be used for the res tore.

Restore Restores the settings according to the definitions made.

5.1.8.1 To Backup Unit Settings

To backup unit settings

1. In the Setup workspace, select System > Backup & Restore . The Backup & Restore screen
is displayed. 

Backup & Restore Screen

2. In the Back up area, c lick Backup. The Save As dialog box is displayed.

3. Browse to location where you want the file saved and enter the name of the file in the File name
field.

Note: 

Make sure that you use the correct file ex tension (.fbk) for your backup. 
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4. Click Save. The file is saved.     

Warning:

If you res tore your unit to the default factory sett ings, your user account sett ings are also
restored to their default factory settings .

5.1.8.2 To Restore Unit Settings

To restore unit settings

1. In the Setup workspace, select System > Backup & Restore . The Backup & Restore screen
is displayed. See Figure Backup & Restore Screen.

2. Do one of the following in the Restore area:

• If you want to restore the unit to factory defaults, do the following: 

a. Select To factory defaults. A message is displayed asking you to confirm that you
want to restore the unit to the factory default settings.

b. Select Keep current network  settings if you want to keep the current network
settings (IP address, Subnet mask, Default gateway, Unit name, and DHCP
setting).

c. Click Yes. The unit is restored to its factory default sett ings. This concludes the
restore process.

• If you want to restore a full backup, do the following:

a. Select Full restore from file.

b. In the File path field, enter or browse for the required backup file including the
extension (.fbk).

Note: 

Be sure to use the correct file extens ion (.fbk) during the restore process.

c. Click Restore. A message is displayed ask ing you to confirm your act ion.

Note: 

Current settings will be lost by restoring set t ings.

d. Click Yes. The unit’s selected settings are restored.
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• If you want to restore an analytics settings’ backup, do the following:

a. Select Analytics settings from file.

b. In the File path field, enter or browse for the required backup file including the
extension (.fbk).

Note: 

Be sure to use the correct file extens ion (.fbk) during the restore process.

c. Click Restore. A message is displayed ask ing you to confirm your act ion.

Note: 

Current settings will be lost by restoring set t ings.

d. Click Yes. The unit’s selected settings are restored.

5.2 Configuring Network Settings
The Network sect ion of the user interface inc ludes the fol lowing screens:

· IP Address: enables you to define the IP address used by the unit

· Mult icas t : configure multicast support for video streaming

· SMTP: configure set t ings for email

· RTP Length:  set  the length of RTP packets  for real-t ime video t ransmiss ion for use
with encrypted networks

The firs t  s tep in configuring network  set t ings is  to set  the IP address.  Two methods are
available for configuring the IP address of the unit:

• Changing the Unit ’s  IP Address from the Web Interface

• Init ial IP Configurat ion with the DNA Ut i l i ty

5.2.1 Changing Unit's IP Addresses from the Web Interface

All units are delivered with the same IP address set during manufacture. This address must be changed
before connect ing to the network . The default IP address is 192.168.123.10.

A unit can stream video in both multicast and unicast modes. The unicast mode is always enabled and
need not be configured. The unit, however, must be configured to operate in multicast mode, which is
disabled by default.
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The Network > IP Address screen has following fields:

Field Name Description

General

Unit name The name assigned to the unit.

IP Address

Use the following IP
address

Enables you to enter the address of the unit comprising the IP
address , Subnet mask and default gateway address .

IP Address The IP address used on the LAN/WAN in standard format.

Subnet mask The mask that limits which network computers are allowed to access
the encoder. This mask should be changed to match with your local
network numbering convention.

Default gateway Local IP address, usually a router, on the local network that serves to
forward to another network beyond the local network. If your network
uses a switch (gateway), this is the IP address of that switch. If your
network uses a hub, this setting is not applicable.

Obtain an IP address
automatically (DHCP)

Enables the unit to obtain an IP from a DHCP server on the network .

To configure the unit’s IP address

1. In the Setup workspace, select Netw ork > Settings. The Network Se ttings screen is
displayed.

Network Settings Screen

2. In the Unit name field, enter the name of the unit.
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3. Select one of the following settings:

• Use the following IP address to manually define the IP address

a. Enter the IP address to be used in the IP Address field.

b. Enter the network subnet mask in the Subnet mask  field.

c. Enter the IP address of the default gateway in the Default gateway field.
• Obtain an IP address automatically to use a DHCP server on the network

a. If using the automatic option (DHCP), continue with step 4.

Note: 

Selecting the DHCP option when a DHCP server is not available wil l cause
the following results:

• Remote Setup not enabled (default): The unit will be defined with the
last static IP address used.

• Remote Setup enabled: The unit will be defined with the last static IP
address used and will reset approximately every five minutes.

4. Click Apply. The IP address of the unit is configured.

Note: 

After applying the changes to the IP address , the unit resets itself. The browser reconnects
to the unit at the updated URL reflec ting the new IP address .
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5.2.2 Using DNA for Initial IP Configuration of Connected Devices

The Discovery Network Assistant (DNA) application is the preferred method for initial configuration of the
device's IP address.

All ioi products use DNA for easy discovery and configuration in the video surveillance system. Once
discovered, DNA lists and reports the status of all supported devices on the network. It provides a simple
interface for required tasks such as setting IP addresses (manually or using DHCP), logging on to the Web
interface of devices for changing settings, checking and updating firmware, and updating credentials. For
more information about using DNA, click here to download the DNA User Manual from the Tools section.

DNA Main Screen

To set the unit’s IP address for the first time

1. Download DNA from the FLIR Firmware & Software Downloads page. 

2. Click the DNA icon   and run the DNA utility (DNA.exe). DNA discovers all devices on the

same VLAN and displays the device’s current IP address.

3. Attach the unit to the same LAN segment as the computer that is managing the unit. DNA
automatically discovers the unit on the network and displays it in the Discovery list. The unit status
should be displayed as Online and Authenticated.

DNA Discovery List

http://www.flir.com/security/display/?id=44516
http://www.flir.com/security/display/?id=73533
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4.  Do one of the following:

· If the unit is managed by Horizon or Meridian configured as a DHCP server, or
is on a network with a DHCP server, double-click the unit. If the unit’s Login
window opens, the unit has received a valid IP address. 

· If the unit is managed by Latitude or is on a network without a DHCP server
and requires a static IP configuration, open DNA’s Assign IP dialog box. Do
the following: 

a. Uncheck Use DHCP.

b. Enter the IP, Mask and Gateway IP addresses.

c. Click Update. The device will be displayed in DNA’s Discovery list.

DNA Assign IP Dialog Box

· If the device is located on a separate VLAN, it must be added manually to the
network by clicking Add Device Manually from the toolbar and entering its
IP address. The unit will be displayed in the Discover list.

DNA Add Device Manually Dialog Box

5. Click the unit in DNA’s Discover List. The unit’s Login window opens.

6. Enter the default user name (“admin") and password (“admin”). The device’s web interface opens.

7. Click the on-screen message to install the FLIR plug-in.

8. Follow the on-screen instructions to install the plug-in.
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5.2.3 Defining Multicast Settings

A unit can stream video or audio through the network in both multicast and unicast modes. The unicast
mode is always enabled and need not be configured. However, the unit must be configured to operate in
multicast mode, which is disabled by default.

Note: 

Confirm with your Network Adminis trator that multicasting is enabled on the network equipment.

The Network > Mulitcast screen has following fields:

Field Name Description

Multicast

Enable video stream
multicasting

Enables multicast video streaming.

Mult icast address IP multicast group address to which the unit sends the video
stream . The default address is 224.1.1.1.

Port range Enables you to select whether you want the unit to automatically
ass ign a port range or if you want to manually ass ign a port range.

Time to live (TTL) The number of transmiss ions (hops) that a packet can experience
before it is discarded.

Multicast Screen

To enable multicasting streaming

1. From the Netw ork > Multicast screen, select Enable video st ream multicasting.

2. In the Multicast address field, enter the multicast IP address.

Note: 

Obtain the multicast IP address from your Network Administrator.

3. From the Port range drop-down lis t, select Automatic or Manual.
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4. If you selected Manual, enter the s tart port range in the text box to the right of the drop-down lis t.

5. In the Time to live (TTL) field, enter the TTL value. This can be a value from 0-128.

Note: 

The TTL value is the number of hops that a packet is permitted to travel before being discarded
by a router. Zero restricts it to the same host, one to the same subnet, 32 to the same site, 64
to the same region, and 128 to the same continent.

6. Click Apply.

To disable multicasting streaming

1. Unselect Enable video stream multicasting.

2. Click Apply.

5.2.4 Defining SMTP Notifications

In addition to the default network notifications via HTTP, a unit can be configured to send an email through
an SMTP server.  The email can notify of the occurrence of events such as detection of any or a specific
type or rule, tampering and/or operational events. Settings are configured on the Network > SMTP
screen. 

SMTP Screen

The Network > SMTP screen has following fields:
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Enable sending
emails from this unit

Enables to send emails through the organizat ion SMTP server such
as MS Exchange according to the rules defined in the unit event
engine. See Configuring the Event  Engine.

SMTP Server Name/
IP

Defines the SMTP server to be used for sendng email notifications. A
server name, e.g. mail@<domain>.com, can be entered if the
network uses a DHCP server. The SMTP server's IP address can be
entered if there no DHCP server on the network.

SMTP Port Defines the port used by the SMTP server.

Sender ("From") Sets the sender email address as it wil l appear in the email itself
("From").

Is Authentication
Required 

If SMTP Authentication is used, this field should be checked. It is not
checked when using MS Exchange for email notifications.

User name The user name for the email account.

Password The password for the email account.

Is SSL Used If Secure Socket Layers (SSL) is used for encryption, select this
checkbox.

To enable sending email notifications

1. From the Netw ork > SMTP screen, select Enab le sending emails f rom this unit.

2. In the SMTP Server Name/IP text box, enter the SMTP server name or IP address.

3. If necessary, change the default port used by the SMTP server.

4. In the Sender ("From") text box, enter the name of the sender.

5. Click Apply.

6. Go to Events > Responses or Events > Sched. Actions and define rules for sending emails as
the action to be performed. See Defining Automatic Responses and Configuring Scheduled
Actions.

Note: 

Confirm with the Network Administrator that sending email from ioi units is enabled on the
SMTP server and that email notifications are not treated as spam (i.e. filtered).

To disable sending email notifications

1. Unselect Enable sending emails from this unit.

2. Click Apply.

mailto:mail@<domain>.com
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5.2.4.1 Password and SSL Support for Email

Email notifications are sent via MS Exchange. It is possible and recommended to add a password and to
use SSL to encrypt email for maximum security from the Network > SMTP screen.  

Depending whether your network uses a DHCP server, select one of the following options:

· If the network uses a DHCP server, enter the SMTP server’s name in the SMTP Server
Name/IP text box.

· If the network does not use a DHCP server, enter the SMTP server’s static IP address in the 
SMTP Server Name/IP text box.

After entering SMTP server details, do not select the Is Authentication Required checkbox.

The email can include a snapshot of the event and details of the camera on which the alarm occurs. In
order to define rules for sending email as the action to be performed, open the Events > Responses or
Events > Sched. Actions screen. For configuration instructions, see Configuring the Event Engine.

5.2.5 Setting the RTP Length (MTU) for Encrypted Networks

When data is encrypted on a network, additional bytes are added to a data packet, which slows real-time
transmission time. In order to improve real-time video performance, the MTU (Maximum Transmission Unit)
size can be defined by setting the RTP packet size (in bytes).

The following settings are available on the Network > RTP Length screen:

· Long – Maximum value = 1472 (default setting)

· Medium – Value = 1312

· Short – Minimum value = 812

· Custom – Set a custom value between 812-1472

5.3 Configuring Camera Settings
The Camera tab enables you to define the type of camera that is connected to the encoder.

This section provides suggestions for how to configure the camera in different scenarios.It includes the
following topics :

• Defining the Camera Type Connected to a TRK Encoder

• Configuring On-Screen Display Settings

• Configuring Streaming Settings

• Aligning the Camera Position

• Using Storage on the Edge (SoE)

• Tips for Camera Configuration
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5.3.1 Defining the Camera Type and Model

When using a TRK encoder, from the Type & Mode l screen, select one of the following camera types
being used:

• Stationary (fixed). See Defining a Fixed Camera 

• Pan/Tilt/Zoom (PTZ). See Defining a PTZ Camera on trk-101-P

Note: 

1. The trk-101 encoder supports only fixed cameras. This is because the trk-101 does not
support an RS-485 connection and the Type & Model screen does not display fields and
controls required for PTZ camera configuration.

2. The trk-101-P encoder supports PTZ cameras as well as fixed cameras. When a PTZ
camera is attached to the trk-101-P PTZ Tracker, a fixed camera will automatically hand-
off a tracked object from the fixed camera to a PTZ camera.

After configuring camera settings on the encoder, it is necessary to define the On-Screen Display Settings
and Video Display Settings described in the following sections:

• Configuring On-Screen Display Settings

• Configuring Steaming Settings

After defining the connected camera type (fixed or PTZ), you can enhance the quality of the image in the
display area for best detec tion results.

5.3.1.1 Defining a Fixed Camera

This section describes how to define that the unit being configured receives the video signal from a fixed
(stationary) camera.

The following table describes the buttons and fields in the Type & Model screen:

Setting Description

Channel name Name ass igned to the camera.

Camera Type

Fixed Indicates that a stationary camera is connected to the unit . 

Image Quality Enhancer

Automatic/
Manual

Determines which image enhancement method is to be used (Automatic
or Manual). 

• Automatic enhancement enables the built-in image enhancer to
determine the best settings for detection at any given time 

• Manual enhancement enables you to determine the image settings
using the sliders described below

Brightness Sets for the amount of white added to the color of the image. From the
drop-down list, select a number from 0-100.

• The higher the number, the more intense (whiter) the image

• The lower the number, the less internse (less white) the image
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Setting Description

Contrast Sets the difference between colors (gray scale). From the drop-down list,
select a number from 0-100.

• The higher the number, the lighter the colors

• The lower the number, the darker (more gray) the colors

Saturation Sets the vividness of hue (the degree of difference from a gray of the same
lightness or brightness). From the drop-down list, select a number from 0-
100.

• The higher the number, the sharper the colors

• The lower the number,  the colors will be less sharp

Enable noise
reduction 

Activates the 2D noise reduction filter. 

5.3.1.2 To Define a Fixed Camera Source

To define a fixed camera source

1. In the Setup workspace, select Camera > Type & Model. The Type & Model screen is
displayed. 

trk-101 Camera Type & Model Screen

2. In the Camera Type area, select Fixed.

3. Click Apply. The camera type is set as fixed.

To adjust image quality

1. From the Image Quality Enhancer section, select either Automatic or Manual.

Tip:

Always use the automatic Image Quality Enhancer option.
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2. If Manual is selected, use the sl iders to change the following set t ings:

• Brightness

• Contrast

• Saturation

3. If you want to enable 2D Noise Reduction, select the Enable Noise Reduction checkbox.

4. Click Save. The settings for enhanc ing the image are saved.

5.3.1.3 Defining a PTZ Camera on trk-101-P

This section describes how to define that the camera being configured by the TRK encoder receives the
video signal from a Pan/Tilt/Zoom (PTZ) camera.

Note: 

1. Only the trk-101-P encoder supports PTZ cameras.

2. When a fixed camera is connected to the trk-101-P, only the fields illustrated in the trk-101
Camera Type & Model Screen are displayed. 

The following table describes the buttons and fields in the Type & Model screen:

Setting Description

Channel name Name ass igned to the camera.

Camera Type

Fixed Indicates that a stationary camera is connected to the unit . If a fixed
camera is connected to the unit, PTZ camera related fields are grayed
out.

Pan/Tilt/Zoom
(PTZ)

Indicates that a PTZ camera is connected to the unit.

Camera Model

Manufacturer The manufacturer of the PTZ camera.

Model The PTZ camera model.

Max zoom Maximum optical zoom setting of the camera.

Communication

Port The port and protocol of the physical connection on the encoder.

Protocol The protocol of the physical connection on the encoder (RS-232 or RS-485).

Device ID The camera ID number as set in the PTZ camera itself. For more information
on this number, refer to the manufacturer’s documentation of the PTZ
camera.
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Setting Description

Baud Rate Communication setting that specifies the number of bits transferred per
second between the ioi unit and the camera on the specific port.

Parity Communication setting that specifies whether the data (packets) contains a
parity bit for error detection and whether that parity bit is Odd Parity or Even
Parity. This setting should match manufacturer’s PTZ model specifications.

Start bits Communication setting that specifies the number of start bit(s) that signify
the start of a new packet This setting should match manufacturer’s PTZ
model specifications.

Stop bits Communication setting that specifies the number of stop bit(s) that signify
the end of a packet. This setting should match the manufacturer’s PTZ
model specifications.

IP The camera's IP address.

Port The network port used to access the camera via HTTP. Usually, this is port
80.

User The user name assigned to the camera.

Password The password.for authorized users to access the camera.

Image Quality Enhancer

Automatic/
Manual

Determines which image enhancement method is to be used (Automatic
or Manual). 

• Automatic enhancement enables the built-in image enhancer to
determine the best settings for detection at any given time 

• Manual enhancement enables you to determine the image settings
using the sliders described below

Brightness Sets for the amount of white added to the color of the image. From the
drop-down list, select a number from 0-100.

• The higher the number, the more intense (whiter) the image

• The lower the number, the less internse (less white) the image

Contrast Sets the difference between colors (gray scale). From the drop-down list,
select a number from 0-100.

• The higher the number, the lighter the colors

• The lower the number, the darker (more gray) the colors

Saturation Sets the vividness of hue (the degree of difference from a gray of the same
lightness or brightness). From the drop-down list, select a number from 0-
100.

• The higher the number, the sharper the colors

• The lower the number,  the colors will be less sharp

Enable noise
reduction 

Activates the 2D noise reduction filter. 
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The PTZ controller located below the display window inc ludes the following but tons:

Buttons Description

Pan Left : Rotates the PTZ camera to the left.

Pan Right : Rotates the PTZ camera to the right.

Tilt Up: Tilts the PTZ camera upwards.

Tilt Down: Tilts the PTZ camera downwards.

Zoom In: Increases the magnificat ion in the Viewing area.

Zoom Out: Decreases the magnification in the Viewing area.

Speed: Determines the speed at which the camera controls move
the camera when panning, t il ting or zooming.

After defining the camera model and control communication sett ings, you must run the PTZ Camera
Definit ion W izard to complete the configuration process . See Using the PTZ Camera Definition Wizard. 

5.3.1.3.1  Defining the PTZ Camera Model and Control Communication Settings

This section describes how to define the camera model and control communications settings for a PTZ
camera.

Note: 

1. When a PTZ camera is attached to the trk-101-P PTZ Tracker, a fixed camera will automatically
hand-off a tracked object from the fixed camera to the PTZ camera. Depth and rules  should be
defined on the fixed camera before configuring the handoff set t ings on the PTZ
camera as  described in Step 3:  PTZ Synchronizat ion with Fixed Cameras.

2.  If you change the depth on the fixed camera,  you must  perform the binding process
again.
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To configure the PTZ camera settings and activate the PTZ Camera Definition Wizard

1. Select Camera > Type & Model. The Type & Model screen is displayed. 

trk-101-P Camera Type & Model Screen

2. In the Camera Type area, select Pan/Tilt/Zoom (PTZ). The fields for configuring PTZ cameras
are ac t ivated.

3. From the Manufacturer drop-down lis t, select the camera’s manufacturer.

4. From the Model drop-down lis t, select the PTZ camera model. A descript ion of the camera is
displayed in the Descript ion field. The default values for the remaining fields in the screen are
automatically configured. 

5. Do one of the following:

• If the values do not need to be changed, proceed to step 18. 

• If the values need to be changed, change them as described in the following steps. 

6. From the Maximum Zoom drop-down lis t, select the maximum zoom to use.

7. From the Port drop-down lis t, select RS-485, which is the standard phys ical connection used by
the encoder for PTZ controller communication.

Caution: 

Be sure that the two control wires from the PTZ camera are properly connected to the RS-485
port on the encoder. Refer to the encoder’s installation manual for more information.

8. From the Protocol drop-down lis t, select the protocol of the phys ical connection on the unit
being used for PTZ controller communication.

9. From the Device ID drop-down lis t, select the camera ID number.
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Note: 

The camera ID number is the camera’s Pelco D address, which normally is set by dip switches
on the camera. Refer to the camera’s installation manual for more information.

10. From Baud Rate drop-down lis t, select the baud rate.

11. From the Parity drop-down lis t, select the parity to use (Odd, Even or None).

12. From the Start Bits drop-down lis t, select the start bits value.

13. From the Stop Bits drop-down lis t, select the stop bits value. Verify the sett ings are correct by
trying to move the camera using the control buttons from the applicat ion.

14. In the IP field, enter the unit's IP address.

15. In the Port field, enter the network port used to access the camera via HTTP. Usually, this is port
80.

16. In the User field, enter the user name assigned to the camera.

17. In the Password field, enter the password.for authorized users to access the camera.

18. Click Apply. The PTZ camera and its control settings are configured.

19. Use the PTZ control buttons located below the display area to move the camera and verify that
the sett ings you have defined are correct.

Note: 

Before proceeding to the next step, make sure that the sett ings on the PTZ camera match
the detection requirements for an ioi unit. Refer to Tips for Configuring Stationary Cameras and
Third-Party PTZ Cameras.

20. Click Start PTZ Setup and follow the steps in the PTZ Camera Definition W izard.

21. After completing the above steps, configure the image quality settings in the Image Quality
Enhancer section of the screen illustrated above. See following section.
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5.3.1.3.1.1  Using the PTZ Camera Definition Wizard

The PTZ Camera Definition Wizard simplifies the process of setting up a PTZ camera. It includes the
following steps:

• Step 1: Detection & Tracking

• Step 2: Calibration

• Step 3: Preset & Playlist or Step 3: PTZ Synchronization

• Step 4: Tracking Parameters

Step 1: Detection & Tracking

The firs t step of the PTZ camera wizard is to define the detect ion mode used on the unit being
configured. The following is an example of the Detection & Tracking screen.

Detection & Tracking Wizard Screen
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The Detection & Tracking screen inc ludes the following fields:

Setting Description

Detection from this
camera

Enables automatic detection from the PTZ camera presets as
follows:

· Enables you to define camera presets and detection on
each defined preset. Depth setting and detection rules
must be defined on each preset doing detection.

· Supports PTZ tracking with autonomous tracking or no
tracking settings depending on whether the With
automatic track ing option is selected.

Note:

Autonomous track ing is not available for generic PTZ
cameras.

· Supports playl is t definit ions for timed movement among
the defined presets. At each preset its depth and
detection sett ings are loaded and executed.

With automatic
track ing

Enables and disables autonomous PTZ Track ing. Enables and
disables the automatic control of the camera movement by the
encoder for autonomous track ing of detected intruders. There is no
need for user intervention or joys tick use.

Note:

Autonomous track ing is not available when "Generic Pan/Tilt/
Zoom” is selected as the PTZ camera model .

Detection from
another camera with
Automatic PTZ
track ing

Detection is made on stat ionary cameras constant ly monitoring
the target field of view (FOV) and no detect ion is made on the PTZ
camera (used only for track ing).

Enables a handoff to be made from a s tationary camera to a PTZ
camera when an intrus ion is detected by the s tat ionary camera.
The handoff enables the PTZ camera to automatically track  the
intruder.

Manual detection
with Automatic PTZ
track ing

Enables manual (user-init iated) detection as follows:

· Supports the definit ion of camera presets, but detec tion
does not take place.

· Enables PTZ t rack ing of a suspect selected by the user
in the unit's HTML interface Live View.

· Supports playl is t definit ions for timed movement among
the defined presets when operating in NVR mode and
there is live video.
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Setting Description

Note:

Video can be viewed in Live View only when the unit is
operating in NVR mode. In other operating modes, it is not
possible to use manual tracking.

Select the required options and cl ick Next to move to the next screen in the wizard. The Calibration
screen opens.

Step 2: Calibration

The calibrat ion step is required for the TRK encoder to learn the parameters of the PTZ camera for
automatic control and autonomous object t rack ing purposes.

The following is an illustration of the Calibration screen:

Calibration Wizard Screen

The Calibration screen includes the following fields:

Setting Description

Unknown Indicates that the camera installat ion height is not known and cannot be
used for improving the detection sett ings .
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Setting Description

Set camera
height

The height of the camera ins tallation in relat ion to the detec tion plane.

Note that the use of this parameter (accurate value) improves the detection
results .

Calibrate
button

Init iates the calibrat ion process .

Calibration
status

Provides information on the calibration results and indication whether the
calibration was successful or not.

Select the required options and cl ick Next to move to the next screen in the wizard. The PTZ
Synchronization screen opens.

To calibrate a PTZ camera

1. In the Camera Height area, do one of the following:

• If you do not know the installed camera’s height measurements, select Unknown. 

• If you know the installed camera’s height measurement, enter the camera height in the Set
Camera Height text box.

Note: 

1. The camera height is the height of the camera lens relative to the Primary
Ground plane where the intended tracking will take place.

2.  The camera height value greatly influences the detec tion and track ing
accuracy. It is highly recommended to provide a prec ise camera height value
when poss ible.

2. Us ing the PTZ controller, set the zoom on the PTZ camera to the widest view (Maximum Zoom
Out). Ti lt and rotate it to a scene that is opt imal, according the instructions on the PTZ Camera
Definition Wizard sc reen.

3. Set  the optical zoom to full zoom out posit ion for the calibration scene. This pos it ion is only
needed during calibration and is used as the benchmark for zoom settings.

4. Set  the camera tilt to 30-50º below the horizontal l ine parallel to the ground.

5. For calibration, the camera should be framed-up to a scene that contains many noticeable
objects well dis tributed throughout the field of view. This pos ition is only needed during
calibration for opt ical check ing.

Note: 

There should be as many “hard-edges” as possible. Well defined edges (like cars, boxes,
crates, etc.) will produce a more accurate result.

6. Click Calibrate .
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7. Review the Calibration status and Results. If the calibration failed or the results are significantly
flawed, redo this procedure and refine the settings and scene as needed.

8. Click Next to move to the next step in the wizard.

9. Do one of the fol lowing:

• If you selected Detection from this camera or Manual detection with Automatic PTZ track ing
in Step 1: Detection & Tracking, continue with Step 3: Preset & Playlist.

• If you selected Detection from another camera with Automatic PTZ track ing in Step 1:
Detection & Tracking, continue with Step 3: PTZ Synchronization.

Step 3: Presets & Playlist

Note: 

This step is only available if you selected Detection from this camera or Manual detection with
Automatic PTZ track ing in Step 1: Detection & Tracking.

The Presets & Playlist screen enables you to define preset camera viewing pos itions and design a
t imed display sequence for running “s tep and stare” viewing known as a Playlis t.

A Playlis t enables you to organize configured presets into sequenced order presets . When a playl is t
runs , the Pan/Tilt/Zoom camera moves through each preset in the lis t for the defined durat ion enabling
viewing and (if configured in step 2) detect ion as long as the camera is armed. When you create the
Playlis t you can define the durat ion of s taying on each preset.

It is  not  necessary  to inc lude all  the presets  to be inc luded in the play l is t  (t imed
sequence).

Note: 

When detec t ing from the PTZ camera presets ,  make sure the play l is t  s top durat ion is
enough for the detec t ion rules  and set t ings to load and enable detec t ion.

The durat ion should be suffic ient  for the type of detec t ion required,  so that  an int ruder has
suffic ient  t ime to cover the minimal dis tance while the preset  is  on-screen.  Short  display
durat ions can confl ic t  with s low-moving int ruders  who do not  cover the required dis tance.  In
scenarios  such as  these,  cons ider adjus tments  to the minimum dis tance or ex tending the
preset ’s  durat ion.  In addit ion,  cons ider us ing a s tat ionary  camera for ful l-t ime surveil lance
of areas.

Caution: 

All presets on a PTZ camera connected to a TRK encoder must be defined through the unit’s HTML
interface. Do not set presets directly on the PTZ camera.
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The following is an example of the Presets & Playlist wizard s tep:

Preset & Playlist Wizard Screen

The Presets & Playlist Wizard screen inc ludes the following columns and buttons .

Setting Description

Presets

No. The number of the preset as ass igned by the unit. The number of presets
rows in the table according to the number of presets supported by the
camera (max imum 32).

Name The name ass igned to the preset (can be edited).

Status Shows whether or not the spec ific preset is set.

Set Sets the selected preset to the current camera pos ition.

Clear Clears the preset from the Preset l is t.

Add to playl is t Adds the selected preset to the playl is t. The same preset can be added
several t imes to the playl is t.

Go to preset Moves the camera pos ition to the selected preset.

Playlist

Seq. No. The sequence in which the preset is accessed by the playl is t.

Preset No. The number of the preset as ass igned by the unit.

Name The name of the Preset .

Duration The period of time (in seconds) that the camera s tays on the preset location
until moving to the next preset in the playl is t.

Up Moves the selected preset one pos it ion up in the playl is t. This is used for
sorting the playl is t into the des ired sequent ial order.

Down Moves the selected preset one pos it ion down in the playl is t. This is used
for sorting the playl is t into the des ired sequential order.

Remove Removes the selected preset from the playl is t.
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To configure presets and playlists

1. Create presets by moving the camera pos ition to a required scene and set each preset. See To
Create a Preset. 

2. Create a playl is t from the presets lis t. See To Create a Playlist.

3. After c reating your presets and playlis t, cl ick Next to go to the next step in the wizard. See
Step 4: Tracking Parameters.

To create a preset

1. In the Preset lis t, select the preset (row) you want to create.

Note: 

1. When detecting from the PTZ camera presets, make sure the playlist stop duration is
enough for the detection rules and settings to load and enable detection.

2. The table is populated automatically with rows according to the number of presets of the
specific PTZ camera model (up to 32).

2. Us ing the PTZ controller, navigate as directly as poss ible to the scene to set as preset. In order
to prevent poorly defined presets, take the following steps when defining presets:

• Before beginning preset definition, get a clear idea of where you want the next preset to be
positioned.

• Navigate as directly as possible. Remember that any superfluous movements may reduce the
preset accuracy.

Note: 

1. All presets are referenced from the calibration scene, which is the camera
pos ition on which calibration was performed.

2. Be sure to navigate directly from one preset target pos it ion to the next, as
every movement made with the PTZ controller is configured in the preset .
Consequent ly, the more preset  pos it ions that are made, the greater is the
poss ibil ity of errors occurring.



November 7, 2016
66

Configuring the Unit

HTML Edition Units User Guide

3. When the camera is at the pos it ion, cl ick Set. The preset is set.

Note: 

All presets are referenced from the calibration scene (the camera pos ition on which
calibration was performed). After setting a preset, the camera returns automatically to the
calibrat ion pos ition, ready for an additional preset configuration.

4. Repeat s teps 1 through 3 for al l the presets you want to create.

To remove a preset

1. In the Preset lis t, select the preset that you want to remove.

2. Click Clear. The preset is removed.

Caution: 

If you remove a preset that has already been configured for detection, playlists, and PTZ
handoff, you will lose all configurations related to the removed preset.

To create a playlist

1. In the Preset lis t, select the prseset that you want to add to the playl is t.

2. Click Add to playlist.

3. In the Duration drop-down lis t, enter the t ime in seconds that you want the camera to remain in
the preset location unt il moving to the next preset in the sequence.

4. Change the order of the presets in the playl is t using the Up and Dow n buttons.

Note: 

A preset can be added more than once to the playlist.
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Step 3: PTZ Synchronization with Fixed Cameras

Note: 

1.  This step is only available if you selected Detection from another camera with Automatic PTZ
track ing in s tep 1 of the PTZ wizard. See Step 1: Detection & Tracking.

2.  Depth and rules  should be defined on the fixed camera before configuring the
handoff set t ings on the PTZ camera.

3.  If you change the depth on the fixed camera,  you must  perform the binding process
again.

PTZ synchronizat ion is required when detec tion is performed by a fixed camera which cont inuous ly
monitors the target area and hands off the detect ion results to the PTZ camera, which then continues
track ing the detec ted intruder.

The PTZ Synchronizat ion step enables you to synchronize the field of view (FOV) in a preset with the
image from a fixed camera monitoring a similar FOV.

Synchronizing the PTZ and fixed cameras requires two steps:

• Setting a preset for the PTZ camera that is the same or has a larger field of view as the fixed camera.

• Correlating 8 points in the field of view of both the fixed and PTZ cameras (i.e. marking the same point
in the monitored area both in the PTZ preset scene and the fixed camera scene). See To set
correlation points in a preset.

Note: 

Correlation points are two points representing the same physical location: one on the PTZ camera
video image (preset) and the other on the stationary camera video image.

Caution: 

Accurate placement of these points is absolutely critical to the correct operation of the handoff
feature. The zoom tools should be used to ensure that the markers correspond exactly to the
same item on both camera views. Markers are to reference items ONLY on the ground level.
Any item elevated above the primary ground plane cannot be used as a reference.

As part of the synchronization definit ion, you can define priorities for s ituations with more than one
single intruder (multiple detec tions). These priorities configure the PTZ camera to continue with its
current track ing or s top the track ing and start track ing the newly detec ted objec t.

In the following example of the PTZ Synchronization screen, the correlation points for the fixed camera
are displayed in the window on the left and the correlation points for Preset 2 of the PTZ camera are
displayed in the window on the right. The numbers and locations of the presets are the same in both
windows. 
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trk-101-P PTZ Synchronization Screen

The PTZ Synchronization screen has the following fields and buttons:

Field/Button Description

# Number assigned to the preset.

Preset name Name of the preset (editable).

Synch with
camera

The IP address of the stationary camera which will perform the detection
and will handoff the intruder information to the PTZ camera for autonomous
tracking.

Channel N/A

Status Current status for this preset (Preset is set/fully set/not set yet/not defined/
synched with fixed camera, or More sync points needed).

Set preset Sets the current camera position and zoom as the selected preset.

Unset preset Clears the selected preset (camera position and zoom).

Interrupt mode For situations with more than a single intruder (multiple detections
simultaneously), this mode determines which of the following actions the
PTZ camera will perform: 

• Continue its current tracking (Continue ongoing tracking) 

• Stop the current tracking and track the new detection (Track last detected
object)

Test Tests the synchronization settings between scenes. After correlating the
FOV of the PTZ camera with the FOV of the fixed camera, moving the
mouse around in the fixed camera video screen will show the related
position in the PTZ scene.

Link Starts the calculations for correlating the scenes after positioning the
correlation points and links the PTZ preset with the fixed camera.
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Field/Button Description

The Pause button freezes the image.

The Play button displays the Live Video image.

IP address IP address of a discovered stationary camera on the which will perform
detection and handoff to the specific preset of the PTZ camera.

Add Manually If the stationary is not discovered (i.e., it is located on another VLAN), enter
the IP address in the text box. Then click Add. If it is successfully added,
the camera's IP address is added to the IP Address drop-down list.

Add Click this button to manually add a camera that was not discovered.The
encoder searches for the camera and adds it if it is discovered. After the
camera is added, select it from the IP Address drop-down list and click 
Connect.

Channel name Displays the name of the selected fixed camera.

Connect/
Disconnect

Connects to the stationary camera at the address selected in the IP
address field. Click Disconnect to disconnect the stationary camera.

The camera selection windows include the following buttons:

Buttons Description

Select point: Selects a correlat ion point in the PTZ camera view window
The Selected point can be moved and posit ioned by dragging them .

Add point: Adds a correlat ion point to both the stationary and PTZ
camera video windows .

Delete point: Deletes a correlation point in both the s tationary and PTZ
camera video windows.

Zoom In: Increases the opt ical magnificat ion in the Viewing area.

Zoom Out: Decreases the optical magnification in the Viewing area.

Pan: Enables you to move the magnified view in the Viewing area. The
Viewing area must be in a magnified state in order to use this tool.

To configure PTZ synchronization

1. Set each preset position by moving the PTZ camera pos ition to a required field of view (FOV)
and set the preset.

Note: 

Only one stat ionary camera can be synchronized to a preset. Set a preset for each
stationary camera to be synchronized even if they have s imilar field of view.
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2. Create correlat ion points for each preset to be synchronized with a fixed camera. See procedure
below: To set correlation points in a preset.

Note: 

Correlat ion points are two points represent ing the same location (phys ical place), one on the
PTZ camera video image (preset) and the other on the stationary camera video image. See
Figure: trk-101-P PTZ Synchronization Screen.

3. After synchronizing the fixed and PTZ cameras, c lick Next to go to the next step in the wizard.
See Step 4: Tracking Parameters.

To create a preset

1. In the Preset lis t, select the preset you want to create.

Caution: 

All presets on a PTZ camera connected to a TRK encoder must be defined through the web
interface. Do not set presets directly on the PTZ camera.

Note: 

1.The table is populated automatically with rows according to the number of presets of
the spec ific PTZ camera model (up to 32).

2. Only one stat ionary camera can be synchronized to a s ingle preset. Set a preset for
each s tationary camera to be synchronized, even if they have similar field of view.

3. All presets are referenced from the “Calibration” scene (the camera pos ition on which
calibration was performed).

2. Us ing the PTZ controller, navigate as directly as poss ible to the scene to set as preset. In order
to prevent poorly defined presets, take the following steps when defining presets:

a. Before beginning preset definition, get a clear idea of where you want the next preset to
be.

b. Navigate as directly as possible. Remember that any superfluous movements may reduce
the preset accuracy.

Note: 

You must navigate as directly as poss ible to the preset target scene, as every
movement made with the PTZ controller is taken into account. Consequent ly, the
more movements that are made, the greater the poss ibil ity of accumulating errors.
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c. When the camera is at the pos it ion, cl ick Set Preset. The preset pos ition is set .

Note: 

After setting a preset the camera returns automatically to the calibrat ion pos ition,
ready for an additional preset configuration.

3. Repeat s teps 1 and 2 for al l the presets that you want to set.

To remove a preset

1. In the Preset lis t, select the preset that you want to c lear.

2. Click Clear Preset. The preset pos ition is c leared.

Caution: 

If you remove a preset that has already been configured for detection, playlists, or PTZ handoff,
you lose all configurations related to the removed preset.

To set correlation points in a preset

1. In the PTZ Camera toolbar, select Add Point .

2. Move your mouse in the PTZ Camera window to the pos ition where you want to place the
correlation point and c lick . A correlation point is  displayed .

Note: 

1. Correlation points are numbered in sequence from 1 to 8. A corresponding numbered
marker will appear on the fixed camera window. Use your mouse and the Select/Zoom/
Hand tools to adjust the location of each marker in both windows so that the marker
points exactly to the same location on both cameras. 

2. Correlation points should only be placed on the ground level, i.e. the primary ground
plane. Any points elevated off the ground level should not be used. 

3. The two correlation markers should point exactly to the same physical location in both
camera views. Any error here will result in poor hand-off performance. 

4. Use the available viewing tools (Zoom-in, Zoom-Out, Pan, and Close-up) to enlarge the
image and focus on the specific place to improve the placement accuracy of the correlation
 points.

3. Repeat s tep 2 for each correlat ion point you want to create. You must c reate 8 correlat ion
points.
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4. If you want to move any correlat ion point, click Select point  and move the correlation point
 as required.

5. To delete a correlation point, select it by us ing the Se lect point tool.

6. Click Delete point . The correlat ion point is deleted.

7. After defining all the correlation points, cl ick Test to confirm that the correlat ion between the
Fixed Camera and PTZ Camera windows is correct, by moving the mouse on the fixed
camera video screen. A correlated (synchronized) movement is  displayed on the PTZ camera
window.

8. Correct the correlat ion points in either of the windows unti l the test is successful.

9. Click Link. The correlat ion points between the Fixed Camera Se lection and PTZ Camera
windows are linked and the PTZ preset is synchronized with the fixed camera.

To set the Interrupt mode

1. From the Interrupt mode drop-down lis t, select the priority for the PTZ camera. Select from:

• Continue ongoing track ing: The PTZ camera ignores additional detection handoffs while
tracking.

• Track last detected object: The PTZ camera stops its current tracking and starts tracking the
new detection handoff.

Step 4: Tracking Parameters

The Tracking Parameters screen enables you to define the PTZ camera settings during Autonomous
PTZ Track ing.

The following is an example of the Track ing Parameters screen:

Tracking Parameters Screen
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The Tracking Parameters screen has the following fields:

Setting Description

Size in frame The s ize of an object in the display area during Autonomous PTZ
Track ing, relative to the video screen.

To set tracking parameters

1. Move the sl ider to the required s ize or select the required value of ratio between the object
dimens ion and the frame size.

5.3.1.3.1.2  To Adjust Image Quality

The Image Quality Enhancer section includes the following settings:

Automatic/
Manual

Determines which image enhancement method is to be used (Automatic
or Manual). 

• Automatic enhancement enables the built-in image enhancer to
determine the best settings for detection at any given time 

• Manual enhancement enables you to determine the image settings
using the sliders described below

Brightness Sets for the amount of white added to the color of the image. From the
drop-down list, select a number from 0-100.

• The higher the number, the more intense (whiter) the image

• The lower the number, the less internse (less white) the image

Contrast Sets the difference between colors (gray scale). From the drop-down list,
select a number from 0-100.

• The higher the number, the lighter the colors

• The lower the number, the darker (more gray) the colors

Saturation Sets the vividness of hue (the degree of difference from a gray of the same
lightness or brightness). From the drop-down list, select a number from 0-
100.

• The higher the number, the sharper the colors

• The lower the number,  the colors will be less sharp

Enable noise
reduction 

Activates the 2D noise reduction filter. 

To adjust image quality

1. From the Image Quality Enhancer section, select either Automatic or Manual.

Tip:

Always use the automatic Image Quality Enhancer option.

2. If Manual is selected, use the sl iders to change the following set t ings:

• Brightness

• Contrast

• Saturation
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3. If you want to enable 2D Noise Reduction, select the Enable Noise Reduction checkbox.

4. Click Save. The settings for enhanc ing the image are saved.

5.3.2 Configuring On-Screen Display Settings

The On-Screen Display window determines the information to be displayed on the video screen as an
overlay on top of the video. The set tings on this window define the selection, al ignment and color
configuration of the various overlays that appear during normal monitoring, events and detec tion.

On-Screen Display Window

Note: 

1. Analog output from the unit is disabled by default and must be enabled if necessary.

2. The settings under the Track ing Information section refer both to the IP streaming video and
analog video output. 

3. The settings under the Camera Information section refer only to the analog video output and do
not affect the IP streaming video content.

The On-Screen Display Window includes the following fields :

Setting Description

Enable analog
video output

Enables the output of processed analog video from the unit to analog
devices such as monitors , DVR, and so on.

Note:

Analog output from the unit is disabled by default and must be enabled via the
unit’s web interface.
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Setting Description

Display
tracking
information

Enables and disables the display of track ing marks on top of the detec ted
objects according to the defined track ing shape. When enabled, this setting
refers both to the IP streaming video and analog video output.

Tracking
shape

Rectangle: Indicates a detected object is marked by a rectangle around the
 detected object.

Figure Rectangle Tracking Shape

Crosshair: Indicates a detected object is marked by a crosshair (+) overlay
centered on the detected object.

CrosshairTracking Shape

Display trail

Enables and disables the OSD to show a trail ing line where the moving
vehic le or person has been. The drop-down lis t enables you to select how
much trail his tory is displayed. Any trail information that has aged beyond
this threshold time is subtracted from the trail ’s display length.

Tracking
color

The color ass igned to track ing shapes and trails for one or more detected
threats.

• Automatic: The system to determine the next color for each of multiple
intruders or threats.

• Custom: Enables you to define the color to be used for the first five detected
 intruders and threats that are simultaneously viewed on an alarm video.

1 – 5

(intruder
colors)

This feature is only activated when the Track ing Color is set to Custom .
Select up to five different colors for track ing sequential intrusions or threats.
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Setting Description

Display
camera
information

Display camera-related OSD information on the display according to your
selection in the Display column of the Camera Information lis t.

Note:

The settings under this section refer only to the analog video output. They do
not affect the IP streaming video content.

Font Enables you to select the font for the OSD.

Font size

Enables you to select the font size for the OSD.

• Small

• Medium

• Large

5.3.2.1 OSD Camera Information List

The following table describes the columns in the OSD Camera Information list:

Column Description

Type Description of the following OSD types .

Note:

The settings under this section refer only to the analog video
output. They do not affect the IP streaming video content.

Channel
Name

Name of the channel as OSD text.

Date Date stamp that is the current date on the unit.

Time Time stamp that is the current t ime of the unit.

Status Status of a camera. The following are status texts are
displayed:

• Armed: The camera is armed for detection. Is not in an alarm
state

• Live: The camera is disarmed. Is not in an alarm state

• Alarm: The camera has detected. Is in an alarm state

• Not Connected: The camera is not connected to the network

Alert
display
message

Displays a text alert and other custom tex t when a detec tion
occurs.

Blinking
alarm
notification

Shows a blinking customized rectangle when an alarm
notification occurs.
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Column Description

Can be used for triggering DVR events recording using the low
accuracy DVR Video Motion Detection (VMD) to monitor the
blinking alarm.

No signal
message

Displays No Signal or other configured text when the video input
signal is lost.

Bad signal
message

Displays Bad Signal or other configured tex t when the video
Input signal is poor quality.

Low
visibility
message

Displays Low Visibility or other configured text when a low
vis ibility alarm occurs (video with significant ly low grayscale
variance).

Camera
shift
message

Displays Camera Shift or other configured text when a Camera
Shift alarm occurs (s tationary camera is phys ically moved from
its original view).

Good signal
message

Displays Signal OK or other configured text when the video
s ignal is good.

Video
disabled
message

Displays Video Disabled or other configured text when the video
is disabled.

Display Select if you want to display  the OSD type.

Caption Where applicable, this column enables you to define the
capt ion to be displayed for the OSD type.

Background
color

Select the background color that is displayed behind the overlay
text. If Transparent is selected, no background color is applied.

Foreground
color

Select the color for the OSD text.

Horizontal
Align

Sets the text on-screen position. Select from: 

• Left

• Center 

• Right alignment

Vertical
Align

Sets the tex t on-screen pos ition. Select from:

• Top

• Middle 

• Bottom
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The following is an example of the Preview screen showing the OSD configurat ion.

OSD Configurations in Preview Window 

5.3.2.2 To Define the On-Screen Display Settings Tab

To define the On-Screen Display settings tab

1. In the Setup workspace, select Camera > On Screen Display. The On-Screen Display
screen is displayed. See Figure: On-Screen Window Display Screen.

2. In the Analog Video area, select Enable analog video output if you want to enable analog video.

3. In the Track ing Informat ion area, select Display track ing information if you want to display
track ing.

4. Configure the track ing shapes and colors as follows:

a. From the Track ing Shape drop-down list, select the required shape.

b. To display a tracking trail, select Display trail.

5. Select the t ime that you want the trail his tory shown in the display.

6. From the Track ing color drop-down l is t, select one of the following options to define the color:

a. Automatic if you want the system to automatically select the tracking color.

b. Manual if you want to manually define the color. If you choose Manual, you can define up
to five tracking colors.

7. To display camera information on the analog video output , select Display camera information.

8. From the Font size drop-down lis t, select the required font size.

9. Define the information you want to display as explained in the OSD Camera Information Lis t.

10. Click Apply. Your sett ings are saved.
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5.3.3 Configuring Streaming Settings

The Streaming screen enables you to define network video streaming settings , such as compress ion
(MPEG4, MJPEG, or H.264), resolution, bit rate, etc.

The t rk -101 and t rk -101-P support  one video s t ream. Following is an example of the trk-101
Streaming screen:

Streaming Screen
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The Streaming screen inc ludes the following fields :

Setting Description Setting 

Video
Settings Shows the video settings for the unit.

Video
standard Displays the TV standard of the camera (PAL or NTSC).

Main
Stream -
Settings

Enables you to define the settings for the main streaming
set.

Compression Enables you to define the compression mode for the unit: 

• MPEG4 

• H.264

• MJPEG

Resolution Enables you to select from the following resolutions:

• CIF

• VGA

• 4CIF

• 2CIF

• D1

Max. frame
rate

Enables you to select the maximum frame rate 
(PAL: 25 fps/NTSC: 30 fps).

Streaming
mode

Enables you to select the streaming mode: Constant bit
rate (CBR) or Variable bit rate (VBR).

Note:

Variable bit rate is not available with MJPEG
compression. 

Target bit rate
(Mbps)

Enables you to select the target bit rate when using H.264
and MPEG4 compression.

Video Quality Enables you to select the quality of the streamed video for
all compression types with VBR streaming. Select a
number from 5-100.
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The following table summarizes the various settings for the main stream:

Compres-
sion

Resolu-
tion

Max. frame
rate – fps

(PAL/NTSC)

Streaming
mode

Target bit rate
(Mbps)

Video quality

MPEG4 CIF 25/30 CBR 0.125-1.5 -

MPEG4 CIF 25/30 VBR - 5-100

MPEG4 VGA 25/30 CBR 0.5 -2.5 -

MPEG4 VGA 25/30 VBR - 5-100

MPEG4 4CIF 25/30 CBR 1-4 -

MPEG4 4CIF 25/30 VBR - 5-100

MPEG4 2CIF 25/30 CBR
PAL: 0.5-2.0

NTSC: 0.25-2.0
-

MPEG4 2CIF 25/30 VBR - 5-100

MPEG4 D1 25/30 CBR 1-4 -

MPEG4 D1 25/30 VBR - 5-100

H.264 CIF 25/30 CBR 0.125-1.5 -

H.264 CIF 25/30 VBR - 5-100

H.264 VGA 18/22 CBR 0.5 -2.5 -

H.264 VGA 18/22 VBR - 5-100

H.264 4CIF 12/15 CBR 0.75-3.0 -

H.264 4CIF 12/15 VBR - 5-100

H.264 2CIF 25/30 CBR 0.25-2 -

H.264 2CIF 25/30 VBR - 5-100

H.264 D1 12/15 CBR 0.75-3 -

H.264 D1 12/15 VBR - 5-100

MJPEG CIF 25/30 CBR - 5-100

MJPEG VGA 25/30 CBR - 5-100

MJPEG 4CIF 25/30 CBR - 5-100

MJPEG 2CIF 25/30 CBR - 5-100
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Compres-
sion

Resolu-
tion

Max. frame
rate – fps

(PAL/NTSC)

Streaming
mode

Target bit rate
(Mbps)

Video quality

MJPEG D1 25/30 CBR - 5-100

5.3.3.1 To Define the Main Stream Settings

To define the main stream settings

1. In the Setup workspace, select Camera > Streaming. The Streaming screen is  displayed.
See Figure: Streaming Screen.

2. From the Video standard drop-down lis t, select the video standard for the camera (PAL or
NTSC). 

Note: 

Make sure that the ioi unit and the external analog equipment support the same video standard
(PAL or NTSC). 

3. Confirm that other predefined sett ings wil l be deleted.

4. From the Compress ion drop-down l is t, select the compress ion mode for the camera:

• MPEG4 

• H.264

• MJPEG 

5. From the Resolut ion drop-down lis t, select CIF.

6. From the Max. Frame rate drop-down lis t, select the maximum frame rate.

7. From the Streaming mode drop-down-l is t, select Constant bit rate (CBR) or Variable bit rate
(VBR).

8. Set the Target bit rate (Mbps) or Max.  bit rate (Mbps)

• When defining MPEG4 or H.264 with CBR, select the Target bit rate (Mbps) from the drop-
down list.

• When defining MPEG4 or H.264 with VBR, select a value from the Video Quality drop-down
 list.

• When defining MJPEG, select a value from the Video Quality drop-down list.

9. From the Streaming mode drop-down-l is t, select Constant bit rate (CBR) or Variable bit rate
(VBR).

• When defining MPEG4 and H.264: In the Target bit rate (Mbps) or maximum bit rate (Mbps)
field, set the bit rate according to the selected streaming mode.

• When defining MJPEG, select the required quality from the Video Quality drop-down list.

10. Click Apply. Your sett ings are saved.
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5.3.4 Aligning the Camera Position

Situat ions can occur where the camera is moved or shifted from its original posit ion, thus changing its
field of view or, in the case of a PTZ camera, changing its preset pos it ion.

In order to avoid the need to reconfigure the depth (perspective) settings , the camera al ignment
functionality uses a reference image (a snapshot of the camera FOV at the right pos ition) for returning
the camera, or preset in the case of a PTZ camera, to its original position.

The re-aligning method cons is ts on drawing references (same lines or points) on both images
s imultaneous ly, comparing and correcting the camera or preset pos ition accordingly.

The following is an example of the Alignment screen on a TRK unit, which shows the original pos ition
FOV and the shifted one on the live video image:

Camera > Alignment Screen

5.3.4.1 To Realign a Camera or Preset Position

To realign a camera or preset position

1. In the Setup workspace, select Camera > Alignment. The Alignment screen is  displayed.
See figure above.

2. To upload a reference pic ture from a jpeg file, cl ick  Upload. The reference image is displayed in
the right window.

3. On top of the Reference Picture , draw l ines  and/or points  on reference (fixed)
locat ions, such as columns, windows, borders , signs, etc . The same references appear
s imultaneous ly on the Live Video window.
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Camera > Alignment Screen with References

4. Move the camera or preset pos ition so that the OSD marks match the same pos ition as in the
original image (e.g. in the pic ture above the green l ine overlaps the pole).

5. Do one of the following:

• For a fixed camera, fix the camera position.

• For a PTZ camera, reset the preset position.

5.3.5 Using Storage on the Edge (SoE)

trk-101/101-P units can store approximately 3800Mb of video clips and recordings in the internal flash
memory on units that are shipped with firmware version 2.1.1 and higher. The clips can be played back with
the free VLC media player. 

Note:

1. The remote unit must be operating in NVR mode in order to view video while armed. 

2. The VLC player must be the 32-bit version.  

The Setup > Camera > SoE screen displays how many events can be stored based on the range
settings, configured video profile and recording profile. Use this screen to enable or disable the SoE
function, to set the pre-event and post-event recording range, and to automatically backup SoE recordings
by FTP.

Note: 

1. This feature is enabled only on units that are shipped from the factory with firmware version 2.1.1.

2. This feature is NOT upgradeable on units that are already deployed in the field.

3. Storage is not on a microSD card.

4. It is recommended to set unit date and time before enabling SoE.
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5.3.5.1 To Utilize Storage on the Edge

To utilize Storage on the Edge

1. Select Setup > Camera > SoE. The SoE screen is displayed.

Setup > Camera > SoE Screen

2. In the Storage on Edge area, select Enabled.

3. From the Pre-event Range drop-down list, select the number of seconds (0-30) to record before the
event.

4. From the Post-event Range drop-down list, select the number of seconds (10-270) to record after
the event.

5. Click Apply.
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5.3.5.2 To Record an SoE Event

To record an SoE event

1. After applying SoE settings, click Events. The Events > Responses screen opens on the
Triggering Event tab.

Events > Responses > Triggering Event Screen

2. Click Add.

3. From the Detection By Type drop-down list, select Any Detection or any other triggering event from
the drop-down list. 

Detection By Type Drop-Down List
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4. Select the Actions tab.

Events > Responses > Actions Screen

5. From the Action drop-down list, select Activate SoE.

6. Repeat the above steps each event that you want to record if you do not want to record all
detections.

7. Click Apply.

Note: 

If you do not perform the above steps, the event will not be recorded.  
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5.3.5.3 To Backup a File Using FTP

Note: 

If you do not perform the following steps, the event will not be recorded.  

To backup a file using FTP

1. In FTP Backup area, select Enabled.

2. In the FTP server IP text box, enter the FTP server IP address.

3. In the FTP server port field, select the port number.

4. In the FTP Username text box, enter the FTP user name.

5. In the FTP Password text box, enter the FTP password.

6. In the Sub folder text box, enter the camera name.

7. Click Apply.

Note: 

The following restrictions apply when using SoE:

1. Operates only in NVR mode.

2. Operates only when trk-101/101-P is configured to CBR (Constant Bit Rate) video profile,
which is set on the Setup > Camera > Streaming screen.

3. Bit rate must be 1.5 Mbps or less.

4. Operates only on H.264 and MPEG4.

5. Recording is for events, which must be configured from the Setup > Events screens. This
function is not used for constant recording.

6. Maximum clip size 300 Mbit (including pre-event and post-event recording).

7. A configured post-event time range stops the clip recording, even if more events were
triggered. If additional events occur during the clip recording, a new clip is created with
post-event duration.
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5.3.6 Tips for Camera Configuration

This section provides suggestions for configuring stationary cameras and PTZ cameras.

5.3.6.1 Tips for Configuring Stationary Cameras and Third-Party PTZ
Cameras

Following are suggestions for configuring stationary cameras and PTZ cameras:

• The encoders only support analog input signal. The video input of the encoder’s white balance signal
should be 1V p/p.

• Connected video should be live when the encoder is powered on.

• If the camera model supports On-Screen Displays, disable them.

• Enable the image stabilizer, if your camera model supports this functionality.

• If the camera has built-in motion detection, disable it.

• If the camera model has a shutter speed setting that is automatically reduced during night, disable it.

• Position the camera to avoid scenes that directly view the sun in the daylight.

• Extend the sunshield as far as possible. This increases the possibility of the sunshield protecting
from effects of the sun and the lens from dust and weather.

• Adjust the camera for clarity of the objects, not necessarily for the best aesthetics. 

• Adjust the sharpness, brightness, and gain on the camera for optimal settings. 

• Adjust the focus as follows: Adjust the focus during the day to best view of the area of interest.
Perform final focusing always during the night.

Following are tips for configuring PTZ cameras only:

• Analog PTZ cameras must have auto focus. Assure that auto focus (AF) is enabled and manual
focus (MF) disabled.

• If the PTZ camera has automatic backlight compensation (BLC), disable it.

• If the PTZ camera supports privacy masking, disable all privacy masks.

• If the PTZ camera has proportional pan and tilt, disable it.

Caution: 

To achieve good tracking results, proportional pan must be disabled.

• If the PTZ camera supports digital zoom, the digital zoom should be disabled or adjusted to full zoom
out. Current support for zoom uses optical zoom commands.

• If the PTZ camera supports zoom speed settings, refer to the ioi datasheet for the optimal setting.

• Disconnect any attached keyboards or controllers, except for unit connection. Use of a splitter and
dual controls may cause interference with unit operations.

• If the camera supports sync settings, change the synch setting to internal synchronization.

5.3.6.2 Tips for Configuring All Cameras

5.3.6.2.1  Camera Height and Angle Adjustment

• When movement towards the camera is to be detected, the camera angle and height
should be adjusted based on the Field of View depth, topology/detection plane, and angle
of intersection. 
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Tip:

Recommended minimum camera height is 5m (15 feet) above the detection plane (6m/19
feet is advisable). This height should be increased as the detection distance increases.

• In case a unit is mounted on a fence, the fence height should be considered. Assuming
fence height is 2.5m/8’, the minimum installation height should be 7.5m (2.5m + 5m)/23
feet (8 feet + 15 feet).

• In general, greater heights with smaller inner (steeper) angles provide more pronounced
visualization of movement on the detection plane towards or away from the camera. 

• If you set a low camera height and a camera angle that is too large (tilt approaching
parallel in relation to the detection plane), visualization of movement towards or away from
the camera will be less pronounced. This may affect the speed of detection if an intruder
makes a precise forward or backward movement (no significant horizon), because the pixel
distance translations will be more difficult to gauge. A one-pixel change, in this situation,
will be equivalent to a considerable distance traveled. 

• Pole vibration should be up to 0.5° and up to 5% of the field of view.

• Pole should be capable of withstanding wind gusts of 80 mph (129 km/h) speed.

• The higher the camera is placed on the pole, the larger the Field of View.
• Camera installation should be parallel to the horizon without rotations.

• In order to avoid blind spots, it is recommended to use multi-camera installation that will
cover all areas.

• Camera should not be facing straight down. It should be mounted at 30°– 40° angle from
the object.

• An angle of 35° from the horizon is required for getting the right depth angle when setting
up the algorithm.

• Wide-angle lenses provide less depth capabilities at distances, as the intruder will appear
smaller at close to 90° (relation to the primary detection plane).

• The following image shows how, from the camera’s point of view, the angle at which an
intruder is viewed becomes greater at a distance. Thus, quality of visible progression away
from the camera is less pronounced.

Field of View at 100m

• The view nearer the camera is at a steeper angle, the depth is more accurate in
determining depth movements towards or away from the camera (more pixels per
movement at a set distance). If a camera is mounted at 90° to the detection plane, an
approaching object only grows in size, but does not show movement in reference to the
detection plane. 
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• Poor camera placement can be compensated partially by increasing sensor Gain
(sensitivity). This, however, may increase noise in the image.

The following illustration demonstrates the following conditions:
• Camera detection area of 60 meters (197 feet)

• Pole height is 4 meters (13 feet)

• Camera is mounted at a 35° angle

• Lens magnification of 18mm

5.3.6.2.2  Lighting Adjustment

• For scenes of depth, lighting should always be behind the camera and not in the front. If
the lighting is in front of the camera, it may cause the auto iris to automatically adjust to
close light. This will reduce visibility at depth where the light is not as strong.

• If the foreground is brightly lit, the auto iris may adjust and reduce visibility at depth where
the light is not as strong.

• If using white or yellow lighting, use a Lux meter and measure the lighting by facing the
meter down. The reading for areas that will support detection in white or yellow light
cameras should read at 5 lux or greater.

• Lighting (including infrared) should not be directed at the ground in front of the camera. It is
best to direct it nearly parallel to the ground.This will avoid auto iris malfunctioning and to
avoid blurry spots on the surface, which could prevent detection.

• If using an infrared illuminator, check that the sensitivity of the camera chip matches the
illuminator specifications.

• Illumination units should be installed at a distance, so that the illumination is constant and
floods constantly along the Region of Interest.

• Infrared lights should be separate from the camera and directed away from camera lens in
order to avoid attracting bugs.

• Illumination units should be located on a different pole than the cameras pole, in order to
prevent false alarms caused by insects attracted to the heat source.

• Light poles should be at least 2m (79”) higher than the camera poles.

• Moving object light can reduce the analytics performance.

• Blinking lights might cause detection issues.

• Avoid cameras facing the sunrise or sunset.

• Avoid shadows from buildings which can cause the camera Field of View to contain bright
and dark areas.

• Thermal cameras do not require any lighting. They are recommended to use in cases
where static and moving lights are expected to be in the scene.
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5.3.6.2.3  Camera Placement

• The tripwire functionality performs optimally when the camera is positioned to point down
the tripwire line of separation. 

Optimal Camera Tripwire Placement

• When the PTZ synchronization is used, the PTZ camera must translate the stationary
cameras’ three-dimensional coordinates to its own preset scene coordinates. 

• In a situation where the stationary camera sends a less than precise depth coordinates,
most often synchronization can overcome errors using the other two coordinates. If,
however, the PTZ camera is at a nearly 90° intersection with a stationary camera, the
margin of error in distance coordinate becomes more pronounced, as individual pixels can
translate into several meters on the horizontal pan of the PTZ camera. 

• When planning the intersection angles of a PTZ and stationary camera, observe the
following guidelines for understanding the level of accuracy on a PTZ handoff at the
different PTZ-to-stationary camera intersect angles (horizontal) for different visual and
camera angles (vertical).

• For a stationary camera with a low camera angle or visual angle (vertical), the following
illustration shows the advantages and disadvantages of intersecting between a PTZ

camera (  ) and a stationary camera:

Intersection of PTZ and Stationary Camera with Low Angles

• For a stationary camera with medium camera angle or visual angle (vertical), the following
illustration shows the various qualities at installation angles where the PTZ and stationary
camera synch share a view of an intruder at horizontal intersect angles: 

Intersection of PTZ and Stationary Camera with Medium Angles 
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• For a stationary camera with a steep camera angle or visual angle (vertical angle), the
following illustration shows the qualities at installation angles where the PTZ and
stationary camera sync share a view of an intruder (horizontal intersect angles at
horizontal intersect angles: 

Intersection of PTZ and Stationary Camera with Steep Angles

• If an area is large and requires multiple cameras, place the cameras so that each
camera’s Field of View (FOV) overlaps sufficiently so that there are no dead zones
between them. Factors of lens selection, camera height, depth, and width of view will
determine the capabilities of the cameras to cover any given FOV area. The overlap should
be such that the area of overlap provides the ability to view the full top-to-bottom height of
an intruder by the camera covering the dead zone of another camera. Overlapping views
also enable capturing an attempt to tamper or disable an adjacent camera.

Incorrect Camera Placement with Overlapping FOV

Correct Camera Placement with Overlapping FOV
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• When determining camera height and installation area, consider accessing the camera for
maintenance, camera security, lighting qualities, cabling requirements (factors signal
degradation) and FOV coverage.

• After configuring a camera scene in the Setup workspace, be sure to use the Alignment
function to record the camera’s position. In this way, if the camera is shifted during
cleaning or maintenance, it can be restored to the configured scene. See Aligning a
Camera Position.

5.3.6.2.4  Environmental Considerations

Environment (vegetation, weather, animals, etc.) has a vast influence on detections and should be taken
into account when setting up a camera for detection.  Considerations include:

• When PTZ synchronization is used, the PTZ camera must translate the stationary
cameras’ three-dimensional coordinates to its own preset scene coordinates.

• Vegetation can create shadows in certain regions.

• Consider variables such as parking vehicles.

• Typical animal types and their sizes should be taken into account.

• Cameras can be dazzled by headlight wash from passing vehicles.

• The relevant size of the far-end detected intruder should be not less than 10% of the frame
size (unless otherwise approved for a specific camera model).

• Maximum object size should be less than 25% of the frame.

5.4 Configuring Analytics
The Analytics tab contains menus for defining the camera’s depth, rules, and advanced settings. 

· The Depth tab enables you define the perspective of the scene being monitored (3D view).
Depth can be calibrated automatically or manually.

o When selecting Manual depth calibration, it is possible for one person to single-

handedly configure a unit's depth by using the Solo Setup function or to configure
multiple units with the Batch Solo Setup function.

Analytics > Depth > Manual Tab

o When selecting Auto depth calibration, the camera automatically calculates the

depth based on an advanced algorithm. 
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· The Rules tab enables you to define detection rules according to the type of detection you
want to be notified about. When the conditions of a detection rule are met, an alarm is
shown in which you can observe the detection and take the appropriate action. See 
Configuring Detection Rules.

· The Advanced tab enables you to define scenes with large or many object and to enable/
disable enhanced detection. See Configuring Advanced Analytic Settings.

5.4.1 Solo Setup

The Solo Setup function enables you to install and setup a camera at the remote site without requiring
another person’s assistance. It is very useful and should be used even if you have another person’s
assistance. With this feature, you can: 

· Move around within the camera’s field of view.

· Use the camera to record a set of snapshots of the scene while the user is moving around the
camera field of view. Creating the recording of the person in the FOV can be used to adjust
settings without requiring another physical walk through the FOV.

· Use the recording of his movement to setup the depth by marking his height on the camera’s
field of view.

When selecting Solo Setup, a keypad is displayed with the following control icons:

Icon Function Notes

Start Recording
Starts recording and browses to destination folder
where the clip will be saved

Stop Recording Stops recording

Browse
Browses to the destination folder where clip is stored
and loads the clip

 Play/Pause Speed X1/X0

Fast Forward
Speed X2, X4, X8, X16. Click to increase or decrease
speed.

Rewind
Speed -X2, -X4, -X8, -X16. Click to increase or decrease
speed.
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5.4.1.1 To Perform a Solo Setup

To perform a Solo Setup

1. Open the Setup > Analytics > Depth window. The Solo Setup window is displayed:

Solo Setup Window

2. On the Solo Setup control keypad, click Start Recording  to record a view in the camera’s
field of view.

3. Create a separate folder for each camera or Preset to be configured. Recording starts when the
folder is selected. 

4. Walk through various locations across the vertical axis of the camera’s field of view in order to
place human height markers and ground guidelines in the clip.

5. Press Stop Recording .

6. Proceed to the tab for Step 1: Ground & Height.

7. Click Browse  to load the clip from the folder where it is saved.

8. Use the Play , Pause , Fast Forward , and Rewind  buttons on the Solo
Setup keypad to explore the clip. The status of the view is displayed on the bottom left side of the
screen.

9. Set the human markers and ground guidelines as defined in Depth Setup Step 1: Ground & Height.
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10. Exit Clip mode and return to Live mode by pressing the round Play button  on the control
panel located to the left of the monitor. The caption under the monitor changes from Clip to Live.

11. Proceed to the tabs for Steps 2-4 of the Depth Setup to complete the setup and apply settings.

5.4.1.2 Batch Solo Setup

It is possible to configure Solo Setup (single person depth setup) of multiple trk-101 and trk-101-P units.
This is known as batch solo setup.

To perform a batch Solo Setup

1. Select the Setup > Analytics > Advanced screen, which displays all analytic units in the
physical site (VLAN). The Advanced screen is displayed. The web page searches for the ioi
units and adds them to the Available Units list. Units using firmware version 1.5.7.328 will also
be discovered.

Analytics > Advanced Screen

2. From the Available Units list, select the checkbox for the units to setup or click Select All.
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3. Click the Record icon  to start recording. The Browse for Folder dialog box opens.

4. In the dialog box, enter the name of the directory in which you want to save the data. By
default, the data for each camera is stored in a folder whose name is the camera’s IP address.

5. Click the Stop icon  when finished recording.  

6. For each camera, select Setup > Analytics > Depth. The Depth screen opens.

Setup > Analytics > Depth Screen

7. Click the Step 1: Ground & Height tab. The tab opens.

Step 1 Ground & Height Screen

8. Browse for the recorded data folder and follow steps 1-4 on the screen.
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5.4.2 Manually Defining the Depth (Perspective) of the Monitored
Scene

Depth setup is the configuration used to teach the ioi unit about the scene perspective as seen by the
camera. It c reates a virtual 3D model for measurement of dis tances and sizes from the perspective of the
camera over the field of view. In other words, it compensates for the fact that objects visually appear
larger when closer to the camera lens .

Depth settings are performed by teaching the unit how a human person looks in several posit ions
around the scene as well as known reference dis tances .

All units come with a default depth setting that must be modified and adapted to each scene.

Note: 

1. Depth settings are performed by teaching the unit how a person looks in several places throughout
the scene and known distances (between reference points) is displayed on the ground (detection
plane).

2. If you are using a PTZ camera, the depth (perspective) must be defined for each of the presets
separately. 

The following is an example of the Depth tab showing Step 1 of the depth configuration steps for a unit
with a single FOV (camera or encoder connected to a fixed camera):

Depth Setup Step 1: Ground & Height
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Note: 

Presets with depth (perspective) or detection rules not defined are shown in orange in the drop-down
lis t for c lear ident ification. 

5.4.2.1 Depth Tab Buttons

The Depth tab includes many toolbar icons. Each step of the configuration process has different icons .
The following buttons are available during the depth configurat ion process .

Icon Description

Shows all human markers (height markers), ground guidelines and horizon
markings in the display area.

Hides all human markers, ground guidelines and horizon markings in the
display area.

Enables you to select items, such as human markers, ground guidelines,
and advanced depth regions.

Deletes the selected item.

Enables the ground guideline tool for defining a reference distance in the
display area.

Positions the PIP window at the top right corner of the Viewing area.

Enables the human marker tool for defining a person’s height in the display
area.

Enables to upload a previously saved image of the scene (jpeg file).

Returns the display area to normal size after it has been magnified.

Magnifies the view in the display area.

Reduces the magnification of the display area.
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Icon Description

Enables you to move the magnified view in the display area. You can only
use this tool if the display area is in a magnified state.

Enables you to select an area in the display area and to magnify it to fit the
display area.

Displays the horizon skyline on scenes when needed.

Enables the interactive ground guideline tool that displays the distance of a
line drawn with this tool. Use this tool to compare the calculated depth and
measurement values with objects in the scene whose size you know.

Enables the interactive human marker tool that displays a marker that
reflects the calculated person height in the specific position on the scene.

Shows the configured horizon indicator.

Draw fence tool.

Draw multi-segment fence tool.

Enables you to select items, such as human markers, ground guidelines,
and advanced depth regions.

The following sequence of configurat ion must be followed to ensure proper detec tion on the specific
scene or preset.

• Step 1: Ground & Height: Enables you to position and resize markers representing a person's height
and guidelines, representing known reference distances as they appear in the detection plane
(ground) in the video image. See Step 1: Ground & Height.

• Step 2: Camera & Horizon: Enables you to define the camera’s height and set the horizon if it is visible
in the video image. See Step 2: Camera & Horizon.

• Step 3: Advanced Depth Regions: This optional step enables you to define additional planes in cases
where the video scene has areas that are not on the ground plane and where the change in perspective
 can affect the object’s size (slopes, hills, walls, fences, etc.). See Step 3: Advanced Depth Regions.

• Step 4: Verification: Enables you to verify and test the results of the configured scene depth
(perspective). See Step 4: Verification.
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Note: 

Detection is based mainly on a single detec tion plane at ground level. If detect ion is needed
in areas that are elevated above the ground detec tion plane, Advanced Regions need to be
spec ified. 

If the intended detection for the scene includes Fence Intrus ion, the definit ion of fence depth regions is
required. This must be done to relate each fence to the detection rule configurat ions for Fence trespass .
See Step 3: Advanced Depth Regions.

Note: 

If you are using a PTZ camera, depth settings must be defined for each of the camera presets field of view
separately. You can only save the depth settings definitions in the Verification tab. 

5.4.2.2 Depth Setup Step 1: Ground & Height

Note: 

If you are using a PTZ camera, depth set tings must be defined for each of the camera presets
separately. 

This step enables you to define the depth (scene perspective) in the video image by plac ing size
markers (which represent  a person’s height) and guidelines (which represent  known reference dis tances
as they appear in the detec t ion plane).

Marker and Ground Guidelines
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To define the ground and height settings

1. Select the Depth > Manual tab.

2. Select the Step 1: Ground & Height tab. The Ground & Height section is displayed. See Figure:
Depth Setup Step 1: Ground & Height.

3. Select the measurement units  from the Units  drop-down l is t . Set the units of measurement
to Meters (metric standard) or Feet (English standard). See Selecting Measurement Units.

4. Create and adjust markers represent ing persons. Align four or more head to toe mark ings
(human markers) on people in the video who are standing on the ground (primary detection
plane).  See Creating and Adjusting Human Markers.

5. Create and adjust ground guidelines.  Align one or more line measurements (ground guidelines)
on the ground and enter the equivalent dis tance value. See Creating and Adjusting Ground
Guidelines.

5.4.2.2.1  Selecting Measurement Units

Before defining any set tings and measurements, you must select the measurement unit .

To set the measurement units

1. In the Setup workspace, select Analytics > Depth >Manua l . The Depth > Manual screen is
displayed.  See Step 1:  Ground & Height .

2. From the Units drop-down lis t, select Feet (American/English measurement standard) or Meters
(metric standard).

5.4.2.2.2  Creating and Adjusting Human Markers

In order to teach the ioi unit how a human looks in the scene, you will need an individual, whose
approx imate height is known, to walk into the field of view. At least four markers representing the
person's height at specific locations are required. For best results, the markers should be well
dis tributed throughout the field of view where detec t ion is to take place.

Note: 

By default, four markers are already placed in the display area. Use the default markers or c reate
additional markers. 

The markers should be adjusted and set while the individual is observed in the display area. The
individual should be standing on the ground (primary depth detection plane) for this step.

After completing the depth setting process (including human markers and ground lines), you must select
Step 3: Advanced Depth Regions to verify and save the markers or ground l ines that you have defined.
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5.4.2.2.2.1  To Adjust Markers Representing Persons on the Scene

To adjust markers representing persons on the scene

1. In the Setup workspace, select Analytics > Depth > Manua l . The Depth > Manual screen
is  displayed.  See Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or
Figure: Depth Setup Step 1:  Ground & Height  – Mult iple FOV.

2. If the camera type is a PTZ camera, select a preset from the Preset drop-down lis t and select
the Step 1 Ground & Height tab.

3. Place a person at the sett ing position:

· If you are using an assistant, ask the assistant to stand still in the selected location.

· If you are using passersby, freeze the video using the Pause button on the Solo Setup
keypad. 

4. Use the Close-up, Zoom, Magnifying Glass and Pan but tons to focus on the person as
much as poss ible.

5. Click Select  in the Depth toolbar.

6. Select one of the exis t ing markers (vertical lines) by c lick ing it . The selected marker turns red.

7. Place the marker over the person by pressing and holding the left mouse button while dragging
the marker.

8. Us ing the mouse scroll wheel or Up/Down arrows on the keyboard to resize the marker to the
individual’s height. 

9. Click to set the marker.

Tip:

Use the Close-up, Zoom, Magnifying Glass, Close-up View and Pan buttons to focus on the
person and improve marker placement. Use the 1:1 button to return to original image size.

       

Depth Setup Step 1: Ground & Height Tab – Zoomed In
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10. Enter the height of the individual in the Marker height propert ies tex t box.

Depth Setup Step 1: Ground & Height Tab with Height Measurement

Note: 

Instead of entering the same height for each marker, you can enter it once and cl ick Apply
height to all markers. 

11. If you are going to configure addit ional human markers, ask the individual to move to another
pos it ion in the field of view.

12. Repeat s teps 6 through 11 for each marker.

Note: 

At least four markers are required. For best results, the markers should be well dis tributed
throughout the field of view where detec t ion is to take place. 

13. Delete any unused markers as described below in To delete markers.
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5.4.2.2.2.2  To Create Additional Markers

To create additional markers

1. Click Marker  in the Depth toolbar. A marker is displayed at the end of the mouse pointer.

2. Posit ion the marker in the display area and left-c lick the mouse, in order to leave the marker in
the posit ion.

3. Repeat s teps 1 and 2 for each human marker you want to c reate.

5.4.2.2.2.3  To Delete Markers

To delete markers

1. Click Select  in the Depth toolbar.

2. In the display area, c lick the human marker you want to delete.

3. Click  in the Depth toolbar. The marker is deleted.

4. Repeat s teps 1 and 2 for each marker you want to delete.

5.4.2.2.3  Creating and Adjusting Ground Guidelines

Ground guidelines enable you to define a known dis tance (the “reference”) as it is viewed by the camera
on the video scene (e.g. dis tance between poles, trees, dedicated measurement, etc .).

Ground guidelines should be marked on the ground (the “detec tion plane”) and not at an elevat ion
above, as the measurement points are always treated as being on the detection plane.

Ground guidelines are opt imal if they are at an angle other than horizontal or vert ical within the field of
view (diagonal in the camera’s perspective), but both edges should be on the detec t ion plane.

Note: 

Accuracy for ground guidelines is essential. If ground guidelines are used, the measurement should be
done with a tape measure. Endpoints should be placed by using the zoom tool to achieve as much
accuracy as possible. 

After completing the depth setting process (including human markers and ground guidelines) you must
select Step 4: Verification to verify and save the markers or ground l ines you have defined.
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5.4.2.2.3.1  To Adjust a Ground Guideline

To adjust a ground guideline

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed.   See
Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup
Step 1:  Ground & Height  – Mult iple FOV.

Note: 

By default, two ground guidelines are already placed in the display area. You can use the default
ground guidelines, delete them or create new ones.  

2. If the camera type is a PTZ camera, select a preset from the Preset drop-down lis t.

3. Select the Step 1: Ground & Height tab.

4. Select a reference dis tance on the detec t ion plane (ground), for example: 

• Two persons standing at a known distance holding a measuring tape at their feet.

• A known distance between reference points, such as poles, columns, trees, etc.

5. Click Select  in the Depth toolbar.

6. In the video display area, select the ground guideline (green line) us ing the arrow selec tion tool.

7. From the Guidelines color drop-down lis t, select the color for the ground guideline markers for
best vis ibili ty according to the scene background.

8. Click  and drag each endpoint of the exis ting ground guideline to match the field measurement
location on the ground plane of the scene.

Tip:

By default, two ground guidelines are already placed in the display area. You can use the default
ground guidelines, delete them or create new ones.

9. Enter the length in the Guideline distance text box.

10. Delete any unused ground guidelines. See explanation below.



November 7, 2016
108

Configuring the Unit

HTML Edition Units User Guide

5.4.2.2.3.2  To Create Ground Guidelines

To create ground guidelines

1. Click Ground Guideline  in the Depth toolbar.

2. Point to start posit ion, click and drag the ground guideline so that it stops at the end
measurement point. Then double-c lick the mouse.

3. Enter the length in the Guideline distance text box.

4. Repeat s teps 1 through 3 for each guideline you want to c reate.

5.4.2.2.3.3  To Delete Ground Guidelines

To delete ground guidelines

1. Click Select  in the Depth toolbar.

2. In the display area, c lick the ground guideline you want to delete.

3. Click  in the Depth toolbar. The ground guideline is deleted.

4. Repeat s teps 2 and 3 for each ground guideline you want to delete.

5.4.2.3 Depth Setup Step 2: Camera & Horizon

The camera height from the ground (primary detection plane) should be entered to help optimize the depth
(perspective) definition. This is the vertical measurement perpendicular to the ground to the height where
the camera lens is. It is not necessarily the pole height of the camera.

Camera Height Measurement
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The following is an example of the Depth tab showing Step 2 of the depth configuration steps:

Depth Setup Step 2: Camera & Horizon

Perform the following steps to configure the camera and horizon:

• Set Camera Height. If known, set the camera installation height from the detection plane (lens to
detection plane measurement). See Setting Camera Height.

• Set the Horizon line. If your scene has a detection horizon (skyline), use the horizon tool to teach the
unit where the outer edge of ground plane detection reaches the horizon. See Adjusting the Horizon
Skyline.

After completing the definit ion of the camera height and the detection horizon, select Step 4: Verification
to verify and save your sett ings .

5.4.2.3.1  Setting Camera Height

This section describes how to enter the camera height. If the camera height is unknown, it is calculated
by the unit and should be checked in the verification step.

To enter the camera height measurement

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed.   See
Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup
Step 1:  Ground & Height  – Mult iple FOV.

2. Select the Step 2: Camera & Horizon tab. See Figure: Depth Setup Step 2:  Camera &
Horizon.

3. If the camera type is a PTZ camera, select a preset from the Preset drop-down lis t.

4. If the camera height is not known, select Unknown in the Camera Height area of the window.
The camera height is calculated and the result should be checked in the verification step.

5. If the camera height is known, enter the height in the Set camera height text box in the Camera
Height area.



November 7, 2016
110

Configuring the Unit

HTML Edition Units User Guide

5.4.2.3.2  Adjusting the Horizon Skyline

The horizon marker enables the measurement model to ident ify items that are not located on the
ground.

Scene  With Horizon Marks

Scene Without Horizon Marks

To set the horizon

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed.   See
Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup
Step 1:  Ground & Height  – Mult iple FOV.

2. Select the Step 2: Camera & Horizon tab. See Figure: Depth Setup Step 2:  Camera &
Horizon.

3. If the camera type is a PTZ camera, select a preset from the Preset drop-down lis t.

4. Do one of the following:

· If the horizon line is unknown, select Calculate.

· If the horizon is known, select Set horizon line to. 

5. Drag the blue line from the top video border and place it on top of the horizon line.
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Note: 

1.  The horizon pos it ion is represented as a percentage measured from the video display
top border: 0% represent ing the top border and 100% represent ing the bottom border.

2. Values below 0% or above 100% indicate that the horizon is below or above the
scene’s FOV. 

5.4.2.4 Depth Setup Step 3: Advanced Depth Regions

The Advanced Depth Regions tab is used to define zones that may affect the size of objects that are
viewed in the scene. Advanced depth regions help determine the dis tance and size of threats for areas not
on the detect ion plane.

Note: 

1. Advanced depth regions should be defined in scenes that include additional surface levels (roofs,
walls, slopes, ditches, etc.), besides the main ground (detection) level.

2. Every plane which affects the scene perspective (an object height) should be defined as a "Special
Region".  

The Advanced Depth Regions tab includes the following icons that are used for configuring advanced depth
regions: 

Icon Description

Draw fence tool

Draw multi-segment fence tool

Draw additional plane tool
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5.4.2.4.1  To Set an Advanced Depth Region

To set an Advanced Depth Region

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed.  See
Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup
Step 1:  Ground & Height  – Mult iple FOV.

2. Select the Step 3: Advanced Depth Region tab. The Advanced Depth Region tab opens. 

Depth Setup Step 3: Advanced Depth Region

5.4.2.4.2  To Add a Straight Line, Single-Segment Fence

To add a straight-line, single-segment fence

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed. In the
Setup workspace, select Analytics > Depth. The Depth screen is  displayed.  See Figure:
Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup Step 1:
Ground & Height  – Mult iple FOV.

2. Select the Advanced Depth Region tab. The Advanced Depth Region tab opens. See figure
above. 

3. Click Draw Fence  in the Depth toolbar.

4. Point to the start posit ion of the fence. Click and point the mouse to the end pos it ion of the
fence. Click again.

5. Do one of the following:

• Enter the properties of the fence in the Fence Name, Fence Height, and Fence Width
fields. 

• Drag the fence borders in the video window to match the required size.
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6. Repeat s teps 4 through 6 for each fence.

5.4.2.4.3  To Add a Multi-Segment Fence

To add a multi-segment fence

1. In the Setup workspace, select Analytics > Depth. The Depth screen is  displayed.  See
Figure: Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup
Step 1:  Ground & Height  – Mult iple FOV.

2. Select the Advanced Depth Region tab. The Advanced Depth Region tab opens. See figure
above. 

3. Click the Draw multi-segment fence  but ton  in the Depth toolbar.

4. Point to start posit ion of the fence. Click and point to each locat ion where there is a bend in the
fence and cl ick . Right-c l ick after the last point .

5. Do one of the following:

• Enter the properties of the fence in the Fence Name, Fence Height and Fence Width fields.

• Drag the fence borders in the video window to match the required size.

6. Repeat s teps 2 through 6 for each multi-segment fence.

5.4.2.4.4  To Adjust an Existing Fence Line

To adjust an existing fence line

1. In the Setup workspace, select Analytics > Depth. The Depth screen is displayed.  See Figure:
Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup Step 1:
Ground & Height  – Mult iple FOV.

2. Select the Advanced Depth Region tab. The Advanced Depth Region tab opens. See figure
above. 

3. Click Select  in the Depth toolbar.

4. Click on the base of the fence region so that a centerline is  displayed.

5. Place the cursor over a point or on the line. Drag the line to adjust or move the center fence line.

The following are examples showing a three dimens ional fence moved to a new location:

Adjustment of Three Dimensional Fence Region -1
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Adjustment of Three Dimensional Fence Region -2

5.4.2.4.5  To Add an Additional Detection Plane

To add an additional detection plane

1. In the Setup workspace, select Analytics > Depth. The Depth screen is displayed.  See Figure:
Depth Setup Step 1:  Ground & Height  – Single FOV or Figure: Depth Setup Step 1:
Ground & Height  – Mult iple FOV.

2. Select the Advanced Depth Region tab. The Advanced Depth Region tab opens. See Figure:
Depth Setup Step 3: Advanced Depth Region.

3. Click Draw Additional Plane  in the Depth toolbar.

Note: 

1. Additional plane areas can be set anywhere within the scene for providing adjusted
measurements that are used instead of the primary detection plane (ground)
measurement sizes.

2. Additional planes boundaries are determined by placing markers . 

3. The lines connecting the bottom of the markers represent the plane boundaries.

4. Each marker height represents a human height (how a human looks) on the marker
position.   

4. Click  and position the bottom of the marker at a perimeter point. 

5. Scroll to res ize according to a person's height on this pos ition.

6. Click to set.

7. Repeat to define the outside boundary of the plane area. The following example shows a sloped
detection plane placed over steps leading from the mezzanine of a building to the ground floor. On
the ground floor is a flat detection plane.
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Additional Detection Plane on Sloped Surface

Note: 

The Advanced Depth Regions  tab turns orange after additional planes are created:

 

5.4.2.4.6  Considerations for Configuring an Advanced Depth Region

In a typical scene where the camera is angled down towards the ground, the closer an object is, the
larger it is  displayed in the video image in number of pixels . In addition, as an object moves towards
the camera, the closer its base is displayed to the bottom of the image.

Primary Plane Straightforward Size Perspective

An exception to this is when an object does not move closer or further to the camera on the ground
plane. Instead, it ascends or descends away from the ground plane. This can occur with c l imbing a
fence or in scenes that include additional surface levels (hills , val leys , buildings, and so on). In these
s ituat ions , the sys tem, which sees in two dimens ions, needs to be taught that it should not measure
these objects as if they were on the main ground plane.

The following graphically altered image shows the same man as seen in a video. This simulation shows
how the s ingle measurement model on a two dimens ional image assumes that both are on the ground
and standing s ide-by-s ide. 
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The single ground plane measurement model measures the man on the left correctly and at the correct
dis tance. But it incorrectly assumes the man on to the right is too large to be human, because of a
mis take in gauging dis tance from the camera lens .

Optical i llus ion of a giant when climbing a fence is not considered in gauging size perspective.

Simulation of an Object Not on the Ground Plane

Scene with Elevated Areas of Detection

After completing the definitions in this section, select Depth Setup Step 4:  Verificat ion to verify and
save your sett ings .
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5.4.2.5 Depth Setup Step 4: Verification

The Verification step enables you to check if the configured depth sett ings match the scene perspective
as viewed by the camera. 

Check the fol lowing steps: 

1. Review the Camera Height properties for inaccurac ies in the calculated value.

2. Use the Interactive Marker tool  to check human heights throughout the field of view.

a. Place the Interac tive Marker on a selected position in the scene.

b. Set the height the marker represents by using the keyboard Up/Down arrows or by
entering the value on the Interact ive Marker text box.

c. Move the Interact ive Marker through the scene by c l icking and dragging the marker bottom
center point. The marker height changes according to how the height it represents is seen
at the spec ific pos it ion.

Note: 

The Interactive human marker must correctly represent the height of a human at any
position in the scene. If there is an error in this representation, detection results will be
incorrect. Adjustments should be made in the depth setup until this representation is
correct. 

3. Use the Ground Guideline tool  to check dis tances on the ground plane and advanced
depth regions throughout scene. Measurement should be checked at the base where an object
would make contact with the detec tion plane.

a. Click on the start point and while leaving the mouse left button pressed. 

b. Drag the measuring to the end point. The dimens ion is shown on the video screen.

4. Use the Show Horizon tool  to check the height of the horizon in the scene.

5. If the results are unsatis factory and negatively affect detect ion, repeat  Step 1 Ground & Height
and/or Step 2 Camera & Horizon.

6. If you are satisfied with the results, click Apply to save the depth configuration and complete the
verification process.

Note: 

Depth (perspective) settings are not saved until you click Apply in the Step 4: Verif icat ion
tab. 
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Caution: 

1. When selecting the Step 4: Verif icat ion tab, the unit checks for incons is tenc ies in the
depth definitions .

2. If the following message is displayed, depth definitions must be corrected.

3. Clicking Continue Anyway causes wrong detection results and should never be used for
detection.

5.4.3 Automatic Depth Calibration

The Automatic Calibration function:

· Automatically configures scene depth

· Calculates camera height, focal length, and tilt angle according to the scene depth

· Discovers people in the scene and configures human markers automatically

· Eliminates the time and effort required to manually add human markers 

· Requires a person walking in the scene while auto calibration is in progress

Note: 

1. The Auto Calibration function does not support multiple PTZ presets.

2. If you use the Auto Calibration function, it is possible to configure additional settings
manually and verify the Auto Calibration settings after the Auto Calibration process is
completed. Click MANUAL in order to configure additional settings.

3. If you choose to not use this feature, click MANUAL and proceed with the manual depth
configuration.

Caution: 

1. Auto calibration can be performed only in scenes that contain a single plane (no
differences in height), because it automatically configures depth settings for the entire
field of view. 

2. Auto calibration is not recommended when analytics are required only for certain areas. 
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5.4.3.1 To Configure Automatic Depth Calibration

To configure automatic depth calibration

1. Verify that the camera is installed at a height of at least four meters (13 feet).

2. Verify that the horizon is less than 30% of the Field of View (FOV).

Horizon Line

3. From the Settings tab, select Analytics > Depth. The Auto depth screen opens.

Analytics > Auto Depth Screen-Step 1

4. From the Units drop-down list, select Feet or Meter. 

5. Select Set camera height. See Setting Camera Height.

Tip:

If you are using Auto calibration on a camera with a zoom lens, set the height as Unknown.
If you do not see any progress in the progress bar, or if you do not see flickering over the
detection box, enter the estimated camera height in the Set Camera Height textbox. If there
is no flickering over the detection box, reduce the camera height setting by a few meters
until you do see flickering over the detection box and the progress bar reaches 100%.

6. Enter the estimated camera height in the text box.

7. Click Start. The camera automatically calibrates the depth. 
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Note: 

Be sure that a person is walking along the Y (vertical) axis of the FOV while Auto
Calibration is in process. When the progress bar reaches 100%, the Auto Calibration is
completed. The unit displays the Step 2: Verification tab.

Auto Depth Screen with Results

Note: 

While Auto Calibration is in progress, you can proceed with the next steps in the analytic
configuration if you are operating in NVR mode. In all other modes, the video is not
displayed in the web interface during Auto Calibration. This is the normal behavior.  

Caution: 

1. The Auto Calibration algorithm takes at least five minutes to run. If you stop the
procedure before the progress bar reaches 100%, the analytic process will reset.

2. If you change from Auto to Manual mode, you must wait until the analytic process
resets in order to use Manual mode.

8. Select the Auto > Step 2: Verification tab.

9. In the Results area, verify that the horizon and camera height are correct. Also check that the
human marker settings are correct by selecting the buttons in the top left corner of the screen.
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Note: 

If the results are unsatisfactory, run Auto Calibration again (follow Step #1 on-screen) or
click MANUAL to manually configure the depth settings.

10. After finishing the Auto Calibration, click the MANUAL tab. The MANUAL Depth screen is
displayed.

Manual Depth Screen

11. Select the Manual > Step 4: Verification tab to complete the depth configuration.

Analytics > Depth > Manual > Step 4 Screen

12. Add markers and guidelines as needed.

13. To configure advanced settings, see Defining the Depth (Perspective) of the Monitored Scene
and Configuring Detection Rules.
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5.4.4 Configuring Detection Rules

The Ana lytics > Rules tab enables you to define and customize detection rules.

Detection rules are a combination of one or more condit ions that must be met in order to regis ter
detect ion. Examples of detection rules in a defined region include: 

• Region entrance

• Loitering 

• Tripwire Crossover

• Fence Trespassing

• Unattended Baggage

• Stopped Vehicle

• Object Removal

For detai ls  about  each type of detec t ion rule,  see Rule Types .

Detection occurs when one or more detection rules are active, the camera is in Arm  mode, and the
scenario on the video (scene) fits the detec tion criterion specified.

To define a new rule

1. Create a new rule and selec t its type. See Creating New Rules.

2. Draw a tripwire line or define the region of interes t where events are monitored while other
regions are ignored in the display window. See Drawing Detect ion Areas.

3. Modify the detection attributes as needed. See Modify ing Rule At t ributes .

4. Activate the rule. See Enabling and Apply ing (Saving) Rules .

Ex is ting rules can be modified and/or duplicated. See Modify ing and Duplicat ing Rules . 

Note: 

When using a PTZ camera, rules should be set for each preset.
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Following is an illustration of the Rules screen:

Rules Screen

The Rules screen includes the following areas and buttons:

Label Description

Active Sett ing Indicates if the rule is currently act ive for use when the camera is armed
for detect ion.

Rules Lis t Lis t of the rule definit ions for the defined region on the camera or preset
as selected in the Preset menu.

Rule Command
Buttons

Buttons apply to the selected rule in the Rules lis t.

• New: Creates a new rule based on the default template for drawing a
region, defining detection, and setting attributes to detect.

• Delete: Deletes the selected rule from the Rules list.

• Duplicate: Creates a new rule based on the selected rule in the
Rules list, using the identical settings, drawings and attributes.

• Apply: Saves changes. All changes are lost if a Rule definition is not
saved before leaving the Rules screen.

Rule Toolbar Tools for graphical definit ion of detect ion rules attributes, such as
drawing detect ion areas , pre-alarm zones, defining spec ific directions ,
etc.

Display Area Shows the camera or preset field of view (FOV). The actual detection
area can be defined as the full FOV (default) or part of it .

Video Control Enable to show a l ive or s ti l l image (pause) of the streaming video in the
display area. In addit ion, a .jpeg pic ture file of a scene captured with the
Snapshot tool on the Live View screen can be uploaded to ease the
detection definit ions on a clear image of the scene.

Show/Hide 
Pre-alarm Zone,
Show/Hide
Custom
Directions and
Color Selection
Buttons

Buttons that show/hide the pre-alarm zone and the custom directions,
and a button that enables you to select the color of a selected area in
the display area.
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Label Description

Unit of Measure Measurement unit used for the Attribute settings . Select from Meters
(Metric Standard) or Feet (English Standard).

Selected Rule Currently selected rule in the Rules lis t, whose parameter vales are
shown in the Attributes area. A selected rule is indicated by a
highlighted gray background.

Rule Type Menu Menu for selecting the type of detection to be used. It opens a lis t of
detection poss ibili ties and l is ts them under the following groups .

• For stationary camera types: Region entrance, Loitering, Tripwire
crossover, Fence trespass, Unattended baggage, Stopped vehicle,
and Object removal.

• For PTZ camera types: Region entrance, Loitering, Tripwire
crossover, and Fence trespass.

Attributes Area Sett ings for the Rule Type detect ion selected.

Min./Max . Size
Simulation

Enables you to simulate the boundaries of the minimum and maximum
sizes of humans or vehic les according to the values defined in the
Attributes area.

The following table describes the icons available for use in defining the Pre-alarm area, direct ions, and
the color of a selected region.

Icon Description

     

No pre-alarm zone.

Shows the pre-alarm zone (allows editing of the pre-alarm zone).

Hides the pre-alarm zone (allows edit ing of the detec t ion area).

No custom directions configured (detec tion in all directions).

    

Shows custom direction arrows.

    

Hides custom direction arrows.

Enables setting a color for the selected region (detec tion region and/or pre-
alarm zone).
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5.4.4.1 Rule Types

Rules can be set for the following rule types:

· Region Entrance

· Loitering

· Tripwire Crossing

· Fence Trespass

· Unattended Baggage

· Stopped Vehicle

· Object Removal

5.4.4.1.1  Region Entrance

This rule detects humans or vehic les that either enter or move within the defined region. The movement
can be qualified by user settings on direction, time, and dis tance traveled. Detec tion can be defined for
human, vehic les or both.

Detection areas can be custom drawn and detection is determined on the locat ion where the object is
standing (lowest part of the object). If spec ial regions (different perspect ive than the main detect ion
plane/ground) are added, the measurement model of the spec ial region takes priority over the detect ion
plane.

Region Entrance includes the following rules:

Rule Icon Description

Human
enters
region

Detects prohibited human movement into or within a region. The rule
identifies moving persons and can detect persons walking upright,
piggyback, running, crawling or walking crouched. This detection
enables the definition of directional movement settings for detecting
human movement in any direction in the region.

Vehicle
enters region

Detects prohibited vehicular movement into or within a region. The rule
 identifies moving vehicles. This detection enables the definition of
directional movement settings for detecting vehicle movement in any
direction in the region.

Human or
vehicle
enters region

Same as above for either persons or vehicles.

5.4.4.1.2  Loitering

This rule detects humans that enter and remain in the spec ific region for a pre-defined period of time. 

Loitering includes the following rule:

Rule Icon Description

Human
loitering

Detects persons which remain inside the specified region for
more than a pre-defined period of time.
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5.4.4.1.3  Tripwire Crossing

This rule detects humans , vehic les or both cross ing a tripwire detection line drawn in the detec t ion
plane. Detection is based on the firs t vis ible movement beyond the line. There are two bas ic types of
tripwire lines: a single point -to-point line or multi-segment.

The detection on the tripwire line can be in a single direction or both direct ions. One-way detection
allows people to cross in the opposite direction and is useful for ex it control or flagging individuals
moving against the flow of traffic .

The tripwire funct ionality performs optimally when the camera is pos itioned to point down the tripwire line
of separat ion,  as  per the fol lowing i l lus t rat ion.

Overhead Optimal Camera View of a Tripwire

Tripwire Cross ing inc ludes the following rules:

Rule Icon Description

Human
crosses
tripwire

Detects if any part of a human crosses over a spec ified line.

This detection enables the definit ion of direct ional movement
settings for detecting human movement over the tripwire line.

Vehic le
crosses
tripwire

Detects if any part of a vehic le crosses over a specified line.

This detection enables the definit ion of direct ional movement
settings for detecting vehic le movement over the tripwire line.

Human or 
vehicle
crosses
tripwire

Detects if any part of a human or a vehic le c rosses over a specified
line. This detect ion enables the definition of directional movement
settings for detec ting human or vehic le movement over the tripwire
l ine.

Human
crosses multi-
 segment
tripwire

Detects if a human crosses over a spec ified line. This detection
enables the definition of directional movement settings for detec ting
 human movement over the multi segment tripwire l ine.

Vehic le
crosses
multi-
segment
tripwire

Detects if any part of a vehic le crosses over a spec ified l ine. This
detect ion enables the definition of directional movement settings for
 detect ing vehic le movement over the multi-segment tripwire line.

Human or 
vehicle
crosses
multi-
segment
tripwire

Detects if any part of a human or a vehic le crosses over a specified
line. This detection enables the definit ion of directional movement
settings for detec ting human or vehic le movement over the multi-
segment tripwire line.
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5.4.4.1.4  Fence Trespass

This rule detec ts movement across a fence line drawn in the detec t ion area. Detection is based on the
firs t vis ible movement beyond the line. Its detec tion differs from tripwire, because it is designed to work
with Advanced Region definit ions that compensate the relat ive size of intruders for climbing (elevat ion)
above the ground detection plane. See Depth Setup Step 3:  Advanced Depth Regions. 

Note: 

A fence compensates the relative size of intruders for climbing (elevation) above the ground detection plane. 

Detection can be assigned a single direction of detection. This one-way detection allows people or vehicles
to pass a fence in the opposite direction. It is useful for exit control or flagging individuals or vehicles
moving against the flow of entrances and exits. Detection of human or vehicle crossing can also be
configured to detect crossing in either direction, for example, over a perimeter fence.

In order to use Fence Trespass detection, a straight-line or multi-segment fence region must be defined in
the depth setup. See To add a straight line fence or To add a multi-segment fence in Depth Setup Step
3:  Advanced Depth Regions. 

Fence Trespass includes the following rules:

Rule Icon Description

Human
crosses
fence

Detects if a human breaches the specified fence line. This
detect ion mode enables the definition of directional movement
sett ings for detecting human movement over the fence line.

Vehicle
crosses
fence

Detects if any part of a vehic le breaches the spec ified fence
line. This detection mode enables the definit ion of direc tional
movement settings for detec t ing vehic le movement over the
fence line.

Human or
vehicle
crosses
fence

Detects if a human or vehic le breaches the spec ified fence
line. This detection mode enables the definition of directional
movement settings for detect ing human or vehic le movement
over the fence line.

Human
crosses
multi-
segment
fence

Detects if a human breaches the fence lines spec ified. This
detec tion mode enables the definition of directional movement
settings for detect ing human movement over the fence line.

Vehic le
crosses
multi-
segment
fence

Detects if any part of a vehic le breaches the spec ified fence
lines. This detect ion mode enables the definition of directional
movement settings for detec ting vehic le movement over the
fence line.
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Rule Icon Description

Human or 
vehicle
crosses
multi-
segment
fence

Detects if a person or vehic le breaches the spec ified fence
lines . This detec tion mode enables the definit ion of directional
movement settings for detec ting human or vehic le movement
over the fence line.

5.4.4.1.5  Unattended Baggage

This rule detects when an item is displayed in a scene and remains unmoved and unattended for a period
of time. It also detects objects that the user left in the scene that were not previously in the scene. This is
helpful for identifying suspic ious bags that may pose a terrorist threat, or even watching for debris, such
as on railroad tracks or highways .

Unattended Baggage includes the following rule:

Rule Icon Description

Object left
behind in
region

Detects qualified objects left behind in a controlled area

Note: 

Unattended Baggage, Object Removal and Stopped Vehicle are static rules that cannot be activated at
the same time as any of the motion type rules above. Motion and static rules can be scheduled to
operate at different times on the same unit. Static type rules cannot be used with PTZ cameras. 

5.4.4.1.6  Stopped Vehicle

This rule detects when a vehicle arrives and remains in an area of interest for a specified time. This
detection can be used for many applications, for example:

• Traffic enforcement of no parking or standing rules.

• Notifying security of parking behavior which can alert security personnel to detect suspicious
behavior, thefts, preplanning, and attacks.

Stopped Vehicle includes the following rule:

Rule Icon Description

Vehicle
stops in
region

Detects if a vehic le stops , parks or remains in an area for a
period longer than the t ime threshold defined.
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Note: 

Unattended Baggage, Object Removal and Stopped Vehicle are static rules that cannot be activated at
the same time as any of the motion type rules above. Motion and static rules can be scheduled to
operate at different times on the same unit. Static type rules cannot be used with PTZ cameras. 

5.4.4.1.7  Object Removal

This rule detects when an item is stolen or removed from its given locat ion. This rule can be designed to
allow a grace period for restoring the item to its location and pos it ion. The rule can be used for safety
and loss prevention, as well as for notification with images of who has moved items of interes t.

Object Removal inc ludes the following rule:

Rule Icon Description

Object
removed
from
location

Detects if an object is removed from its location for a period
longer than the time threshold defined.

Note: 

Unattended Baggage, Object Removal and Stopped Vehicle are static rules that cannot be activated at
the same time as any of the motion type rules above. Motion and static rules can be scheduled to
operate at different times on the same unit. Static type rules cannot be used with PTZ cameras. 

5.4.4.2 Creating New Rules

This section describes how to create new rules and to modify exis ting saved rules.

After c reating a bas ic rule and selecting the rule type, you must define the region to which the rule
applies. See Drawing Detect ion Areas.  

New rules are automatically given default attributes that can be modified as required. See Modify ing
Rule At t ributes .

After c reating and/or modifying a new rule it must be enabled and saved. See Enabling and Apply ing
(Saving) Rules .

Note: 

A unit must be armed in order for it to start detecting according to the enabled rules.
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5.4.4.2.1  To Create a New Rule

To create a new rule

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. Do one of the following:

• If the camera type is a PTZ camera, select a preset from the Preset drop-down list.

• If the camera is not a PTZ camera, continue with the next step.

3. Click New . A new rule is created and is  displayed in the Rule lis t.

4. Enter a name for the rule in the Name column of the Rule lis t.

5. Use the default or define the detection region as described in Drawing Detection Areas. 

6. Click the [b lue hyperlink ] Rule Type that is just above the Attributes area.

7. Selec t the required rule type from the drop-down list. See Rule Types.

8. Modify the rule attributes. See Modifying Rule Attributes.

9. Enable and save the rule. See Enabling and Applying (Saving) Rules.

5.4.4.3 Drawing Detection Areas

By default, the detec tion area of a new rule comprises the entire display area. The default detection area
always has a fil l color. If you plan to change the detect ion area, you must firs t clear (remove) the default
region from the display area.

This section describes how use the icons in the Rule toolbar to draw detection areas in the display area
used in the creation of rules. The icons that are displayed vary according to the rule type. The following
table is a comprehens ive lis t of all the icons that can appear in the Rule toolbar:
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Icon Name Description

Region Entrance and Human Loitering Toolbar

Clear Region Erases all the masks and markers drawn in the display area.

Erase Erases the selected mask or marker in the display area.

Fill Enables you to fill an area is the display area with a selected
color. The selected area should have an external boundary.
Otherwise, the entire display area is fil led with the selected
color.

Line Width Enables you to select a line width for any l ines being drawn.
Each cl ick on the icon changes the line s ize as follows:

Magnifying 
Glass

Magnifies a selected area to fit to the display area.

Pan Enables you to move the image in the display area when it is
magnified.

Penc il Enables you to draw freehand l ines in the display area.

Rectangle Enables you to create a filled rectangular mask area in the
display area.

Line (Polygon) Enables you to draw straight l ines for c reating enc losed polygon
shapes.

Add Direct ion Enables you to add a direct ion and spec ify the direction in which
 movement must be detec ted by the rule.

Delete Direction Deletes the selected direct ion.

Zoom In Magnifies the view in the display area.

Zoom Out Reduces the magnification of the display area.

Normal Size Returns the view from a magnified view to a non-magnified view.
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Tripw ire and Fence Toolbar

Select Enables you to select and move and ex is ting tripwire or fence
detect ion line.

Right side Enables you to draw a new s ingle directional detec t ion tripwire
or fence line in the direction of the arrow. This icon can also be
used to change the direction of an exis t ing direc tional detec t ion
tripwire or fence line.

Left side Enables you to draw a new s ingle directional detec t ion tripwire
or fence line in the direction of the arrow. This icon can also be
used to change the direction of an exis t ing direc tional detec t ion
tripwire or fence line.

Both directions Enables you to draw a new dual directional detec tion tripwire or
fence line. This icon can also be used to change the direct ion of
an exis ting single directional detec t ion tripwire to a dual
direct ional tripwire line.

Clear tripwire/
fence

Deletes the selected tripwire line.

Right s ide Enables you to draw a new s ingle directional detec t ion multi-
segment tripwire or fence line in the direction of the arrow. This
icon can also be used to change the direction of an ex is ting
directional multi-segment detect ion tripwire or fence line.

Left side Enables you to draw a new s ingle directional detec t ion multi-
segment tripwire or fence line in the direction of the arrow. This
icon can also be used to change the direction of an ex is ting
directional multi segment detect ion tripwire or fence line.

Both directions Enables you to draw a new dual directional detec tion multi-
segment tripwire or fence line. This icon can also be used to
change the direct ion of an exis t ing single direct ional detec t ion
multi-segment tripwire to a dual directional multi segment tripwire
line.
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5.4.4.3.1  To Remove the Default Detection Area

To remove the default detection area

1. The default detec t ion area is displayed as follows:

Default Detection Area

2. From the Rule toolbar, selec t the Clear Region tool . The color is removed from the
detect ion area.

Default Detection Area – Color Removed
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5.4.4.3.1.1  To Change the Color of a Detection Area

To change the color of a detection area

1. The following is an example of a defined detect ion area:

Defined Detection Area

2. From the Color drop-down list  , select a new color. The following is an illustration of the
defined detection area after the color was changed. 

Defined Detection Area After Changing Color
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5.4.4.3.1.2  To Draw Freehand Lines Using the Pencil Tool

To draw freehand lines using the Pencil tool 

1. From the Rule toolbar, selec t the Pencil tool . The cursor changes to a penc il shape.

2. Us ing the pencil cursor, point to the locat ion on the image where you want to start drawing.

Drawing a Freehand Line — Start

3. Click and drag the cursor and draw the l ine.

4. Release the mouse button when finished. The freehand line is completed.

Drawing a Freehand Line — Finish
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5.4.4.3.1.3  To Draw Straight Lines Using the Polygon Line Tool

To draw straight lines using the Polygon Line tool

1. From the Rule toolbar, selec t the Line tool . The cursor changes to a polygon shape.

2. Us ing the polygon cursor, point to the locat ion on the image where you want to s tart the line.

3. Click to set each point of the out line of the polygon.

Drawing a Straight Line

4. Click  on the firs t point to close the polygon. The polygon is completed.

Completing the Polygon Shape
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5.4.4.3.1.4  To Draw a Rectangle Using the Rectangle Tool

To draw a rectangle using the Rectangle tool

1. From the Rule toolbar, selec t the Rectangle tool  .The cursor changes to a polygon shape.

2. Us ing the polygon cursor, point to the locat ion in the image where you want to start the
rectangle.

Drawing Rec tangle - Start

3. Click and drag the mouse away from the start point to complete the rectangle.

4. Release the mouse button. The rectangle is completed.

Completing the Rectangle
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5.4.4.3.1.5  To Fill an Area Using the Fill Tool

To fill an area using the Fill tool

1. From the Rule toolbar, selec t the Fill tool  . The mouse changes to fil l shape.

2. Move the fil l cursor over the area in the image that you want to fi ll and c lick the mouse. The
color fills the selected area.

Filling a Polygon Shape

Note: 

 If the borders of the polygon shape are not complete, c l ick  Fill to fil l the ent ire image.

Caution: 

All enclosed regions must be filled or detection will not take place.
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5.4.4.3.1.6  To Erase an Area in a Color Mask Using the Eraser Tool

To erase an area in a color mask using the Eraser tool

1. From the Rule toolbar, selec t the Eraser tool . The mouse changes to a rec tangular shape.

2. Us ing the mouse point to the location on the image where you to remove (erase) previous ly
drawn color mask ing.

Using the Eraser Tool – Start

3. Click and drag the mouse over the area that you want to erase. The color mask ing is erased.

Using the Eraser Tool – Finish
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5.4.4.3.1.7  To Clear All Masks from the Display Area

To clear all masks from the display area

1. From the Rule toolbar, selec t the Clear Region tool  . A message is displayed ask ing you
to confirm that you want to clear al l mask ing from the display area.

2. Click Yes. Al l the mask ing in the display area is cleared.

5.4.4.3.1.8  To Change the Line Pencil and Eraser Tool Thickness

To change the Line Pencil and Eraser tool thickness (line style)

1. From the Rule toolbar, click the Line Width tool  .

2. Continue clicking until the desired line width is displayed in the icon. Each click increments the

line to the next width .

5.4.4.4 Modifying Rule Attributes

Rules have different attributes that must be defined for each rule type. Attributes are divided between
two categories: basic and advanced. By default, the detection set ting attributes are designed for the
most common detec tion rules. These attributes can be changed to opt imize detection for unique
requirements of the camera or viewing scene.

The following table lis ts all the rule at tributes. When you choose to define a rule type, only the at tributes
available for that rule are displayed in the Attributes area. See Figure: Rules  Screen.

Tip:

Avoid changing Advanced detection rule attributes unless you fully understand their necessity and the
consequences of the change. 

Icon Setting Name Description

Basic Attributes

Direction Places direct ional criteria on detection, enabling
detection only when the person/vehic le moves on a
spec ific (custom) direction.

When setting the direction, you can define tolerances
(variances) from the general direction. A person/vehic le
moving in the general direction (including the tolerances)
is detected. Persons/vehic les moving in a direction not
spec ified are not detected. Up to four directions can be
placed in a region.

Pre-Alarm Zone Enables an exterior buffer zone to be defined for pre-
qualifying objects surrounding the region of interest for
detec tion. This expedites detect ion if a person enters the
detect ion zone (pre-alarm zone).
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Icon Setting Name Description

Scene Type Defines the density of the scene. You can choose from:

• Sterile

• Semi-crowded

• Crowded

Alerts Defines the waiting t ime prior to rais ing an alarm
according to the detect ion type.

Advanced Attributes

Size Spec ifies the s ize range of moving persons or vehic les
to be detected.

Max . Speed Defines the upper speed threshold for moving persons or
vehic les. Objects moving faster than this speed are
disqualified.

Time in region Defines the time-in-region and stationary time under the
threshold that must be exceeded for a person or vehic le
to be detected.

Max . Stat ionary t ime The maximum time allowed for an object before it
becomes part of the scene.

Dis tance inside region Defines the movement threshold that must be exceeded
for a person or vehic le to be detected.

Slow crawlers/small
animal detection

Enables or disables detection of very s low crawlers and
small animals . Used mainly for mil itary grade detection.

Note: 

1. By default, the Slow crawlers/small animal detection option is disabled in the above rules,
meaning that the system is identifying people standing or walking upright. Selecting 
Enable activates the identification of sophisticated intruders.

2. The Slow crawlers/small animal detection option is not supported for the following rules:
Object left behind in region, Vehicle stops in region, and Object removed from location.

3. For all other rules, the default setting is Enabled (identifying sophisticated intruders), which
cannot be changed.
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To enable the identification of people standing upright

1. Select Setup > Rules. The Rules screen opens. See Figure: Rules  Screen.

2. Click the Basic tab in the Attributes area.

3. Click the link displayed above the Attributes area and select one of the following rules:

· Human enters region

· Human loitering

· Human crosses tripwire

· Human crosses multi-segment tripwire

4. Select the checkbox for Enable detection of small, crawling or slow intruders.

Enable Identification of Upright People

Note: 

It is possible that a person who is not standing upright might not be detected when: 

• Crawling

• Walking on all four (like an animal)

• Camouflaged to look like an inanimate object (i.e., small tree)

• Running and viewed from the side

• Bent over and viewed from the side

In these cases, in order to enable the identification of upright people and reduce false alarms, the
camera should not be facing straight where the camera does not have good low-light sensors or
thermal sensors, detection might be reduced due to insufficient data. 

The following sect ions describe how to modify rule attributes:

• Modifying Region Entrance Rule Attributes

• Modifying Human Loitering Rule Attributes

• Modifying Tripwire Crossover Rule Attributes

• Modifying Fence Trespass Rule Attributes

• Modifying Unattended Baggage Rule Attributes

• Modifying Stopped Vehicle Rule Attributes

• Modifying Object Removal Rule Attributes 
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5.4.4.4.1  Modifying Region Entrance Rule Attributes

Region Entrance rules identify moving persons and/or vehic les entering a predefined region. In the case
of humans,  Region Entrance rules can detect persons walk ing upright , piggyback , running, c rawling or
crouching.

Note: 

The rule attributes change according to the rule type and the object to be detected (human, vehicle or both).

The following illustration shows the Rules screen for defining the Basic Region Entrance Rule attributes .
The rule attributes are highlighted in the red rec tangle on the right of the screen.

Basic Rule Attributes for Human or Vehicle Entering Region

The following sect ion describes how to modify a rule to detect when a human and/or vehic le enters a
region.

5.4.4.4.1.1  To Modify a Rule to Detect When a Human and/or Vehicle Enters a Region

To modify a rule to detect when a human and/or vehicle enters a region

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See
Figure: Rules  Screen.

2. From the Rule list, select the rule that you want to modify.

3. If you want to modify the Rule Type, click the [blue hyperlink] Rule Type located above the
Attributes area from the list that is displayed.

4. Select the required rule type. See Rule Types.

5. If you want to rename the rule, enter a new descriptive name for the rule in the Rule column of
the Rule list.

6. Modify the region where detection will take place. By default, when a new rule is created, a
companion region is created in the full field of view. 



November 7, 2016
144

Configuring the Unit

HTML Edition Units User Guide

7. To change the region that is  displayed in the display area, do the following:

a. If you want to erase and redraw the selected region, click Erase  in the Rule toolbar.

b. Select a drawing tool and redraw the detection region. For more information on how to
use the Rule toolbar drawing tools , see Drawing Detection Areas.

5.4.4.4.1.2  To Modify Basic Attributes

To modify Basic Attributes

1. Modify the Direction at tribute(s) as described below in To define directions.

2. Modify the Pre-alarm Zone attribute(s) as described below in To define the pre-alarm zone.

3. Check Enable detection of small, crawling or slow intruders if you wish to identify sophisticated
intruders.

4. Click Apply. The rule is modified.

5.4.4.4.1.3  To Modify Advanced Rule Attributes

To modify Advanced Rule Attributes

In the following example for defining Advanced Region Entrance rule attributes, the advanced rule
attributes are highlighted in the red rectangle on the right of the screen.

Advanced Rule Attributes for Human or Vehicle Entering Region

1. From the Rules window, click the Advanced tab in the Attributes section.

2. Modify the Size attribute(s).  Do one of the following:

• Click the [blue hyperlink ] value to the right of the Size label if you are modifying the detection
 rule attributes for humans or vehicles. Click OK when finished.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Human
Size dialog box and/or Set Vehicle Size dialog box. Click OK when finished.
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3. Modify the Max. Speed attribute(s). Do one of the following:

• Click the [blue hyperlink ] value to the right of the Max. Speed label if you are modifying the
detection rule attributes for humans or vehicles. Click OK when finished.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Maximum
Human Speed dialog box and/or Set Maximum Vehicle Speed dialog box. Click OK when
finished.

4. Modify the Distance inside region at tribute(s). Do one of the following:

• Click the [blue hyperlink ] value to the right of the Distance label if you are modifying the
detection rule attributes for humans or vehicles. Click OK when finished.

• If you select Custom, set the values for the minimum distance in the Set Human Minimum
Distance dialog box and/or Set Vehicle Minimum Distance dialog box. Click OK when finished.

5. Modify the Time in region attribute(s). Do one of the following:

• Click the [blue hyperlink ] value to the right of the Time label and within the phrase “At least
[blue hyperlink ] sec” for a time zone if you are modifying the detection rule attributes for
humans or vehicles. Click OK when finished.

• If you select Custom, set the values for the time in zone in the Set Human Time In Zone dialog
box and/or Set Vehicle Time In Zone dialog box. Click OK when finished.

6. Modify the Max. Stationary t ime attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Time label and within the phrase “Stationary
no more than [blue hyperlink ] sec” if you are modifying the detection rule attributes for
humans or vehicles. Click OK when finished.

• If you select Custom, set the values for the “stationary no more than” time in the Set Human
Time Static dialog box and/or Set Vehicle Time Static dialog box. Click OK when finished.

7. Modify the Slow crawlers/small animals detect ion attribute(s) as follows:

• Click the value to the left of the label in the [blue hyperlink ].

• Enable or disable it as required.

5.4.4.4.1.4  To Define Directions

To define directions

1. By default, the All attribute is selected. Any object (human or vehic le) moving in any direct ion
within the detect ion region wil l be detected.

2. To define custom directions, click the [b lue hyperl ink ] value to the right of the Direction label.

3. Select Custom . A direct ional arrow  is displayed in the display area. The center vertical
arrow defines the main detec t ion direction. The horizontal arrows to the left and right of the
center arrow determine the tolerance or deviation from the center that is allowed. Adjust the
pos ition of the tolerance arrows by dragging either of the arrowheads to the required tolerance.
Both arrowheads move in synch.

4. Click the Select tool . Drag the arrow to a pos it ion in the detection area where you want to
define the detec t ion direction.

5. Set the custom direction by dragging the center arrow and turning it to point towards the
required direction of movement detec tion. Select the tolerance arrows and turn them to set the

allowed deviat ion from the main direction .
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6. To add a new direction, click the New Direction icon  in the Rule toolbar. The new direction
is added. 

Note: 

A detec tion rule can have up to four direct ions . 

7. If necessary, modify the at tributes of the new direction as described in the previous step.

8. To delete a direction, do the following:

• Select the direction you want to delete by using the Select tool . 

• Click the Delete Direction icon  in the Rules toolbar. The direction is deleted.

9. Click the Show/Hide Directions but ton  to show or hide the direction arrows.

The following is an illustration of the display area with a s ingle direction arrow.

Direction Arrows in Detection Area

5.4.4.4.1.5  Pre-Alarm Zones

A pre-alarm zone is an area where the unit detects according to the detect ion rules, but does not trigger
any alarm notifications in case of detect ion. It can be used in narrow detection areas where it is
preferable to detect and track before an intruder enters the detection area for a short period of time.

To define the pre-alarm zone

1. Click the [blue hyperl ink ] value to the right of the Pre-alarm Zone label.

2. Selec t On. The entire display area becomes a pre-alarm zone as shown below.
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Default Pre-alarm Zone

3. From the Rule toolbar, c lick the Clear Region icon  to delete the default pre-alarm zone (full
FOV).

4. Click the Show/Hide Pre-alarm Zone button  . Using one of the drawing tools in the
Rules toolbar, draw a new pre-alarm zone. The following is an example of custom pre-alarm
zones.

Custom Pre-Alarm Zones

Note: 

For more information on how to use the Rule toolbar drawing tools , see Drawing Detection
Areas. 
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5. To change the color of the pre-alarm zone, do the following:

• From the Rule toolbar, click the Select icon  to select the pre-alarm zone.

• Select a color from the Color drop-down list .

Note: 

Use the  icon to switch between detection and pre-alarm areas. 

5.4.4.4.2  Modifying Human Loitering Rule Attributes

Loitering rules detect persons that remain in a spec ific region for a pre-defined period of time.

In the following Rules screen for defining Human Loitering attributes , the rule attributes are highlighted
in the red rec tangle on the right of the screen.

Rule Attributes for Human Loitering

5.4.4.4.2.1  To Modify a Rule to Detect Human Loitering

To modify a rule to detect human loitering

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select Human Loitering.

5. To rename the rule, enter a name for the rule in the Rule column of the Rule list.

6. Modify the region where detection will take place as required. By default, when a new rule is
created a companion region is created on the full field of view. 

7. To erase and redraw the selected region, click Erase  in the Rule toolbar.
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8. Select a drawing tool and redraw the detection region. 

Note: 

For more information on how to use the Rule toolbar drawing tools , see Drawing Detection
Areas. 

9. Modify the Time attribute as follows:

• Select a [blue hyperlink ] value that is displayed to the right of the Time label and within the
phrase “At least [blue hyperlink ] sec. in zone”. Click OK when finished.

• If Custom is selected, set the values for the minimum time in zone in the Set Human Time in
Zone dialog box. Click OK when finished.

10. Modify the Slow crawlers/small animals detect ion attribute(s) as follows:

• Click the [blue hyperlink ] value to the left of the label and enable/disable as required.

• Click Apply. The rule is modified.

5.4.4.4.3  Modifying Tripwire Crossover Rule Attributes

Tripwire Crossover rules detect humans , vehic les or both when cross ing a s ingle or multi-segmented
tripwire line. Detect ion is based on the firs t vis ible movement beyond the line.

Rule attributes are highlighted in the red rectangle on the right of the following Rules screen for defining
Human or Vehic le Cross ing Tripwire attributes.

Rule Attributes for Human or Vehicle Crossing Tripwire

To modify a rule to detect when a human and/or vehicle crosses a tripwire line

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select the required rule type. See Rule Types.

5. To rename the rule, enter a descriptive name for the rule in the Rule column of the Rule list.
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6. Modify the direction by using either the direction icons or the selection [blue hyperlink] in the
direction attribute area.

7. Click  to select the tripwire line.

8. Do one of the following: 

· Click  ,  or  to change the directional detection as needed.

· Click the [blue hyperlink ] in the direction attribute area, and select a value from the list that is
displayed.

9. Click Apply. The rule is modified.

Note: 

The direction (left/right) is referenced as looking from the start point of the tripwire line to the end
point. 

5.4.4.4.4  Modifying Fence Trespass Rule Attributes

Fence trespass rules detec t movement across a fence line. Its detection differs from tripwire in that it is
des igned to work with Advanced Region definitions that compensate for the relat ive size of intruders for
c limbing (elevat ion) above the ground detec tion plane. The Advanced Region definit ions must be defined
before defining this rule type. See Depth Setup Step 3: Advanced Depth Regions.

The following is an example of the Rules screen for defining Human or Vehic le Cross ing Fence Basic
attributes.

Basic Rule Attributes for Human or Vehicle Crossing Fence
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5.4.4.4.4.1  To Modify a Rule to Detect When a Human and/or Vehicle Crosses a Fence Line

To modify a rule to detect when a human and/or vehicle crosses a fence line

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select the required rule type. See Rule Types .

5. To rename the rule, enter a name for the rule in the Rule column of the Rule lis t.

6. From the Fence Region drop-down lis t to the right of the selected detection rule [blue hyperl ink ],
choose an exis ting straight line fence or multi-segmented fence.

7. To change the direction of the detec t ion on the fence, do one of the following:

• Click ,  or  to achieve the directional detection required

• From the Direction attribute, click the [blue hyperlink ] and select the required direction.

8. Click Apply. The rule is modified.

5.4.4.4.4.2  To Modify Advanced Attributes

To modify advanced attributes

The following is an example of the Rules screen for defining Human or Vehic le Cross ing Fence Basic
At tributes .

Advanced Rule Attributes for Human or Vehicle Crossing Fence

1. Click the Advanced tab in the Attributes section.

2. Modify the Size attribute(s) as follows:

• Select a [blue hyperlink ] value to the right of the Size label if you are modifying the detection
rule attributes for humans or vehicles.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Human
Size dialog box and/or Set Vehicle Size dialog box. Click OK.
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3. Modify the Max. Speed attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Max. Speed label, and select a value from
the list that is displayed. If you are modifying the detection rule attributes for humans or
vehicles the Max. Speed values for both humans and vehicles are displayed.

• If Custom is selected, set the values for the minimum and maximum sizes in the Set
Maximum Human Speed and/or Set Maximum Vehicle Speed dialog box. Click OK when
finished.

4. Modify the Slow crawlers/small animals detect ion attribute(s) as follows:

• Click the [blue hyperlink ] value to the left of the label.

• Enable or disable as required.

5. Click Apply. The rule is modified.

Note: 

The fence height and width propert ies can be changed in the Advanced Depth Regions. 

5.4.4.4.5  Modifying Unattended Baggage Rule Attributes

Unattended Baggage rules detect when an item is displayed in a scene and remains unmoved and
unattended for a pre-defined period of time.

Note: 

Unattended Baggage is a static rule that is not supported on PTZ cameras.

In the following example of the Rules screen for defining Object Lef t Behind in Region attributes, the
rule attributes are highlighted in the red rectangle on the right of the screen.

Rule Attributes for Object Left Behind in Region
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To modify a rule to detect an object left behind in a region

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select Object left behind in region. See Rule Types.

5. To rename the rule, enter a name for the rule in the Rule column of the Rule list .

6. Modify the region where detection will occur as required. By default, when a new rule is created,
a companion region is created on the full field of view.

• To erase and redraw the selected region, click Erase  in the Rule toolbar.

• Select a drawing tool and redraw the detection region. 

Note: 

For more information on how to use the Rule toolbar drawing tools , see Drawing
Detection Areas. 

7. Modify the Size attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Size label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Baggage
 Size dialog box. Click OK when finished.

8. Modify the Scene type at tribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Scene type label, and select a value from the
list that is displayed.

9. Modify the Time until alert attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Alerts label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum period in the Set Time to
Alarm dialog box. Click OK when finished.

10. Click Apply. The rule is modified.

5.4.4.4.6  Modifying Stopped Vehicle Rule Attributes

Stopped Vehic le rules detec t when a vehic le has arrived and remains for a spec ified time in an area of
interest.

Note: 

Stopped Vehicle is a static rule that is not supported on PTZ cameras.
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In the following example of the Rules screen for defining Vehic le Stops in Region attributes, the rule
attributes are highlighted in the red rec tangle on the right of the screen.

Rule Attributes for Vehicle Stops in Region

To modify a rule that detects when a vehicle stops in a region

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select Vehicle stops in region. See Rule Types.

5. To rename the rule, enter a name for the rule in the Rule column of the Rule lis t.

6. Modify the region where detection will occur as required. By default, when a new rule is created,
a companion region is created on the full field of view.

• To erase and redraw the selected region, click Erase  in the Rule toolbar.

• Select a drawing tool and redraw the detection region. For more information on how to use the
 Rule toolbar drawing tools, see Drawing Detection Areas.

• Modify the detection sett ings attributes, as required. By default, the detection sett ing
attributes are des igned for the most common detection rules. These attributes can be
changed to opt imize detection for unique requirements of the camera or preset scene.

7. Modify the Size attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Size label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Baggage
 Size dialog box. Click OK when finished.

8. Modify the Scene type at tribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Scene type label, and select a value from the
list that is displayed.

9. Modify the Time until alert attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Alerts label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum period in the Set Time to
Alarm dialog box. Click OK when finished.
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10. Click Apply. The rule is modified.

5.4.4.4.7  Modifying Object Removal Rule Attributes

Object Removal rules detect when an item is stolen or removed from its given location.

Note: 

Object Removal is a static rule that is not supported on PTZ cameras.

In the following example of the Rules screen for defining the Object Removed from Location attributes, the
rule attributes are highlighted in the red rectangle on the right of the screen.

Rule Attributes for Object Removed from Location

To modify a rule to detect an object removed from a region

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule that you want to modify.

3. To modify the Rule Type, c lick the [b lue hyperlink ] Rule Type located above the Attributes area.

4. Select Object removed from location. See Rule Types.

5. To rename the rule, enter a name for the rule in the Rule column of the Rule lis t.
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6. Modify the region where detection will occur as required. By default, when a new rule is created,
a companion region is created on the full field of view.

• To erase and redraw the selected region, click Erase  in the Rule toolbar.

• Select a drawing tool and redraw the detection region. For more information on how to use the
 Rule toolbar drawing tools, see Drawing Detection Areas.

• Modify the detection sett ings attributes, as required. By default the detection sett ing
attributes are des igned for the most common detection rules. These attributes can be
changed to opt imize detection for unique requirements of the camera or preset scene.

7. Modify the Size attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Size label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum sizes in the Set Baggage
 Size dialog box. Click OK when finished.

8. Modify the Scene type at tribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Scene type label, and select a value from the
list that is displayed.

9. Modify the Time until alert attribute(s) as follows:

• Click the [blue hyperlink ] value to the right of the Alerts label, and select a value from the list
that is displayed.

• If you select Custom, set the values for the minimum and maximum period in the Set Time to
Alarm dialog box. Click OK when finished.

10. Click Apply. The rule is modified.

5.4.4.5 Simulating Maximum and Minimum Object Sizes

You can s imulate the maximum and minimum size of objects to be detec ted (the persons,  vehic les, or
objects) on the video screen, in order to verify and confirm the s ize attributes defined in the detection
rule.

Note: 

1. In order to be detec ted, an object must be between the minimum and maximum size of the
simulated image. Move the OSD s imulat ion around the scene and confirm it fits the required
size of the persons,  vehic les, or objects to be detec ted.

2.  When moving the simulation, its size changes according to the calculated size values on the
spec ific locat ion based on the depth (perspective) settings defined for the scene. 

To simulate the Min./Max. object size

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. On detection rules with both Basic and Advanced attributes, select the Advanced Attributes
tab.
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Advanced Attributes Tab Size Settings

3. In the checkbox at the bottom of the Attributes area, select the type of object to simulate
(Human or Vehicle). An On-Screen Display (OSD) s imulation of the minimum (small box) and
maximum (large box) object size is shown on the video screen.

4. Set the minimum and maximum size of the object.

Set Human Size Dialog Box

5. Click and drag the bottom (center) point of the OSD s imulation to move the simulation inside
the scene. The simulat ion size changes according to the size values calculated on the spec ific
locat ion.

6. Click and drag on the simulation borders to change the ratio of its height or width.

7. Click and drag the simulation corners to change the minimum or max imum object size or define
them in the attributes section.

8. Confirm that a typical object to be detec ted is between the minimum and maximum s imulated
size.

9. If necessary, change the object size attributes accordingly.

10. Click Apply to save the changes.

Note: 

Use the Zoom-in, Zoom-Out, Pan, and 1:1 tools to enlarge and focus on the object to improve the
simulation accuracy. 
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5.4.4.6 Restoring Rule Attributes to their Default Settings

You can restore a rule attributes to their default settings to cancel any changes performed by the user.

To restore the detection rules attributes to its default settings

1. Click Restore default settings.

Basic Attributes Area

2. Click Apply.

5.4.4.7 Enabling and Applying (Saving) Rules

You can enable and disable rule definit ions in the Rule table. Only enabled definitions are used when a
camera is armed.

To enable or disable a rule

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. In the Active column of the Rule list, select or c lear the rules that you want to enable or disable.

3. Click Apply. The rules are enabled or disabled.

5.4.4.8 Modifying and Duplicating Rules

You can modify or duplicate an exis ting rule. The procedure for modifying ex is ting rule is the same as
for modifying new rules. See Modifying Rule Attributes.

To modify the detect ion area for a rule, follow the procedures described in Drawing Detection Areas.

To duplicate a rule

1. In the Setup workspace, select Analytics > Rules. The Rules screen is displayed. See Figure:
Rules  Screen.

2. From the Rule list , select the rule you want to duplicate.

3. Click Duplicate. The rule is duplicated and is displayed in the Rule list .

4. Modify the detection area of the duplicated rule. See Drawing Detection Areas.

5. Modify the rule attributes as described in Modifying Rule Attributes.

6. In the Active column of the Rule list , select or c lear the rules that you want to enable or
disable.

7. Click Apply. The duplicated rule is saved.
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5.5 Configuring Advanced Analytic Settings
Enhanced detection is possible in scenes where there is movement in up to 80% of the frame. This
function is enabled by default. When the trk-101 and trk-101-P are operating in DVR and HD Analytic
Analog modes, the distance from which smaller objects are detected is enhanced and enabled by default.

To disable enhanced detection distance

· Uncheck the Enable enhanced detection checkbox in the Advanced Settings area of the
Setup > Analytics > Advanced screen. 

Analytics > Advanced > Advanced Settings 

5.6 Configuring the Event Engine
The unit’s embedded event engine enables you to define responses (automatic actions) for selected
events and to perform actions at pre-defined times (scheduled actions).

Each automatic response definition includes the following three parameters :

• Triggering event – The event that will start the automatic response.

• Actions – The actions to perform in response to the occurrence of the triggering event.

• Schedule – When to monitor for the triggering event occurrence.

Each scheduled action includes the following two parameters :

• Actions – The actions to perform at the scheduled time.

• Schedule – When the actions must be performed.

Mult iple events or scheduled actions can be defined per unit. Ac t ions can be defined to be performed (a)
locally on the configured unit, or (b) remotely on external units. For example, upon Intrus ion detec t ion
from this camera, to move a PTZ camera on the second floor to preset 5.
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The following is an illustration of the Responses screen:

Responses Screen

The following is an illustration of the Sched. Actions screen:

Sched. Actions Screen

The Responses and Sched. Actions screens are similar, except that the Responses screen includes
the Triggering Event tab. Both pages include a section where defined responses or scheduled events
are l is ted, as well as tabs for their sett ings . 
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The Events lis t inc ludes the following columns and buttons:

Setting Description

Name The automatic response or scheduled event custom name as given by the
user.

Enabled Enables and disables the spec ific automatic response or scheduled event .

Event Description of the triggering event type (for Responses only).

Action Description of the ac tions to perform .

Schedule For an automatic response indicates when the triggering event will be
monitored (always or scheduled).

For a scheduled event indicates when the act ions shall be performed.

Add Adds a new event definit ion to the Events l is t.

Delete Deletes the selected event in the Events l is t.

The Responses and Sched . Events screens include the following tabs:

• Triggering Events: Responses screen only. Defines the type of event which will start the automatic
response. 

• Actions: When configuring automatic responses, defines the actions to be performed on the
occurrence of a triggering event. When configuring a scheduled event, defines the actions to be
performed on the scheduled date or time.

• Schedule: When configuring automatic responses, this tab enables you to define when to monitor
for the triggering event occurrence. See Configuring When to Perform Scheduled Actions. When
configuring Scheduled actions, this tab enables you to define when the actions must be performed.
See Configuring Scheduled Actions.

5.6.1 Defining Automatic Responses

An automatic response is a set of actions to be taken upon the occurrence of the triggering event during
a defined monitoring period (schedule).

To configure automatic responses in the unit

1. In the Setup workspace, select Analytics > Responses. The Responses screen opens. See
Figure: Responses Screen.

2. Click Add. A new event is added and is displayed in the Events l is t. 

3. Configure the Triggering Event tab, as described in Configuring a Triggering Event.

4. Configure the Actions tab, as described in Configuring the Actions to Perform.

5. Configure the Schedule tab, as described in Configuring the Monitoring Schedule for Automatic
Responses.

6. Click Apply. The automatic responses sett ings are saved. 

7. After configuring responses, you can perform the following functions:

• Sort Events

• Delete Events
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5.6.2 Configuring Scheduled Actions

Scheduled act ions perform an act ion on a spec ific date or time or on a recurring bas is over a defined
time period (schedule).

To configure automatic responses in the unit

1. In the Setup workspace, select Analytics > Sched. Actions. The Sched. Actions screen is
displayed. See Figure: Scheduled Actions.

2. Click Add. A new event is added and is displayed in the lis t.

3. Configure the Actions tab, as described in Configuring the Actions to Perform.

4. Configure the Schedule tab, as described in Configuring When to Perform Scheduled Actions.

5. Click Apply. The scheduled actions settings are saved.

6. After configuring responses, you can perform the following functions:

• Sort Events

• Delete Events

5.6.2.1 Configuring a Triggering Event

Note: 

Triggering events refer only to responses and are not applicable when configuring scheduled actions.

The Triggering Event tab enables you to define triggering events that initiate an automatic response. An
automatic response is an action that is defined in the Actions Tab and executed during the monitoring
period defined in the Schedule tab. See Configuring the Monitoring Schedule for Automatic Responses. 

The Triggering Event tab inc ludes the following fields:

Setting Description

Detection by type Triggers an automatic response in case the unit detects according
to a detect ion rule matching the selected type:

• Intrusion detection

• Vehicle Stopped

• Unattended Object

• Object Removal

• Tripwire detection

• Fence detection

• Loitering detection

• Any detection

Detection by rule Triggers an automatic response according to a spec ific detection
rule defined in the unit .

External alarm 
(dry contact)

Triggers an automatic response when the unit detects dry contact
alarms received from connected alarm Inputs.
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Setting Description

No more detect ions
left in scene

Triggers an automatic response in case no detec tions are left in
the scene.

Video signal Triggers an automatic response in case one of the following video
signal s tatus not ifications occur:

• Video Signal OK

• No Video Signal

• Low Video Signal

• Bad Video Signal

• Camera Shift

Power On Triggers an automatic response when the unit’s power is turned
on.

Arm Triggers an automatic response when the unit’s status is changed
to arm .

Disarm Triggers an automatic response when the unit’s status is changed
to disarm .

To configure a triggering event

1. In the Setup workspace,  selec t  Events > Responses. The Responses screen is displayed.
See Figure: Responses screen.

2. Define the Triggering Events tab as follows:

Trigger Type Action

Detection alarm
type

Select detection alarm trigger from the Detection by type drop-down
list.

Specific rule alarm Select Detection by rule.

Select the rule to use as a trigger from the Detect ion rules drop-
down lis t.

External alarm 
(dry contacts)

Select External alarm (dry contact). 

From the drop-down l is t, select the dry contact to monitor.

Select whether to trigger an alarm when the selected dry contac t
s tate is Open or Close.

After all detected
objects leave the
scene

Select No more detections left in scene.

Following changes
in the video s ignal
state

Select Video signal.

Select the type of video signal alarm to use as a trigger from the 
Video signal drop-down list:

• Video Signal OK

• No Video Signal

• Low Video Signal

• Bad Video Signal

• Camera Shift

• Any tamper
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Trigger Type Action

Following powering
up the unit

Select Power on.

Following the arming
of the unit or
channel event

Select Arm.

Following the
disarming of the unit
or channel event

Select Disarm.

3. Click Add to add the event to the Events list at the top of the page. The event is enabled.

4. Assign a name to the event by entering a name in the Response_x field, where x is the number of
the response.

5. Uncheck the Enable checkbox to disable the response.

6. To modify an event setting, simply change the setting in the Triggering Event tab and click Apply.

5.6.2.2 Configuring the Actions to Perform

When defining automatic responses , the Act ions tab enables you to define the ac tions to be performed
when the triggering event occurs during the monitoring schedule.

When defining scheduled actions, the Actions tab enables you to define the actions to be performed at the
scheduled time.

The following is an example of the Actions tab. The details shown on this tab vary according to the
action chosen from the drop-down lis t:

Actions Tab
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Warning:

The relay output can be used for automatic responses that are initiated without intervention from an
outside user. Never use the relay output for automation that cannot be overridden or may cause
damage, injury or loss of l ife. 

Because an ioi unit can automatically change the relay output state (NORMALLY OPEN or
NORMALLY CLOSED) of devices controlled by the sys tem , safety measures should be taken as a
precaution.

The Actions tab includes the following fields:

Setting Options Description

Action Defines the ac tions to be performed when the triggering
event configured in the Triggering Event tab occurs
during the monitoring schedule.

Perform on
this/remote
unit

Defines the unit to perform the selected actions: unit
being configured (local) or remote unit according to IP
address .

Sett ings Sett ings according to the selected ac t ion to perform .

5.6.2.2.1  To Configure the Actions Tab

To configure the Actions tab

1. Select the Actions tab. The Actions tab is  displayed.

2. From the Actions list , select the action to configure.

3. From the Action drop-down list, select the action to perform on event occurrence.

4. Define the unit to perform the spec ific action:

• By default, the action is performed on the unit you are configuring.

• To perform the action on another unit, click Perform on this unit. 

5. Enter and verify the IP address of the unit on which you want the ac tion performed.

6. Click OK. The IP address of the unit on which the action is to be performed is displayed in the
Act ions tab in place of the Perform on this unit l ink .

7. Define the Sett ings for the selected action:

Activate relay output
• In the Activate relay setting, select one of the two options for when to activate the relay:

§ Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box
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• Select the Activation signal: 

§ Continuous: Select On or Off

§ Pulse activation: In the Pulse duration field, enter the duration of the pulse in
seconds

Clear alarms
• Select when you want to clear alarms:

§ Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

Arm/Disarm camera 
• Select when you want the camera armed: 

§ Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

Arm/Disarm alarm input
• Select when you want the alarm input armed or disarmed:

§ Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

• From the Alarm input drop-down list, select the alarm input you want to arm or disarm.

Clear external alarm input
• Select if you want the dry contact alarm cleared:

§  Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

• From the Alarm input drop-down list, select the alarm input you want to clear

Send email
• Select when you want to perform the action:

§  Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

• Enter the email recipients ("To:" and "Cc:")

• Keep the default notification message or click Edit to customize the email content

• Check or uncheck the box to include an image of the event as an attached file

Enable/Disable detection rule
• Select when you want a detection rule enabled or disabled:

§ Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

• From the Rule name drop-down list, select the rule to be enabled or disabled

Control PTZ camera actions
• Select when you want to perform the action:

§  Immediately 

§ After x seconds, where x is the number of seconds to enter in the text box

• Select the action to perform from:

§ Go To Preset and then select the required preset from the drop-down list

§ Start/Resume Playlist

§ Stop Playlist

§ Pause Playlist

8. If you want to add additional actions for this triggering event , Click Add. A new action is added
to the Action list .
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9. Configure the new action as described in steps 3 through 5.

10. Repeat s teps 6 and 7 for all new actions that you want to add to this triggering event.

11. To delete any of the ac t ions for this triggering event , select the required ac tion in the Action list
and cl ick Delete. The selected ac t ion is deleted.

12. Repeat s tep 9 for all act ions you want deleted for this t riggering event.

13. If required, change the order in which you want the actions performed using the Up and Dow n
buttons.

5.6.2.3 Configuring the Monitoring Schedule for Automatic Responses

This section describes how to configure the Schedule tab in the context of an automatic response event.

The Schedule tab enables you to configure a time schedule when the occurrence of triggering events
should be monitored. See Configuring a Triggering Event.

If you want to configure a schedule for a scheduled action (when a scheduled action should take place),
see Configuring When to Perform Scheduled Act ions.

The following is an illustration of the Schedule tab when defining an automatic response:

Schedule Tab for Responses
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The Schedule tab for automatic responses to events has the following fields:

Setting Options Description

Always Defines cont inuous monitoring of triggering events.
occurrence.

Monitor event
occurrence

Defines when a triggering event occurrence should be
monitored.

From Selects the date on which the monitoring starts .

To Selects the date on which the monitoring ends .

No end date Used in conjunct ion with the From option, if the event
monitoring is to run from the selected date with no end
date.

Weekdays Select the days of the week on which the event
monitoring is to take place.

Between Select the time of day during which the event
monitoring is to take place.

Time periods are entered in the format hh:mm-hh:mm,
where the firs t time entry is the starting time and the
second t ime entry is the finishing t ime. 

If multiple t ime ranges are required, the additional t ime
ranges are separated by a space. For example, hh:mm-
hh:mm hh:mm-hh:mm .

5.6.2.3.1  To Configure the Monitoring Schedule

To configure the monitoring schedule

1. Select the Schedule tab. The Schedule tab is displayed.

2. Select Always if you want the event to be continuously monitored.

3. If you selected Always, continue with step 5.

4. Select Monitor event occurrences.

5. Do one of the following:

• In the From field, enter the date on which you want monitoring of the event to start. 

• Click in the field and select the date from the calendar that is displayed.

6. Do one of the following:

• In the To field, enter the date on which you want monitoring of the event to end. 

• Click in the field and select the date from the calendar that is displayed.

7. If you want the event to be monitored with no end date, select No end date.

8. In the Weekdays field, selec t the day(s) on which you want the event monitored.

9. In the Between field, enter the t ime range during which you want the event monitored. Use the
format hh:mm-hh:mm , where the firs t time entry is the starting t ime and the second time entry is
the finishing time. If multiple time ranges are required, the addit ional time ranges are separated
by a space. For example, hh:mm-hh:mm hh:mm-hh:mm .
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Note: 

Events that pass midnight and cross over into the next day must be configured twice: once for
the time period till midnight and the other starting from midnight the next day. 

5.6.2.4 Configuring When to Perform Scheduled Actions

This section describes how to define when to perform scheduled act ions .

Scheduled act ions are actions performed on a spec ific date or on a recurring bas is over a defined t ime
period; on specific days or over a range of days; and at a spec ific time or at multiple specific times. 

The following is an example of the Schedule tab when configuring scheduled actions:

Schedule Tab for Scheduled Actions

The Schedule tab for scheduled ac tions inc ludes the following fields :

Setting Options Description

Perform selected
actions

Defines when the act ion should be performed.

From Selects the date on which the recurrent scheduled action
period s tarts .

To Selects the date on which the recurrent scheduled action
period ends.

No end date Used in conjunct ion with the From option, if the recurrent
scheduled period is to run from the selected date with no
end date.
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Setting Options Description

Weekdays Select the days of the week on which the scheduled
action is to take place.

At Select the time of day during which the scheduled ac t ion
is to take place.

Times are entered in the format hh:mm . If the scheduled
act ion is to be performed at various times during the day,
each time is separated by a space. For example, hh:mm
hh:mm hh:mm hh:mm .

5.6.2.4.1  To Configure When to Perform a Scheduled Action

To configure when to perform a scheduled action

1. Select the Schedule tab.

2. Select Perform selected actions on.

3. Do one of the following:

• In the From field, enter the date on which you want the scheduled action performed. 

• Click in the field and select the date from the calendar that is displayed.

4. Do one of the following:

• In the To field, if the scheduled action is to be performed on a recurring basis over a period of
time, enter the date on which you want the scheduled event to end.

• Click in the field and select the date from the calendar that is displayed.

5. If you want the scheduled ac tion to recur cont inuous ly, select No end date.

6. In the Weekdays field, selec t the day(s) on which you want the scheduled action performed.

7. In the At field, enter the t ime or times when the scheduled event is to be performed. Use the
format hh:mm. If multiple t imes are required, the additional times are separated by a space. For
 example, hh:mm hh:mm hh:mm hh:mm .

Note: 

Events that pass midnight and cross over into the next day must be configured twice: once for
the time period till midnight and the other starting from midnight the next day.  

8. Click Apply. The scheduled event is defined.
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5.6.2.5 Sorting Automatic Responses and Scheduled Actions in the Events
List

This section describes how to change the order of defined automatic responses and scheduled act ions
in the Automatic responses and Scheduled actions l is ts.

To sort automatic responses and scheduled actions

1. In the Events lis t, select an automatic response or scheduled act ion. The select ion is
highlighted.

2. Click Up or Dow n to move the selected automatic response or scheduled action to the des ired
pos ition in the lis t.

3. Repeat s teps 1 and 2 for each automatic response or scheduled act ion in the lis t.

4. Click Apply. The changes in the Events l is t are saved.

5.6.2.6 Deleting Automatic Responses and Scheduled Actions from the
Events List

You can delete automatic responses and scheduled actions from the Events l is t.

To delete an automatic response or scheduled action 

1. In the Events l is t, select an automatic response or scheduled ac tion. The select ion is
highlighted.

2. Click Delete. The automatic response or scheduled action is deleted.

3. Click Apply. The changes in the Events lis t are saved.

5.7 Operating with FLIR Cameras
Support is being added on an ongoing basis for ioi encoders to operate with FLIR cameras. Check with
your sales representative or FLIR support for the current listed of supported cameras. We recommend
reviewing Release Notes as they are issued to see the latest features and functions.

The following FLIR cameras are supported as of the date of this document: F-Series, FC-Series 
(R, S, and ID models) and TCX Series. 

For optimal performance, the following image settings are recommended on the F-Series and FC-Series
camera’s Setup > IR web page:

· AGC > Gain: 8-10

· AGC > Plateau: 110

· AGC > ITT :120

· Digital Detail Enhancement: Auto

The camera’s streaming settings must be: (a) D1, 4CIF, VGA, or 640x512; (b) H.264 (Main Profile only); (c)
a bit rate lower than 1500 bps.

Note:

You must change the camera’s factory default settings upon configuring the camera.
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Caution: 

Make sure that the camera is configured in the camera web page as PAL or NTSC according to the
camera model type. The TRK unit must also be configured as PAL or NTSC according to the camera
model type.

Thermal cameras are supported by binding them to the encoder via Latitude. See the following section for

instructions how to bind the camera and encoder.

5.7.1 Binding a FLIR Camera to the trk-101

A FLIR fixed thermal camera and the trk-101 or trk-101-P are bound to each other from the Latitude
AdminCenter. The following schematic illustrates the connection.

Binding FLIR Camera to trk Encoder

Each camera has its own syntax for the URL which connects it to the RTSP server and defines the video
stream that will be sent via RTSP. The RTSP URL is entered in the TRK’s Setup > System > Unit
Information screen. It is necessary to select the fourth option (Digital input,digital analytics out) in the
Operating Modes section. 

Operating Modes

Note:

If you are using Latitude to bind the camera and encoder, Latitude will automatically select the fourth
option and set the URL. 
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The syntax for each supported camera is:

Model Syntax

F-Series and FC-Series 
(R, S, and ID models)

rtsp://<ip>/ch0

TCX Series T43xxBN rtsp://<ip>/cam/realmonitor?channel=1&subtype=1&proto=Onvif

RTSP Authentication is not required for these units.

To bind the trk-101 or trk-101-P to the camera

1. Open the Latitude AdminCenter in the Physical View tab for the desired.

2. Select the camera. Note that the camera icon is displayed as a PTZ camera.

PTZ Configuration Screen

3. Select the PTZ Configuration tab.

4. Uncheck the Enable PTZ functionality checkbox. 

5. From the Toolbar at the top of the screen, click Save. Note that now the camera icon changes to
a fixed camera icon.

6. Select the top-level System in the Camera Tree.
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7. Select the Analytics tab.

Analytics Tab

8. Select the camera that you want to bind from the Available Camera list.

9. Use the arrow button to add it to the Camera table. 

Caution: 

Make sure that the TRK unit is not attached to Latitude.

10. In the table, do the following:

a. In the Connection Type column, from the drop-down list, select Analog or Manual RTSP
(for IP cameras).

b. In the Analytic Device IP column, enter the IP address of the TRK unit that you want to
attach to the PTZ camera.

i. If you select Manual RTSP, click the RTSP Setting button. If the trk-101 is connected
to a FLIR camera, the IP address is displayed automatically in the Analytic Device IP
column. If the camera is not displayed automatically, enter the full RTSP address
string after the camera’s IP address in the RTSP Settings dialog box. For example, if
the FLIR camera’s RTSP URL is “rtsp://<ip>/ch0”, enter “/ch0” in the Camera RTSP
Stream URL text box. 

RTSP Settings Dialog Box
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ii. If authentication is required for the RTSP connection, select the Authorization
Required checkbox. Then enter the User Name and Password in the respective text
box. Click OK.

Camera Table

Note:

This feature is supported only on the Quasar CP-4221-30x.

11. Click Save.

12. Click Arm/Disarm or arm the unit from ControlCenter. The camera is displayed as Armed in the
Arming Status column of the Camera table. The Analytics function starts to operate after the
camera is armed and OK is displayed in the Analytics Status column.

13. From the Setup > Depth screen of the TRK unit’s web interface, configure the analytic settings.

5.7.2 Binding a PTZ Camera to the trk-101-P

The PTZ camera and the trk-101-P are bound to each other from the Latitude AdminCenter.

Note:

The same procedure that follows can be used for PTZ cameras from other manufacturers that are
supported by FLIR. You can request the ioi Supported PTZ Cameras list from your FLIR representative or
FLIR Support. See RTSP URLs for Supported Cameras in this document for a list of the RTSP URL to
use for each supported camera manufacturer. 
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To bind the trk-101-P to the camera 

1. Open the Latitude AdminCenter on the desired site. Make sure that the PTZ Tracker is listed in the
site.

2. Select the Analytics tab.

Latitude Analytics Tab

3. Select the camera that you want to bind from the Available Cameras list.

4. Use the arrow button to add it to the Camera table. 

Caution: 

Make sure that the TRK unit is not attached to Latitude.

5. In the table, do the following:

a. In the Connection Type column, from the drop-down list, do one of the following:

i. Select Decoder for the CP-4221-30x PTZ camera

ii. Select Manual RTSP for all other PTZ cameras

b. In the Analytic Device IP column, enter the IP address of the TRK unit that you want to
attach to the PTZ camera.

c. Click the RTSP Setting button. The RTSP Settings dialog box opens. 

RTSP Settings Dialog Box
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d. Verify that the encoder’s IP address is displayed in the Camera RTSP Stream URL text
box.

· If the camera’s RTSP URL is not displayed automatically in the Camera RTSP
Stream URL text box, enter the camera’s RTSP URL manually. For example, if
the Quasar camera’s RTSP URL is “rtsp://<ip>/ h264_2”, enter “/h264_2” in the 
Camera RTSP Stream URL text box.

e. Click OK.

Note:

In case the VGA stream is stream #1, the RTSP URL should be “/h264”. 

Camera Table

6. Set the Rearm Time in the Auto Rearm column. This is the number of seconds until the camera is
rearmed after being automatically disarmed due to manual PTZ control. The Rearm countdown
starts from the moment the camera tile is unselected in ControlCenter. The default is 30 seconds. 

Note:

This feature is supported only on the Quasar CP-4221-30x.

7. Click Save.
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8. In Latitude, on the Video Settings screen, do one of the following:

· If operating in separate-stream mode, enter the settings for each stream on the Live and
Recorded tabs. 

a. On the Recorded tab, do not select the Recorded quality same as live checkbox.

Latitude Video Settings Screen

b. Configure the following settings on one of the tabs (Live or Recording): VGA
resolution (640x480), constant bit rate 1000 kbps, and 25 fps.

· If the Recorded quality same as live checkbox is selected, the recorded stream will be
the same as the live stream.

a. From the camera’s web interface, configure the camera settings for the second
stream. 

b. On the Streaming > Video Format screen, set the Video Format for the second
stream (Format 2) to VGA (640x480) and 25 fps. 

c. On the Streaming > Video Compression screen, set the H.264-2 Compression
setting for the second stream to 1000 kbps. 

d. On the Streaming > Video Compression screen, select the Enable H.264-2
CBR mode setting checkbox. 

9. On the PTZ Tracker, configure the TRK encoder presets.Then configure Depth and Rule settings for
each preset on the PTZ Tracker.
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6 Monitoring Real-Time Video
Real-time video monitoring on ioi products is  performed by using the Live View screen of the unit’s
embedded HTML interface.

The Live View screen enables you to perform operational actions according to the privileges ass igned
to the login user, as well as to monitor detec ted objects according to the detec t ion rules set in the unit.

The following is an example of the Live View screen:

Live View (Workspace) Screen

The fields and toolbar icons are described in Live View Workspace Overview.

The Live View screen enables you to:

• View live video, as described in Monitoring Live Video

• View alarm notifications, as described in Viewing Alarm Notifications

• Track detected objects, as described in Tracking Detected Objects

• Control PTZ cameras, as described in Using the PTZ Controls 

• Arm and disarm the video channel, as described in Arming and Disarming a Camera

• Clear alarms, as described in Clearing Camera Alarms

• Capture the video image, as described in Capturing the Video Image

• Enable and disable Audio, as described in Enabling and Disabling Audio  

• Monitor the real-time status of the unit’s Discrete I/O resources, as described in Monitoring
Discrete Input/Output Resources 

6.1 Monitoring Live Video
The Live View screen enables you to view and monitor the real-t ime video of the scene.

While viewing l ive video, you can use the unit ’s electronic magnification tools on the Viewing toolbar to
zoom in and out of the image. Unlike the PTZ controls that enable you to use the opt ical zoom to move
the camera lens when zooming in or out, the electronic zoom enlarges or reduces the image from the
camera by enlarging pixel size. This may cause image quality degradat ion above a specific zoom level.



November 7, 2016
180

Monitoring Real-Time Video

HTML Edition Units User Guide

Click the Zoom In button  to electronically zoom in on an image. The following examples show the
effect of using the Zoom In button. The Viewing area on the left shows the regular image, while the right
one shows the enlarged image in the Viewing area after c lick ing the Zoom In button.

Using the Electronic Zoom Tool

While an image is magnified, you can use the Change Pan button  to select the portion of the image

to be shown enlarged. Click the Zoom Out button  to electronically zoom out on an image or c lick

the 1:1 button  to return the image to its original size.

To magnify a selected zone of the Viewing area

1. Click the Magnifying Glass button . The cursor changes to . 

2. Drag your mouse to create a rectangle around the area you want to magnify.

3. Release the mouse button. The magnified image is displayed in the Viewing area. 

The following examples show the Viewing area with an area marked for magnification (left) and the
Viewing area with the magnified area of the image.

Using the Magnifying Glass Tool
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Click the Close-up view button   to show a magnified view (x2) of the image around the current
mouse position. The following example shows the effect of using the Close-up view button.

Using the Close-up View Button

6.1.1 Viewing Alarm Notifications

Alarm notifications are shown in the Live tab above the Viewing area. When detec tion occurs, the type of
detection is indicated in the Alarm Not if ication area. It remains displayed unti l cleared by press ing the Clear
Alarms button. See figure below.

The detection is also indicated as overlay mark appearing around the detected object. If the object is
moving, a trail is marked for the path that the detected object has taken, according to the definitions set in
the OSD setting of the channel. 
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The following image of a detection appearing in the Live View screen during real-t ime monitoring
shows a detec ted object with a path trail and an alarm notification above the Viewing area.

Real-Time Monitoring – Intrusion Detection

6.1.2 Tracking Detected Objects

Detected objects are indicated in the Live View screen as defined in Configuring On-Screen Display
Sett ings.This indication may take the form of a rec tangle around the detec ted object or a crosshair on
the detected object. According to the detect ion rule type, you can also define if you want the path trail of
the detected object to be shown. See Figure: Direction Arrows in Detection Area for an illustration of a
detec ted object inside a rec tangle with a trail showing its movement.

When using an encoder connected to a PTZ camera, use the Manual tracking   button to enable
manual PTZ track ing. Click the PTZ control commands (up/down/left/right) or c lick the target to init iate
autonomous track ing while the channel is armed. The unit automatically commands the pan, ti lt and
zoom of the camera to track and focus on the target.

Use the Manual tracking   button again, to disable manual track ing and enable automatic
detect ion and track ing as defined in the unit .

Note:

This feature works only when the camera is operating in NVR mode.
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6.1.3 Using the PTZ Controls

When a unit is configured for a PTZ camera, the PTZ controls appear at the bottom left of the Live View
 screen. 

The PTZ controls enable you to perform the following tasks:

• Manually move the PTZ camera

• Zoom in and out of an image (optical zoom)

• Change the speed at which the camera moves when panning, tilting or zooming

• Select presets

• Control playlist actions

The following image shows the PTZ control panel.

PTZ Controls

The Presets drop-down lis t enables you to select a preset locat ion for display in the Viewing area. For a
detailed explanation of the PTZ control panel, see PTZ Control ler Panel . 

Use the Play , Stop , and Pause  buttons to control the playl is t defined for the channel
during setup. For more information on creating presets and playl is ts, see Step 3: Presets and Playlist.

Use the Pan Left , Pan Right , Tilt Up  or Tilt Dow n  buttons to move the camera to
the des ired pos it ion.

Use the Zoom In  and Zoom Out  buttons to increase or decrease the opt ical magnificat ion in
the Viewing area.

Move the Speed s lider left or right to decrease or increase the speed at which the camera moves when
panning, t il ting or zooming.

6.1.4 Arming and Disarming a Camera

Arming a camera engages the act ive rules to detect on the live video. It also enables the camera to send
and receive alarms , generate and receive events as well as to perform automatic responses and
scheduled act ions .

Disarming changes the state of the camera to s top detecting l ive video and to stop sending alarms ,
events or perform automatic responses and scheduled actions.

Click the Arm but ton  to arm the camera. The Disarm button is enabled. 
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Click the Disarm button  to disarm the camera. The Arm button is enabled.

Note:

In order for a PTZ camera to detec t  and t rack  an objec t ,  a channel must  be armed with an
act ive rule defined in the setup.  

6.1.5 Clearing Camera Alarms

When there is a detec t ion alarm on a channel, the alarm status can be cleared, which restores  the
channel to a non-alarm status. The Clear Ala rms button is activated only when an alarm is indicated. 

Click the Clear Alarms button  to c lear al l alarms in the unit.

6.1.6 Capturing the Video Image

It is poss ible to capture the current video image in the Live View window and save it as a .jpg image
file.

Click the Snapshot   button to capture the current video image (including OSD if shown). The Save
As dialog box opens for spec ifying the fi le name and location to save the image file.

It is recommended to save a proper snapshot of each camera or preset FOV in the sys tem in order to
use it as a reference for camera re-alignment, depth settings or detect ion rules re-definit ion if necessary.

6.2 Monitoring Discrete Input/Output Resources
You can monitor the real-t ime status of the unit’s discrete I/O resources from the Live View screen. For
more information on configuring a unit’s Discrete I/O resources, see Configuring Discrete Input /
Output  Resources .

Note:

Enabling alarm Inputs or relay outputs can be performed only by a user with adminis trative privileges . 

The buttons located to the right of the Viewing area in the Live View screen enable you to see the
status of the defined Discrete I/O resources. See Figure: Live View (Workspace) Screen. 

The following table describes the various statuses of the buttons:

Label Description

Alarm Input
(from
external
device dry
contac t)

Button indicat ing the current status of the alarm input as follows:

: Disabled

: Enabled, armed and there is no alarm indicated

: Enabled and disarmed
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Label Description

: Enabled and an alarm has been t riggered (the external device is in a
s tatus cons idered as an alarm)

Relay Button indicat ing the current status of the relay as follows:

: Disabled

: Enabled and the relay has not been activated (Off)

: Enabled and the relay has been activated (On)

Note:

1. Alarm input icons are shown in the Live View window only if at least one alarm input is enabled in
the unit.

2. Relay output icons are shown in the Live View window only if at least one relay output is
enabled in the unit.

3. A tooltip displays the name of the alarm input/relay and its current status  when you hold your
mouse over a resource icon. 

Users logged in with adminis trative privileges (Adminis trators , Supervisors and Operators) can perform
the following tasks:

• Arm/Disarm Dry contacts

• Turn Relay outputs On/Off from the Live View window

Note:

If you are logged on as guest, changing I/O status as described below is not available
(monitoring only). See Accessing the Unit.

Clicking  a specific alarm input button changes its status as follows:

• Clicking an alarm input whose status is armed changes its status to disarmed .

• Clicking an alarm input on which an alarm has been triggered  clears the alarm and changes the

status to disarmed .

Clicking a specific relay but ton changes the relay status as follows:

• Clicking a relay whose status is not activated (Off)  changes the relay to activated (On) .

• Clicking a relay whose status is activated (On)  turns off the relay as not activated (Off) .
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6.3 Accessing a Remote Unit over the Web (Port Forwarding)
It is possible to remotely access a unit that is located behind a firewall at a remote site by using port
forwarding. Port forwarding enables two functions:

1. Transmitting MJPEG videos via HTTP over remote networks with low bandwidth. 

2. Remote configuration of the unit over the web. The web setup supports login, all setup
functions, and video display configuration.

Port forwarding maps and enables communication between an external IP address (accessible over the
Internet) and an internal IP address (assigned to a unit on a private network located behind a firewall),
which is not directly accessible over the Internet. In the case of trk-101 and trk-101-P, the encoder enables
IP access to a camera that does not have built-in IP capability. 

Note:

This function is available on units running firmware version 2.1.1 or higher. 

Remote Access System

The following port forwarding table displays an example of the mapping between the external IP address/
port and the internal IP address/port:

Camera # External IP Address:Port
Number

Internal IP Address:Port Number

Camera 1 172.168.123.30:180 10.30.75.10:80

Camera 2 172.168.123.30:280 10.30.75.11:80

Camera 3 172.168.123.30:380 10.30.75.12:80

Camera 4 172.168.123.30:480 10.30.75.13:80

If there are "privileged users" on the remote unit, you must enter the unit's External IP address on the User
Accounts screen. See To Configure Unit Privileges.
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To access a remote device

1. On the client PC browser, enter “http://[NAT external IP]:[port 80 forwarded port]” For each
unit. For example, http://172.168.123.30:180. The login window opens for the HTML interface
of the trk-101 unit to which Camera 1 is attached.

Login Window

2. Log into the ioi unit.

3. Enter the unit’s Setup screen.

4. Perform the required action.

6.4 Monitoring and Controlling Remote Sites with Site Viewer

Site Viewer enables you to access any IOI unit connected on the network and to connect remotely to the
unit. You can view live video, control PTZ, view and modify relay status, and download or query for recorded
SoE clips to playback. Each user can have privileges for a number of cameras on-site. 

Note:

1. The remote unit must be operating in NVR mode in order to view live video on a remote site when
the camera is armed.

2. When set to one of the other operating modes, there is live video only when the camera is
disarmed.
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6.4.1 Visual Alarm Indication on Site Viewer

When an event occurs, it is possible to view a visual alarm indication on an armed unit in Site Viewer, as
well as hear an audio alarm. The status icon changes from a green circle to a red bell for the camera on
which an alarm occurs in the Site Viewer navigation tree and in the tile of the Site-Live screen. 

Alarm Indication on Site-Live Screen

6.4.2 To Log into Site Viewer

To log into Site Viewer

There are two ways to login to Site Viewer:

· If you are on the same VLAN as the site, enter the IP address of any unit with
privileges and enter the user credentials. For example, enter http://10.30.75.11 to
access Camera 2 from within the network in the example provided in Accessing a
Remote Unit over the Web.

· If you are outside the network (for example, when using port forwarding), enter the
external IP address of the site and the external port number of a unit with
privileges. For example, enter http://172.168.123.30:280 to access Camera 2 from
outside the network in the example provided in Accessing a Remote Unit over the
Web.

Once logged in through Site Viewer, all units with privileges are displayed.

To view live remote sites

1. Log into the trk-101 or trk-101-P. The unit’s web interface opens on the Live View screen. 

2. From the Navigation bar, click Site-Live. If you have already downloaded the VLC media
player, an information bar opens, requesting you to allow the VLC ActiveX plug-in to run. 

ActiveX Plug-in Information Bar

http://10.30.75.11
http://172.168.123.30:280
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Note:

The VLC player must be the 32-bit version.  

3. Click Allow. The Site Viewer screen opens. A unit with red button is disarmed, a unit with a
green button is armed, and a unit with a gray button does not have firmware that supports SoE
and armed/disarmed status. 

Empty Site Viewer Screen

4. Select a tile layout (1 x 1, 2 x 2, or 3 x 3) from the layout icon . You can
display up to 9 cameras.

5. Double-click a unit from the device list or drag the camera to a tile. The first unit that is clicked is
displayed in the upper left corner of the screen. 
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Site Viewer Screen with One Camera

6. Click additional units, which are displayed in the next tile to the right and below, or drag a unit into
a tile. 

7. Click a camera to select it. The active camera name is displayed in blue text in the device list and
the camera tile is enclosed in a gray border. 

Site Viewer Screen with Active Camera

8. To enlarge a tile in a multiple tile layout to 1 x 1 layout, double-click the tile. Double-click again to
return to the previous layout.

9. Select the following icons to control the camera display:
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Icon Description

Activate/Mute audio.

Remove camera from tile

 
Arm/Disarm camera

Clear Alarm

6.4.3 To Activate I/Os

To activate I/Os

The active unit’s alarm inputs and relays are displayed at the bottom of the screen. 

I/O Display per Tile

Alarm inputs can trigger a notification action when an event occurs, such as crossing a tripwire or entering
a region. Relays can trigger a remote action, such as locking a door or turning on a spotlight.

1. Select a tile. To change a unit’s I/O status, click the displayed I/O.

a. Click to disarm an alarm. Its status changes to (disarmed).

b. Click to activate a relay. Its status changes to  (relay activated).

Both audio and visual alarms indicate when an event occurs. For more information, see Visual Alarm
Indication on Site Viewer.
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6.4.4 To Control a PTZ Camera

To control a PTZ camera

1. Select a PTZ camera from the device list. The camera name is displayed in blue text and the 
PTZ Control pane opens.

Site Viewer PTZ Control Pane

2. Select one of the following functions: 

a. Preset – Select a preset number from the combo box in the PTZ panel.

b. Playlist – Select button from play, pause stop from the PTZ panel.

c. Manual PTZ control and Click-and-Track .

· Click PTZ Manual Tracking.  The PTZ directional icons are enabled.

PTZ Control Keypad

· Adjust the PTZ motor speed on the slider.

· Select a directional button to control the camera movement.

· Click on the target in the tile to track it.

3. To exit Manual Tracking mode, uncheck PTZ Manual Tracking and press the clear alarm icon 

.
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6.4.5 To Playback a Clip

Note:

The remote unit must be operating in NVR mode in order to create and view video clips.   

To playback a clip

1. After logging onto a camera in the site, select Site – Playback on the Navigation bar. If you
have not already download the VLC media player, a popup message to install the player is
displayed in the viewing window in the Site – Playback screen.

Site Viewer Site-Playback Screen
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2. Select a camera from the device list. The camera name is displayed in crimson text and its IP
address is displayed in the device list.

Site Viewer Search for Video Clip

Note:

Only units with firmware that support Site Viewer are displayed in the device list.  

3. In the Search for a Video Clip area, do the following:

a. Click the calendar icon  to enter the From and To dates. 

b. Click the clock icon  to enter the From and To times.

4. Click Search. The results are displayed in the Search Results list.

Site Viewer Search Results List
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5. Select the clip, double-click, or click  to play the clip. The clip is displayed in the viewing
window if you have downloaded the VLC media player.

Site Viewer Clip Playback Window

6. If you have not installed the VLC media player, do it now.  

Note:

The VLC player must be the 32-bit version.  

6.4.6 To Install the VLC Player

To install the VLC player

1. Click the link in the window (ht tp: / /www.videolan.org). The download starts automatically. The
following information bar is displayed:

VLC Installation Message

Note:

The VLC player must be the 32-bit version.  

2. Click Run. The VLC setup wizard opens.

3. Follow instructions in the wizard until the VLC Media Player window opens.

http://www.videolan.org
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VLC Media Player Window

4. To open the player in the future, click the VLC icon .

5. Scroll over the playback window and select the following icons to control the clip:

Icon Description

Play/Pause the clip.

Enlarge the image to full-screen size. Click the Escape key on your
PC’s keyboard to restore the image to window size.

Note:

Site Viewer playback allows only play and pause options. To use Fast Forward, Fast Rewind, and
Jump to Time functions, you must first download the AVI clip to the local disk and use an AVI
player.   

6.4.7 To Export a Clip

To export a clip

1. Select the query result from the list. The Export button   is displayed.

2. Click Export. The following information bar opens.

Export Information Bar

3. Right-click Save.

4. Select Save as to set the path for saving the file.

5. Click Save.  
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7 Appendix
This appendix includes the fol lowing sect ions:

• Network Settings

• Enabling Cookie Settings 

• Configuring ActiveX Security Settings

• Resolving ActiveX Version Conflicts 

• Using ioi Units with Windows Firewall Turned On

7.1 Network Settings
The following are the network protocols, ports and usage of the encoders  and cameras:

Protocol Port Usage

HTTP 80 Commands,  requests ,  replies  and not ificat ions

NTP 123 Time synchronizat ion with a network  t ime server us ing
SNTP

RTSP 554 RTP sess ion setup

RTP 2000 to
65535

Mult imedia s t reaming

Mult icas t
UDP

9766 Unit  self-publishing.  Uses IP address 224.9.9.9

Mult icas t
Streaming

As
defined
in the
units

Video/s t reaming (mult icas t).  Uses the IP address defined
in the units .

7.2 Enabling Cookie Settings
This section describes procedures for adjusting your Internet Explorer settings to enable the ioi encoder to
use cookies when browsing the Internet.

Your web browser must enable the use of cook ies and allow downloading and activat ing ActiveX
components.

ioi products use cook ies when browsing through their HTML interface. The security and privacy cook ies
settings on your computer must therefore permit the use of firs t party cook ies. This section describes
how to change the cook ie settings in your browser.

Note:

The browser must be 32-bit Internet Explorer 9, 10, or 11. 
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To enable cookies in Internet Explorer 9

1. In Internet Explorer, select Tools > Options.

2. Selec t the Privacy tab. The Internet Opt ions – Privacy tab is  displayed.

Advanced Privacy Settings Dialog Box (IE 9)

3. Click Advanced. The Advanced Privacy Settings dialog box is displayed.

Advanced Privacy Settings Dialog Box (IE 9)
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4. Select Override automatic cook ie handling.

5. Select Accept in the Firs t-party Cook ies l is t.

6. Select Prompt in the Third-party Cook ies l is t.

7. Click OK. The Advanced Privacy Settings dialog box closes.

8. Click OK. The Inte rnet Options dialog box closes. The settings are saved.

To enable cookies in Internet Explorer 10 or 11

1. In Internet Explorer,  select Tools > Options.

2. Selec t the Privacy tab. The Internet Opt ions – Privacy tab is  displayed.

Internet Options – Privacy Tab (IE 10/11)
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3. Click Advanced. The Advanced Privacy Settings dialog box is displayed.

Advanced Privacy Settings Dialog Box (IE 10/11)

4. Select Accept in the Firs t-party Cook ies l is t.

5. Select Prompt in the Third-party Cook ies l is t.

6. Click OK. The Advanced Privacy Settings dialog box closes.

7. Click OK. The Inte rnet Options dialog box closes. The settings are saved.



201
November 7, 2016

Appendix

HTML Edition Units User Guide

7.3 Configuring ActiveX Security Settings
ioi products use ActiveX controls and plug-ins. This section describes procedures for enabling ActiveX in
the Internet Explorer security sett ings , as well as in any firewall that  is  used.

To adjust security settings for ActiveX 

1. Open the security settings screen:

a. With IE 9, from the Control Panel, select Security Settings > Internet Zone. 

b. With IE 10 and IE 11, from the Control Panel or from the Tools  Command Bar, select
the Internet Options > Security tab. 

Internet Options > Security Tab Dialog Box
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2. Click Custom level. The Security Settings – Internet Zone dialog box is displayed.

Security Settings Dialog Box

3. Under ActiveX controls and plug-ins > Download signed ActiveX controls , select Enable.

Note:

This setting is only needed on init ial web browser connectivity after installing or upgrading. It
can also be set to issue a prompt based on security requirements. 

4. Under ActiveX controls and plug-ins > Run ActiveX controls and plug-ins , select Enable.

5. Under ActiveX controls and plug-ins > Script ActiveX controls mark ed safe for scripting, select
Enable.

6. Under Script ing > Active scripting, select Enable.

7. Click OK to c lose the Security Settings dialog box.

8. Click OK to c lose the Internet Options dialog box. The settings are saved.
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To install or run the ActiveX plug-in on IE 9, 10, and 11

1. Close any other open Internet Explorer browser applications.

2. Upgrade the firmware. See Updating the Unit Firmware.

3. Login to the unit after the firmware finishes.  

4. On the popup message that opens, click on Click  here to install ActiveX component. 

5. Click the gold Information bar that appears on the top of the webpage.

6. Follow the prompts. The ActiveX component is installed. It is not necessary to reset the
computer.

7.4 Resolving ActiveX Version Conflicts
This section describes how to delete and update the ioi ActiveX component in the event of Ac tiveX
vers ion conflic ts.

Connecting to an ioi unit through its HTML interface requires the use of ActiveX components on the local
computer running the web browser. The ioi ActiveX component vers ion must match the unit’s firmware
vers ion.

If it is the firs t time your works tation accesses any vers ion of the ioi units, the ActiveX is automatically
downloaded, provided that the browser security settings are correct. See Configuring ActiveX Security
Settings.

If you use an older vers ion of the ActiveX component (RenderControlClass), this may result in a failure
when access ing the unit through a web browser.

After upgrading or checking to make sure the proper ActiveX component vers ion is used, i t is
recommended to delete previous vers ions of ActiveX components from the local computer.

To delete the ActiveX component in IE 9, 10, and 11

1. Open Internet Explorer.

2. Click the Tools button. The Tools drop-down list opens.

Tools Drop-down List (IE 9)
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Tools Drop-down List (IE 10/11)

3. Select Manage add-ons. The Manage Add-on window opens.

4. Under Show, select Currently loaded add-ons. All ActiveX controls are displayed.

Manage Add-on Screen

5. Select the VideoRenderingClass add-on. The add-on is highlighted.

6. Click Disable. The add-on is disabled.

7. Repeat steps 4 and 5 if you wish to delete the Network  ActiveX Class add-on.

8. Click Close when you are finished.
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7.5 Using ioi Units with Windows Firewall Turned On
This section describes how to enable ioi client applications functionality without switching off the
Windows Firewall on your computer. ioi c l ient applications (Discovery Network Assistant and the unit’s
embedded HTML Setup) must not be blocked by the local W indows Firewall when switched on. 

To enable ioi functionality

1. Make sure that your computer’s Pop-up Blocker is turned off.

To turn the Pop-up Blocker off with Windows 7

a. Open Internet Explorer. 

b. Click the Tools button, point to Pop-up Blocker.

c. Click Turn Off Pop-up Blocker.

To turn the Pop-up Blocker off with Windows 8, 8.1, and 10

a. Open Internet Explorer. 

b. Click the Tools icon, select Internet Options.

c. Open the Security tab.

d. Click Custom level.

e. In the Miscellaneous > Use Pop-up Blocker section, select Disable.

Disable Pop-Up Blocker



November 7, 2016
206

Appendix

HTML Edition Units User Guide

2. Open the Windows Firewall screen:

• On Windows 7, from the Windows Control Panel, select System and Security. The System
and Security window is displayed.

Windows 7 System and Security Window

• Select Windows Firewall. The Windows Firewall dialog box is displayed.

Windows 7 Firewall Dialog Box

• On Windows 8, 8.1, and 10, from the Windows Control Panel, select Windows Firewall.
The Windows Firewa ll dialog box is  displayed.

Windows 8, 8.1, and 10 Firewall Dialog Box
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3. Select Advanced Settings from the sidebar. The Advanced Security window is displayed.

Advanced Security Window (Win 7)

Advanced Security Window (Win 8, 8.1, and 10)
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4. In the Getting Started area, select View and create firewall rules > Inbound Rules. The Inbound
Rules screen is displayed.

Inbound Rules Screen

5. From the Actions section, select Inbound Rules > New Rule. The New Inbound Rule Wizard opens
on the Rule Type screen. 

Rule Type Screen
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6. Select Port and click Next. The Protocol and Ports window opens.

Protocol and Ports Window

7. Select UDP.

8. Select Specific local ports and enter 9766 in the text box.

9. Click Next. The Action window opens.

Action Window

10. Select Allow the connection.
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11. Click Next. The Profile window opens.

Profile Window

12. Select the profile according to the type of network to which you are connected. Consult your
Network Administrator regarding this setting. 

13. Click Next. The Name window opens.

Name Window

14. In the Name field, enter the name of the rule.

15. In the Description field, enter an optional description for the rule.
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16. Click Finish to close the New Inbound Rule Wizard. Your settings are saved.

17. Run the Discovery  Network  Ass is tant  (DNA) to verify that it discovers  all ioi units on the
network.
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